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Method: Use of the Polilight PL500 Alternate Light Source

Date: 3/31/00 Revision Date:01/01/2007 Approved by: SAM

MATERIALS:

1. Polilight PL500 Alternate Light Source
2. Orange and yellow goggles or filters
PROCEDURES:

Note: The Polilight PL500 is a high intensity light source, which if used inappropriately has the potential
to be a hazard to the eyes and skin. Users should use the Polilight PL500 with the awareness that both their
own eyes and skin, and those in close proximity should be protected at all times. Even with protective
goggles exposure time needs to be considered.

1) Make sure the light guide with black focusing lens is‘connected to the Polilight unit.

2) Place the Polilight PL500 on a solid surface and turn the power switch on back panel to the up (ON)
position. Ensure the air flow around the unit is not obstructed.

3) Conduct a quality control check of the Polilight PL.500 using known biological fluid stains prior to
examining evidence:
a) The known biological stains should be checked with all wavelengths desired in the examination (the
450 and 490 nm wavelengths are recommended for most evidence items) and the results of the
quality control check will be recorded in the case notes.

4) Filter tuning is achieved by using the wavelength specific numerical buttons located on the front control
panel or on the hand held remote control box. (See the figures below)

5) Once a filterhas been selected it can be fine-tuned. Fine tuning will decrease the wavelength and is

used to optimize illumination conditions for specific materials. The fine tuning has a range from tO -
t40.
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6) Once a filter has been selected the intensity can be tuned by changing the power setting. The power
setting has a range from P1 (lowest power) - P8 (highest power).

7) Systematically pass the light over the entire item to be examined. A fluorescent area may indicate the
presence of a body fluid stain. Note the area for further testing.

8) Once the examination is complete, turn the power switch on back panel to the down (OFF) position.

9) Secure the Polilight PL500 by either placing it on a stable surface or removing the power ¢able; remote
control, and liquid light guide from the main unit and placing them in the carrying case.

REFERENCES:

1. Auvdel M]. Comparison of Laser and High-Intensity Quartz Arc Tubes in the Detection of Body
Secretions. ] Forensic Sci. 1988 Jul;33(4):929-45.

2. Rofin Australia Pty. Ltd. POLILIGHT PL500 (Version 2) Multi-Waveband Tunable Light Source
Instruction Manual
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Method: Use of the Crime-lite 80S Alternate Light Source

Date: 1/12/05 Revision Date:01/01/2007 Approved by: SAM
MATERIALS:

1. Crime-lite™ 80S Blue (450nm) or Crime-lite™ 80S Blue/Green (485nm)

2. Battery Adaptor with Makita® Rechargeab]e battery

3. Mains Adaptor

4. Orange goggles or filters

PROCEDURES:

Note: The Crime-lite™ 80S is a portable high intensity light source; which if used inappropriately has the

potential to be a hazard to the eyes and skin. Users should use the Crime-lite™ 80S with the awareness that

both their own eyes and skin, and those in close proximity should be protected at all times. Even with

protective goggles exposure time needs to be considered.

1. Connect the output plug holding the Makita® Rechargeable battery with battery adaptor to the Crime-
lite™ 80S for portable use.
Connecting the Light Source
Connecling the Battery Adaptor to a Crime-lite 80L or B0S Forensic Light Source
Insert the plug from the Battery Adaptor into the socket in the centre of the end cap on the handle of the
Crime-lite 801 or 805 Forensic Light Source
I'he light source 1s now ready for use
If the battery has a low charge or unavailable, attach the Mains Adaptor to the Crime-lite™ 80S and the
nearest outlet.
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Connecting the Mains Adaptor to the Crime-lite 80L or 80S Forensic Light Source

[rjsgrt the plug from the Mains Adaptor into the socket in the centre of the end cap on the handle of the
Crime-lite 80L or 80S Forensic Light Source as shown above,

1. Turn on the power switch on the Crime-lite™ 80S.

Crime-lite
80S

2. Conduct a quality control check of the Crime-Lite™ on known biological stains prior to examining
evidence and record the results in'the case notes:

4. Systematically pass the light over the entire item to be examined. A fluorescent area may indicate the

presence of a body fluid stain. Note the area for further testing.

5. Once the examination is complete, turn off the power switch located on the handle. Caution: the light

output headwill become warm during use.

6. Secure the Crithe-lite™ 80S by either placing it on a stable surface or in its carrying case (for long term
storage)and removing the Mains Adaptor or Battery Adaptor.

Charging the Makita® rechargeable battery:

The Makita® Rechargeable battery is a nickel-metal hydride 24V, DC that supplies a Crime-lite™ 80S
sufficient power for up to 50 minutes at a fully charged capacity.
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Charging

Battery cartridge

Terminal cover

1. Insert the battery cartridge into the charger until it stops adjusting to the guide of charger. Terminal
cover of charger can be opened with inserting and closed with pulling out the battery cartridge.

2. When the battery cartridge is inserted, the charging light color will change from green to red and
charging will begin. The charging light will remain steadily during charging.

3. Onered Charging iight indicates charged condition in 0 - 80% and two red ones indicates 80 — 99%.
4. With finish of charge, the charging lights will change from two red ones to two green ones.
5. The charging time is approximately 60 minutes for the Makita® Rechargeable battery.

6. If you leave the battery cartridge in the charger after the charging cycle is complete, the charger will
switch into its “trickle charge (maintenance charge)” mode which will last approximately 24 hours.

7. After charging, unplug the charger from the power source.

Tips for maintaining maximum battery life:

1. Charge the battery cartridge before completely discharged. Always stop Crime-lite™ 80S operation
and charge the battery cartridge when you notice less tool power.

2. Never recharge a fully charged battery cartridge. Overcharging shortens the battery service life.

3. Charge the battery cartridge with room temperature at 10°C - 40°C. Let a hot battery cartridge cool
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down before Charging it.

REFERENCES:

1. Auvdel M]. Comparison of Laser and High-Intensity Quartz Arc Tubes in the Detection of Body
Secretions. ] Forensic Sci. 1988 Jul;33(4):929-45.

2. Foster and Freeman- Crime-lite™ Information sheet QCL/80S-B-BG-G. Issue 01 (September 2004)
3. Foster and Freeman- Crime-lite™ Information sheet QCL/83. Issue 01 (September 2004)

4. Foster and Freeman- Crime-lite"" Information sheet QCL/80. Issue 01 (September 2004)

5. Makita®- High Capacity Battery Charger Model DC24SA Instruction Manual.
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Method: Microscopic Screening of Evidence for the Presence of Semen

Date: 4/2/98 Revision Date:01/01/2007 Approved by: SAM

Note: This procedure has been specifically written for Analysts involved in screening evidence for the
presence of semen but not involved in DNA testing.

1. Remove a very small portion of the putative semen stain and perform a test for the presence of'acid
phosphatase activity.

2. Remove approximately 1/4 of a swab or a suitable portion of the substrate and:place.in 1.5mL tube.
Add 1mL of nanopure water and incubate for 30 minutes at room temperature. Vortex several times
during that 30 minutes. A reagent blank tube should be created at this pointwhich will undergo all of
the following manipulations and will be used as a control to monitor potential,contamination, if the
extracts prepared will be used for DNA testing.

3. Using a pipette tip (or wooden stick) remove as much liquid from thesubstrate as possible, transfer it

to a second microcentrifuge tube, and retain.
4. Microcentrifuge the sample extract at maximum speed for 3-5 minutes.

5. The supernatant may be used for serological tests for blood, semen, saliva, and/or feces. [Consult the
specific procedure for details]. Remove an appropriate amount of the supernatant for any desired
assays.

6. Carefully pipette off all but 50-100uliof the supernatant being careful not to disturb the pellet. The
supernatant can be discarded. At least 50uL of supernatant should be left behind to ensure the cell
pellet is not disturbed.

7. Resuspend the cell pellet in the remaining supernatant. Pipette 5-10ulL of the sample on to the well of
a slide (differentamounts may be used). Place the slide in the incubator or on a heat block to dry.

8. Stain the slide with"’Xmas Tree Stain (refer to the Identification of Cellular Material using Xmas Tree
Staining procedure).

9. [If only screening is being performed and enough sperm are present in a sample, no further work on that
sample may be necessary and that sample (along with the reagent blank) can be referred for DNA
testing. In general, at least 100 sperm cells in the sample are needed for successful DNA typing. If no
sperm are observed in a sample then proceed with the following steps.

10. Add back the substrate to what remains of the water extract and add 750uL of digest buffer and 25ul of
proteinase K to the tube. Incubate the sample for at least one hour at 56°C.
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11. Retain as much liquid from the substrate as possible and discard the substrate.
12. Microcentrifuge the sample at maximum speed for 3-5 minutes.

13. Carefully pipette off all but 50-100uL of the supernatant being careful not to disturb the pellet. The
supernatant can be discarded. At least 50uL of supernatant should be left behind to ensure the cell
pellet is not disturbed.

14. Add 1mL of water to the cell pellet and resuspend by lightly vortexing.
15. Microcentrifuge the sample at maximum speed for 3-5 minutes.

16. Carefully pipette off all but 50-100uL of the supernatant being careful notto disturb the pellet. The
supernatant can be discarded. At least 50uL of the supernatant should be left behind to ensure the cell
pellet is not disturbed.

17. Resuspend the cell pellet in the remaining supernatant. Pipette the remainder (or portion) of the
sample on to the well of the slide. Place the slide in‘the incubator or on a heat block to dry.

18. Stain the slide with Xmas Tree Stain (refer to the Identification of Cellular Material using Xmas Tree
Staining procedure).

19. If sufficient sperm are present in a sampleyno further work on that sample may be necessary and that
sample can be referred for DNA testing. 1f no sperm were present for a sample even after the second
round of microscopy, it may be necessary toprepare an extract of a second sample from the evidence.

20. If warranted, a small portion‘can be extracted for p30 analysis. Refer to the Detection of Seminal
Protein p30 Using the Abacus p30 Diagnostic Card procedure.

REMARKS:

The systematic approach to the analysis of semen provides the analyst with the opportunity to assay for body
fluids, to perform microscopy on cells, and to perform DNA testing from a single extract of a potentially
limited sized evidence sample. It represents a superior approach for creating individual extracts for each

class of testing.

The systematic approach to the analysis of semen is carried out by creating a single water extract from a
substrate that may contain semen and other body fluids. Following centrifugation of the water extract, the
supernatant can be used to test for the presence of blood, semen, saliva, urine and feces. The cellular
portion of the extract, after it has been resuspended in the remaining supernatant, can be analyzed
microscopically for the presence of sperm and other cells. Depending on the results of these initial tests,
the remaining sample can be used for DNA testing.
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The reagent blank will be subjected to all reagents used in the extraction process and all manipulations
carried out on the evidence samples. The reagent blank is necessary to ensure that any contaminant
introduced during the extraction process is detected. The use of a reagent blank is mandatory if the samples
are to be tested using the extremely sensitive polymerase chain reaction (PCR) DNA tests. If the extracted
materials are to be used for DNA analysis, the distilled water and microcentrifuge tubes used in the
"Systematic Approach to the Analysis of Semen" must have been autoclaved.

REFERENCE:
Blake, Sensabaugh, Bashinski, "A Systematic Approach to the Analysis of Semen
Evidence." CAC Meeting, November, 1980
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Method: Two-Step Acid Phosphatase Screening Test for Semen
Date: 09/13/2001 Revision Date: 02/06/2009 Approved by: SAM
REAGENTS:

1. SODIUM ALPHA-NAPHTHYL PHOSPHATE SOLUTION (saturated)

Sodium alpha-naphthyl phosphate (a calcium form can also be used) is prepared as a saturated solution
in acetate buffer. Prepare fresh or freeze into one use aliquots.

2. Ortho-DIANISIDINE WORKING SOLUTION

Ortho-Dianisidine (fast blue salt BN) is added to acetate buffer until a yellow brown solution is
produced. Prepare fresh or freeze into one-use aliquots.

3. ACETATE BUFFER, pH 5

Add 5mL of glacial acetic acid to 10g of sodium acetate (anhydrous) in a suitable container. Bring
volume to 500ml with dH,O. Adjust pH to’5. Good for nine months (refrigerated).

MATERIALS:

1. Spray apparatus
2. Disposable pipettes

PROCEDURES:

A quality control check of the reagents against a known semen sample and a negative of reagents only before
use. The results of the quality control test must be recorded in the case notes.

CUTTING METHOD

. Place a small portion of the sample in a small test tube or on filter paper.
2. Add 1-5 drops of alpha-naphthyl phosphate.
3. Add 1-5.drops of ortho-dianisidine and observe for any color change. Positive tests show a red-purple
precipitate.

SWAB METHOD

Wet a cotton swab with dH,O then rub the sample and proceed as above with step 2 on the swab.
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MAPPING

1. Weta piece of filter paper with dH,O. Press against the suspected semen stain sample for a few
seconds.
2. Drip or spray alpha-naphthyl phosphate onto the paper.

3. Drip or spray ortho-dianisidine onto the paper. Positive tests show a red-purple color on the paper.

INTERPRETATION:

Acid phosphatase is an enzyme found in high concentrations in semen, but is also found in other body fluids
and is produced by other organisms such as bacteria, yeast, fungi, and plants. High levels of acid
phosphatase can be found in concentrated vaginal discharge or secretions.

Appropriate results from the negative and positive control must be obtained with the reagents prior to their

use on unknowns.

No color change should be observed after adding alpha-naphthyl phosphate. Ifa color occurs prior to
adding ortho-dianisidine, then the results are inconclusive.

The color change observed after adding ortho-dianisidine should:occur within 45 seconds to be considered a
positive reaction. A strong positive reaction will produce an intense color change within a few seconds. A

color change within 10 seconds that lacks intensity will be considered a positive reaction. Any color change
that occurs after 10 seconds is considered a weak positive reaction, regardless of color intensity. Any weak
reactions should be noted in the case notes. Color change reactions observed after 45 seconds are

considered negative.

When mapping an item, it is important:to remember that as seminal fluid is deposited onto a fabric, the
concentration of spermatozoa will usually be highest in the middle of the stain with the greatest
concentration of acid phosphatase usually along the outer edges.

REFERENCES:

1. Blake, Sensabaugh, Bashinski. A Systematic Approach to the analysis of Semen Evidence. CAC Meeting,
6 November 1980

2. Gaensslen, R.E. Sourcebook in Forensic Serology, Immunology, and Biochemistry, 1983

3. Saferstein, Baechtel, "The Identification and Individualization of Semen Stains”, Forensic Science
Handbook, Vol. 2,1988

4. Metropolitan Lab. Biology Methods Manual, 1978

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 13 of 190




Unit Technical Manual

Forensic Biology

Method: One-Step SERI AP Spot Test Detection of Acid Phosphatase

Date: 01/11/2001 Revision Date: 02/06/2008 Approved by: SAM

REAGENTS:

1. .26g SERI AP Spot Test (SERI Catalog #R558)
2. 10mL Distilled/Deionized water

Different volumes of the reagent may be prepared. The ratio of reagent to water should not be changed

MATERIALS/EQUIPTMENT:

1. Whatman Filter Paper and/or cotton swabs
2. Disposable pipettes

PROCEDURE:

A quality control check of the reagent against a known semen sample and a negative of reagents only before
use. The results of the quality control test must be recorded in the case notes.

1. Dissolve the AP Spot Test reagent in water and test the reagent against known positive and negative

semen standards before use.

2. Moisten a piece of Whatman filter paper oracotton swab and vigorously press or rub it against your
questioned sample. Alternatively, asmall cutting from the questioned sample may be taken and placed
on a piece of filter paper.

3. Drip the AP reagent onto the filter paper, swab, or cutting on filter paper.

INTERPRETATION:

Acid phosphatase is an.enzyme found in high concentrations in semen, but is also found in other body fluids
and is produced by other organisms such as bacteria and yeast. High levels of acid phosphatase can be found
in concentrated Vaginal discharge or secretions.

Appropriate results from the negative and positive control must be obtained with the reagents prior to their

use on unknowns.
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The color change observed after adding ortho-dianisidine should occur within 45 seconds to be considered a
positive reaction. A strong positive reaction will produce an intense color change within a few seconds. A

color change within 10 seconds that lacks intensity will be considered a positive reaction. Any color change
that occurs after 10 seconds is considered a weak positive reaction, regardless of color intensity. Any weak
reactions should be noted in the case notes. Color change reactions observed after 45 seconds are

considered negative.

REMARKS:

Acid phosphatase is an enzyme found in high concentrations in semen, but is also found in other body fluids
and is produced by other organisms such as bacteria, yeast, fungi, and plants. High levels of acid
phosphatase can be found in concentrated vaginal discharge or secretions.

In the presence of acid phosphatase the SERI AP Spot Test reagent contains all’the components necessary to
carry out the following reaction: liberation of napthol from sodium alpha-naphthyl phosphate by the
enzyme and the formation of a purple azo dye by the coupling of napthol with buffered fast blue B.

The reconstituted reagent will remain stable and sensitive for one day’s use at room temperature.

REFERENCE:

Serological Research Institute. Laboratory Protocol, September 29, 1989
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Method: Identification of Cellular Material Using Xmas Tree Staining

Date: 01/20/2000 Revision Date: 01/01/2007 Approved by: SAM

REAGENTS:

1. NUCLEAR FAST RED STAIN

Dissolve 5.0g of aluminum sulfate in 100mL of hot distilled water and add 0.1g of Nuclear Fast Red
(C.1. 60760). Stir, cool, and then filter. This solution is stable for many months stored at 8°/C.

Stain can be ordered pre-made from Seri, catalog #R540.

2. PICROINDIGOCARMINE STAIN

To 100mL of saturated picric acid solution add 0.33g of Indigo Carmine (C.1. 73015) and stir
overnight. Filter and store at 8°C. This solution is stable for many months under these conditions.

Stain can be ordered pre-made from Seri, catalog #R540.
PROCEDURE:

1. Extract the sample according to the procedure for Differential DNA Extraction or Screening for the
Presence of Semen and fix the sample(s) to the slide.

2. Cover sample well(s) on the slide(s) with a drop of Nuclear Fast Red stain (Seri Stain A) and leave for
approximately 10 minutes.

3. Wash away Nuclear Fast Red stain with distilled water dispensed from a wash bottle.

4. Add one drop of Picroindigocarmine stain (Seri Stain B) to the sample well(s) without drying the slide.

Rotate the dye on the slide by hand for 15-30 seconds. Wash the stain from the slide with EtOH
dispensed from a wash bottle. Dry the slide and mount a coverslip with Permount.

5. Examine microscopically. The slide can be examined by phase contrast before or after staining with
Xmas Tree stain.

REMARKS:
Nuclear material is stained red by the Nuclear Fast Red dye. Sperm heads are usually well differentiated

with the acrosome staining less densely than the distal region of the head. Epithelial membranes and sperm
tails are stained green by the Picroindigocarmine. Nuclei inside epithelial cells appear red to purple. Yeast
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cells also stain red, however, the stain is uniform throughout the cells and extends into polyp-like structures
which are occasionally observed with yeast cells. Under phase contrast, the sperm heads will appear bright
white with a dark acrosome.

REFERENCES:

Gaensslen, R., Sourcebook in Forensic Serology, Immunology and Biochemistry. US
Government Printing Office, 1983.

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 17 of 190

J




Unit Technical Manual

Forensic Biology

Method: p30 Detection Using the Abacus p30 Diagnostic Card

Date: 3/31/00 Revision Date: 05-13-2013 Approved by: SAM

REAGENT:
Sterile Nanopure Water.

MATERIALS/ EQUIPMENT:

1. Abacus p30 Diagnostic Test Card Kit. The kit includes the test cards and plastic droppers. Abacus
Diagnostics catalog #308322 (25 tests/kit).
2. Microcentrifuge (capable of 10,000-15,000 x g).

PROCEDURE:

1. Place a cutting* of the stain or swab into a sterile 1.5mL tube. If oneswab or less is tested, add 250uL
nanopure water to saturate the material. If 1% swabs s used, then 300-350ul nanopure water should
be enough to saturate the material. Extracts of positive control samples (neat semen and a 1:20
dilution of semen), and a negative control (reagents only) should also be run with the unknowns.

* If a high amount of semen is expected, add 75lL or enough nanopure water to just saturate the material,
leaving a small amount of excess water. A 1:10dilution of the extract will be generated prior to its
addition to the test card.

Note: The positive control samples can be pre-made stains of neat semen and a 1:20 semen dilution.
Alternatively, the 1:20 dilution may be made from the extract of the neat semen stain.

2. Incubate the samples for 45 minutes at room temperature. Vortex or agitate the samples three or four
times during the incubation:.

3. Remove the'substrate or swab and place it into a spin basket. Centrifuge the spin basket for 5 minutes
at maximum speed.

4. Remove the spin basket containing the substrate and retain if necessary. The tube will contain a
supernatant with water-soluble proteins such as the p30 protein and the cell pellet. The supernatant
will be used for the Abacus p30 Diagnostic Test and the cell pellet can be microscopically examined for
the presence of cellular material.

5. Ifahigh amount of semen is expected, create a 1:10 dilution of the supernatant, otherwise skip to Step
6. To generate the 1:10 dilution, add 20ul of the supernatant to a sterile 1.5mL tube containing 200ul
of water.

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 18 of 190




Unit Technical Manual

Forensic Biology

6. Load 200uL of the supernatant from Step 4 onto the sample loading “S” area of the test card. If the
supernatant was diluted, load the entire contents of tube created in step 5 onto the test card.

7. Immediately start timing the reaction. The test card result should be read at ten minutes. Record the
results as positive or negative on the Abacus p30 Test Worksheet. The test results can be documented
by using a document scanner or digital camera. Once a hard copy of the test cards is obtained there is
no need to keep a permanent data file of the image.

Note: Under no circumstances should results obtained after 10 minutes be recorded.
8. Ifapositive result for the p30 protein is obtained for a given sample it may be appropriate to also test a
substrate control for that sample. For positive results from a questioned stain it could prove useful to

test additional serial dilutions of the sample to provide information on how concentrated the stain is.

INTERPRETATION:

A positive test result for the presence of the protein p30 is indicated by the presence of pink bands at both
the control line “C" and the test line “T* on the test card. The presence of a pink band at the control line
but the absence of a pink band at the test line indicates a negative result. A pink band will always appear at
the control “C” area. The band in the “C” area is an internal control of the test strip. If a pink band does
not appear at the control “C” line of the test card the test is invalid.

For a test series to be interpreted the positive-and negative controls must yield the expected results.

Legend: “S” = Sample loading area “T” = Test line “C” = Control line

@
@
@

] © e

=]
=]
=]
=]
I

POSITIVE NEGATIVE INVALID
REMARKS:
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The principle behind the Abacus p30 Diagnostic Test Card is that p30 protein present in a sample will react
with a mobile monoclonal antihuman p30 antibody creating a mobile antigen-antibody complex. This
mobile antigen-antibody complex migrates through the absorbent test device towards the test area. In the
test area “I”, a polyclonal antihuman p30 antibody is immobilized. This immobilized antibody captures the
above complex creating an antibody-antigen-antibody sandwich. The conjugated pink dye particles
concentrate in a narrow zone on the membrane. When the p30 concentration in the samples exceeds
4ng/mL the pink dye particles will form a pink colored band in the test area “T” indicating a positive result.
An internal positive control in area (C) consists of an immobilized anti-immunoglobulin antibody that binds
all p30 antibody-dye conjugates that are unable to bind to the antibody in the test area (T). The captured
dye particles will form a pink band at test area “C” indicating that the test has worked properly.

During the initial validation work on the Abacus p30 Test Card performed at the San Diego Police
Department, a single concentrated male urine sample gave a positive test result with the test card.
However, the small amount of p30 protein present in male urine was not detected.in dried urine stains
prepared from urine that had been diluted with water (1:5). Three controls were previously prepared for
use with Abacus p30 Test card consisting of an extract prepared from a swatch with undiluted semen, a
1:20 dilution of the semen extract, and an extract prepared from a swatch with undiluted male urine.
Additional experiments demonstrated that dried male urine did not produce positive results with the test
cards. As such, the undiluted male urine control is unnecessary and the only controls required are the neat
and 1:20 diluted semen controls. These controls should be prepared alongside extracts from the questioned
samples. The neat semen and 1:20 dilution of semen should yield a positive result with the test card. A
reagent blank (negative control) should also be run with the test card.

Analysts should be aware that the p30 protein.is used.asa diagnostic marker for prostate cancer where it is
significantly overexpressed. In males with prostate cancer the p30 protein can be found in very high levels
in both urine and in blood.

REFERENCES:

1. Abacus Diagnostics p30 Test Card Product Insert “One step ABAcard p30 Test for the Forensic
Identification of Semen”.

2. Armbruster, D.A. P30: biochemistry, analytical methods, and clinical application. Clinical Chemistry.
v39(2), p 181-95, 1993.

3. Benton, K.A., Donahue, ]J.A., and Valdez, Jr., Manuel. Analysis of the ABAcard OneStep p30 Test
for use in the forensic laboratory. Presented at the Spring Meeting of SWAFS. 1998.

4. Engelmann UH, Schramek, P., Tomamichel, G., Deindl, F., Senge, T.H.
Vasectomy reversal in central Europe: results of a questionnaire of urologists in Austria, Germany, and
Switzerland. Journal of Urol. v143(1), p64-67, 1990.

5. Graves, H.C.B. etal. Postcoital detection of a male-specific semen protein. Application to the
investigation of rape. New England Journal of Medicine. v312(6), p338-343, 1985.

6. Hochmeister, M., Rudin, O., Borer, U.V., Gehrig, C., Kratzer, A., Dirnhofer, R. Evaluation of
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Method: Leucomalachite Green (LMG) Presumptive Test for Blood
Date: 4/1/99 Revision Date: 08/14/2009 Approved by: SAM
REAGENTS:

1. LEUCOMALACHITE GREEN (LMG) SOLUTION

0.1g LMG (p,p-benzylidene-bis-N,N-dimethylaniline)
66mL glacial acetic acid
33mlL distilled H,O

Alternative amounts of the above reagents (in the same proportions) may be used depending on the
amount of desired reagent. Store refrigerated over excess zinc. Caution: the reagent will evolve

hydrogen gas continuously. Do not cap tightlv!!

Expiration: The reagent is usable as long as the LMG is in the clear (reduced) form. The color of the
reagent should be evaluated before each use. A reagent which is lightly tinged green is still usable. A
reagent that has become dark-green or opaque should be discarded.

2. HYDROGEN PEROXIDE 3%

Prepare by 1:10 dilution of 30% stock H;O5 0r use-a commercial 3% solution.
MATERIALS:
Cotton swabs or filter paper (test substrates)

PROCEDURE:

1. Test the reagents against positive and negative blood standards before using. Record these results in
your notes.

2. Moistena cotton swab or filter paper (the test substrate) with distilled water. Gently press or rub the
stain with the substrate.

Alternatively, a portion of the stained material can be cut and used directly as the test substrate.
3. Add 1 or 2 drops LMG solution to the test substrate. Observe briefly for any color change.

4. Add 1 or 2 drops of 3% hydrogen peroxide. Observe for any color change.
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INTERPRETATION:

A swiftly developing (within 5 seconds) blue-green color after step 4 is a positive test and presumptively
indicates the presence of blood. When evaluating the color change in this reaction, the appearance of the
stain, the amount of material being tested, and the condition of the stain should all be taken into
consideration. Analysts may denote a reaction as weak if they can articulate their interpretation (the
underlying reason for calling a reaction weak - color change that lacks intensity or a delayed color change
not to exceed 30 seconds — should be added to the notes).

Lack of a color change before 30 seconds indicates a negative reaction and the absence of blood in
detectable quantities.

Any change to a blue-green color after step 3 may indicate the presence of an oxidizer and should not be
interpreted as a positive. A color change at this step should be deemed inconclusive.

The test depends on the oxidation of LMG from a colorless to.a colored form. This reaction is catalyzed in
the presence of heme and its derivatives. The reaction can also, take place in the presence of other catalysts,

such as peroxidases, or inorganic oxidizers. Therefore, the test cannot be considered completely specific

for blood.
REFERENCES:

1. Burdett, P.E. "Presumptive Tests for Blood -'A Comparative Survey", CRE Report No. 201, October
1976

2. Cox, M. "A Study of the Sensitivity‘and Specificity of Four Presumptive Tests for Blood", ] Forensic
Sci. Vol. 36, no. 5 (Sept. 1991);pp. 1503 - 1511

3. Gaensslen, R.E. Sourcebookdn Forensic Serology, Immunology, and Biochemistry, section 6.5
Grodsky et al., "Simplified Preliminary Blood Testing - An Improved Technique and Comparison of
Methods", J. Criminal Law, Criminology, and Police Science Vol. 42, (1951), pp. 95-104.
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Method: Phenolphthalin Presumptive Test for Blood (Kastle—Meyer Test)
Date: 4/1/99 Revision Date:08/14/2009 Approved by: SAM
REAGENTS:

1. PHENOLPHTHALIN STOCK SOLUTION

To a single-neck round-bottom flask, add:

10g phenolphthalein powder
100g potassium hydroxide
100g zinc shavings

500mL distilled H,O

Place the flask in a heating mantle and attach a reflux unit. Adjust the mantle setting to gently boil the

solution. Reflux until clear. Store refrigerated over excess zinc.

Expiration: Stock solution is usable as long as it is in"the clear (reduced) form. A pinkish solution has
oxidized and should be re-refluxed or discarded.

2. PHENOLPHTHALIN WORKING SOLUTION

Add 4 parts of ethanol to one part phenolphthalin.stock solution. The reagent will be cloudy
immediately following preparation; let stand refrigerated overnight to clear. Store refrigerated over

excess zinc.

Expiration: The same precautions used for the stock solution should be applied. A pinkish solution

should be discarded.

3. HYDROGEN PEROXIDE 3%

Prepare by 1410 dilution of 30% stock H,O, or use a commercial 3% solution.
MATERIALS:
Cotton swabsor filter paper (test substrates)
PROCEDURE:

1. Test reagents against positive and negative blood standards before using. Record these results in your

notes.
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2. Moisten a cotton swab or filter paper (the test substrate) with distilled water.

Gently press or rub the stain with the substrate. Alternatively, a portion of the stained material can be
cut and used directly as the test substrate.

3. Add 1 or 2 drops phenolphthalin working solution to the test substrate. Observe briefly (up to 30
seconds) for any color change.

4. Add 1 or 2 drops of 3% hydrogen peroxide. Observe for any color change.

INTERPRETATION:

A swiftly developing (within 5 seconds) pink to magenta color after step 4 is a positive test and
presumptively indicates the presence of blood. When evaluating the color change.in this reaction, the
appearance of the stain, the amount of material being tested, and the condition of the stain should all be
taken into consideration. Analysts may denote a reaction as weak if they can articulate their interpretation
(the underlying reason for calling a reaction weak - color change that lacks intensity or a delayed color
change not to exceed 30 seconds — should be added to the notes).

Lack of a color change before 30 seconds indicates a negative reaction and the absence of blood in
detectable quantities.

Bloodstains may change to a greenish color after step 3.7 Any change to a pink color at this stage may
indicate the presence of an oxidizer and should-not be interpreted as a positive.

The test depends on the oxidation of clear phenolphthalin to colored phenolphthalein. This reaction is
catalyzed in the presence of heme andits derivatives. The reaction can also take place in the presence of
other catalysts, such as peroxidases, or inorganic oxidizers. Therefore, the test cannot be considered
completely specific for'blood.

REFERENCES:

1. Cox, M. "AsStudy of the Sensitivity and Specificity of Four Presumptive Tests for Blood", ] Forensic
Scii Vol. 36, no..5 (Sept. 1991), pp. 1503 - 1511

2. Gaensslen; R.E. Sourcebook in Forensic Serology, Immunology, and Biochemistry, section 6.3

3. Grodsky et al., "Simplified Preliminary Blood Testing - An Improved Technique and Comparison of
Methods", ]J. Criminal Law, Criminology, and Police Science Vol. 42, (1951), pp. 95-104.
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Method: Luminol Detection of Latent Bloodstains
Date: 01/02/2001 Revision Date: 01/01/2007 Approved by: SAM
PURPOSE:

The Luminol test is a presumptive test for the detection of latent bloodstains not visible to the naked eye.
The test is based on the peroxidase-like activity of the hemoglobin molecule. Hemoglobin derivatives
greatly enhance the chemiluminescence exhibited by luminol when it is oxidized in an alkaline solution.

The luminol test is very well suited for, but not limited to, crime scene applications, especially where there
is a suspicion of possible clean-up of bloodstained areas. This test may also be employed to help in the
visualization of certain bloodstain patterns that may be only partially visible to the naked eye (i.e. drag

marks, shoe impressions, etc.).
POLICY:

This test is not to be used as a substitute for careful visual examination for blood. The area of interest
should be searched in daylight or with the aid of high intensity light prior to the use of luminol.

A Criminalist will be called to the scene to take partin the luminol procedure and to interpret any patterns
that may develop.

REAGENTS AND MATERIALS:

1. Luminol powder (3-aminophthalhydrazide)

2. Sodium Perborate

3. Sodium Carbonate

4. Distilled water

5. Plastic hand pump spray bottle

6. 1L plastic bottle

CONTROLS:

Positive Control: Known blood (or bloodstained area) or a copper penny.
Negative Control: Area void of any suspected bloodstains.
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PROCEDURE:

1. The following proportions of reagents should be employed for 100mL of luminol spray:

0.1¢g luminol powder
0.7¢g sodium perborate
5.0g sodium carbonate

100mL distilled water

2. Weigh out the appropriate amount of the reagents and place them into a plastic 50mL tube. If the
reagents are not to be used immediately it is best to store the sodium perborate in a’separate’ 50mL
tube. The luminol and the sodium carbonate may be stored together. Once the reagents/are mixed
together they have a limited shelf life (approximately 24 hours).

3. Measure the appropriate amount of water and place it in a plastic bottle.” Immediately prior to luminol
application the reagents may be added to the water in the plastic bottle and thoroughly mixed. Once
mixed, the luminol reagent should be decanted into the plastic hand pump spray bottle. Undissolved
powder may have a tendency to clog the pump mechanism;,

4. Prior to the application of the luminol spray, a copper penny:should be placed in the general vicinity of
the area to be tested. Set up any camera equipment required for documentation of the
chemiluminescence at this point, if required.

5. Darken the area suspected of containing latent bloodstains to near or total darkness. It is advisable to
allow time for eyes to adjust to darkness.

6. The nozzle of the plastic hand pump spray bottle should be set to the finest mist setting. Lightly spray
the area of interest, as well as'the copper penny. If applicable lightly spray an area known to contain
bloodstains, as well as.a known negative area.

INTERPRETATION:

A strong bluish chemiluminescence (positive reaction) should be exhibited by the penny when sprayed with
the luminol mixture.  This glow results from the penny because the luminol mixture is known to react with
certain metal halides of copper and iron. The positive reaction from the penny can be used as a quality

control of the luminol mixture.

A positive reaction in the area of interest is also identified by the presence of a strong chemiluminescent
“glow”, which lasts several seconds. Caution must be exercised in interpreting faint, or weak, reactions as
well as “flashes” which could result from the interaction of luminol with metallic halides. Generally,
“flashes” will fade to total darkness immediately after spraying, while a positive bloodstained area will
exhibit a longer lasting continuous reaction.
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The chemiluminescence exhibited from the oxidation of luminol by a bloodstained area is bluish-white in
nature and best visualized under total darkness.

Positive reactions with the luminol reagent should be judged on the color of the reaction, the intensity of
the reaction, and the duration of that reaction.

It is important to note that luminol will react to produce a false positive with any agent that can oxidize the
chemical directly. Some cleaning agents (i.e. Drano and Pine-sol) as well as metallic halides can produce
false positives with the luminol reagent. A positive reaction obtained with the luminol reagent, even a
strong, long lasting chemiluminescence, is not enough to confirm the presence of blood.

It should also be noted that luminol will not interfere with further presumptive testing, human origin
through testing by HemaTrace, or subsequent DNA testing.

COLLECTION:

General evidence collection guidelines should be used for the collection of luminol positive areas. If a
luminol-positive stain is going to be collected using a swab, use the spenge-tipped swab provided
specifically for the collection of luminol-positive stains.“The preservation steps are the same although
drying time is longer.

DOCUMENTATION:

Case notes regarding luminol application should,alwaysbe taken as with any forensic procedure.
Documentation through photography is highly recommended (where possible). Documentation of luminol
reactions can be accomplished with digital photography as well as film-based photography. Photographic
documentation of the luminol reaction is.best accomplished in near or total darkness. It is recommended
that a control (available light or flash) photograph be taken of the area to be sprayed. A reliable reference
scale should be placed in the area to be photographed. It is important that the camera not be moved
between the control photograph and the luminol photograph so that proper orientation and reference can
be inferred.

SAFETY CONCERNS:

May be harmful by inhalation, ingestion, or skin absorption. Causes skin and eye irritation. Material is
irritating to.mucous membranes and upper respiratory tract. Goggles and rubber gloves should be worn.
Use of a maskis required if being used in an enclosed room. Do not breathe the chemical dust. In case of
contact, immediately flush eyes with water for 15 minutes and wash hands with soap and copious amounts
of water.

Do not dispose of excess luminol at the scene. It is to be brought back to the lab for disposal down the
drain.
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If used at a crime scene, the Department is required to leave behind a list of companies that are available for

crimescene clean up.

REFERENCES:

1. Della Manna A and Montpetit S. A novel approach to obtaining reliable PCR results from Luminol
treated bloodstains, J. Forensic Sci., 45:886-890, 2000.

2. RR] Grispino. The effect of Luminol on the serological analysis of dried human bloodstains, Crime
Laboratory Digest, Vol. 39(5), pp. 13-23, 1990.

3. DL Laux. Effects of Luminol on the subsequent analysis of bloodstains, ] Forensic Sci., 36(5), pp.
1512-1520, 1991.

4. AM Gross, KA Harris, GL Kadlun. The effect of luminol on presumptive tests and DNA analysis using
the polymerase chain reaction, ] Forensic Sci., 44(4), pp. 837-840, 1999.

5. Sourcebook in Forensic Serology, Immunology and Biochemistry, National institute of Justice (1980).
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Method: Abacus HemaTrace Detection of Blood

Date: 12/08/1999 Revision Date: 11/01/2011 Approved by: SAM

REAGENTS:

Kit supplied extraction buffer.

MATERIALS/ EQUIPMENT:

Abacus HemaTrace Test Card Kit. The kit includes test cards, plastic droppers,and extraction buffer.
Abacus Diagnostics catalog #708424 (25 tests/box).

PROCEDURE:

Place a cutting of the stain or swab into a sterile 1.5mL tube. Add-100uL of kit extraction buffer. A
solution of 5% ammonia may also be used to extract a stain that is-difficult to remove from the
substrate. Extracts should also be prepared from a known human blood stain (positive control) and a
reagent blank (negative control).

Note: If stains remain in extraction buffer or 5% ammonia in a refrigerator for extraction, they must be

warmed to room temperature before proceeding with step 2.

2.

Remove enough of the supernatant created in step 1 so that when it is added to a second tube
containing 150uL of extraction buffer the color of the solution is a light straw yellow.

Note: If the supernatant created in step 1's clear or light straw yellow, dilution in additional extraction

buffer is not necessary. /Alternative volumes of the kit extraction buffer may also be used to obtain the light

straw yellow color.

3.

4.

Load 150uL of the extraction solution onto the test card (area S).

Immediately start timing the reaction. The test card result(s) should be read at ten minutes. Record
the results as positive or negative on the Abacus HemaTrace Test Worksheet. The test results can be
documented by using a document scanner or digital camera. Once a hard copy of the test cards is
obtained there is no need to keep a permanent data file of the image.

Note: Under no circumstances should results obtained after 10 minutes be recorded.

If a positive result for human blood is obtained for a given sample it may be appropriate to also test a

substrate control for that sample.

INTERPRETATION:
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A positive test result for the presence of human blood is indicated by the presence of pink bands at both the
control line “C* and the test line “T* on the test card. The presence of a pink band at the control line but
the absence of a pink band at the test line indicates a negative result. A pink band will always appear at the
control “C” area. The band in the “C” area is an internal control of the test strip. If a pink band does not
appear at the control “C” line of the test card the test is invalid.

For a test series to be interpreted the positive and negative controls must yield the expected results.

Legend: “S” = Sample loading area “T” = Test line “C” = Control line

@
@
@

] © b

=
=
=
=
I

S S S S

POSITIVE NEGATIVE INVALID

REMARKS:

The principle behind the Abacus'HemaTrace Test Card is that the human hemoglobin protein present in a
sample will react with a mobile monoclonal

antihuman hemoglobin‘antibody creating a mobile antigen-antibody complex. This mobile antigen-
antibody complex migrates through the absorbent test device towards the test area. In the test area “T”, an
antihuman hemoglobin antibodyis immobilized. This immobilized antibody captures the above complex
creating an antibody-antigen-antibody complex. The conjugated pink dye particles concentrate in a narrow
zone on the membrane. When the human hemoglobin concentration in the samples exceeds 0.05ug/mL
the pinkidye particles will form a pink colored band in the test area “I” indicating a positive result. An
internal positive control in area “C consists of an immobilized anti-immunoglobulin antibody that binds all
hemoglobin antibody-dye conjugates that are unable to bind to the antibody in the test area “T*. The
captured dye particles will form a pink band at test area “C” indicating that the test has worked properly.

Validation work on the Abacus HemaTrace Test Card performed at the San Diego Police Department
indicates that the HemaTrace card is specific for human blood, only showing some cross-reactivity (positive
results) with certain higher primates. In their very concentrated form, other human body fluids can yield a
positive with the HemaTrace Test Card. This may result from small amounts of hemoglobin being present
in these fluids (urine for example).
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Due to the positive reaction of the Abacus card with blood of higher primates and published reports of a
positive reaction with blood from ferrets, it is required that reports detailing positive reactions with the
Abacus card note these possibilities.

Validation of the HemaTrace Test Card by the Abacus Company revealed that treatment with Luminol,

Coomasie Blue, Ninhydrin, bleach, or detergent did not interfere with obtaining results from human blood.

Human blood present on soil, plant material, leather, or washed jeans also yielded a positive result.

REFERENCES:
1. OneStep ABAcard HemaTrace for the Forensic Identification of Human Blood (kit insert), Abacus
Diagnostics, 1999.

2. Swander, C.]., Stites, ].G. Evaluation of the ABAcard HemaTrace for the Forensic Identification of

Blood, MAFS 1998 Annual Meeting.
3. Kristaly, A., Smith, D.A.S. Validation of the One-step ABAcard HemaTrace for the Rapid
Forensic Identification of Blood, 1999.

4. Culliford, B., The Examination and Typing of Bloodstains in the/Crime Laboratory, US Department of

Justice, Washington D.C., 1964.

5. Spear, T.F., Binkley, S.A. The Hemeselect Test; aSimple and Sensitive Forensic Species Test, Journal

of Forensic Science Society, V34 (1), p 41-46, 1994.

6. Fernando, S.A., Wilson, G.S. Studies of the Hook Effect in the One-Step Sandwich Immunoassay.
Journal of Immunology Methods, V151 (1-2), p47-66, 1992.

7. laux, D.L. Effects of Luminol on the Subsequent Analysis of Bloodstains, ] Forensic Sci, V35 (5), p
1512-20, 1991.

8. Gerberth, V.]J. Practical Homicide Investigation, Checklist and Field Guide, p 72-73, 1997.

9. Cox, M.A. A Study of the Sensitivity and Specificity of Four Presumptive Tests for Blood, Journal of

Forensic Science, V36 (5), p 1503-1511, 1991.

10. Doherty, P.E., Mooney, D.]J¢, Deciphering Bloody Imprints Through Chemical Enhancement, Journal

of Forensic Science, V35 (2), p 457465, 1990.
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Method: Fluid Identification Interpretation Guidelines

Date: 12/08/1999 Revision Date: 09/06/2011 Approved by: SAM

The following is meant as a guide for what conclusions can be drawn based on a given combination of serological test
results.

IDENTIFICATION OF SEMEN

Negative Not Done Not Done Negative for the presumptive
test for semen
Negative Negative Not Done Nosemen was found.
Negative Negative Negative No semen was found.
Positive Negative Negative No semen was found.
Negative Positive Negative Sperm cells were found.
Positive Positive Not Done Semen was found.
Positive Negative Positive Seminal fluid /
semen was found.
Negative Positive Positive Semen was found.
Positive Positive Positive Semen was found.
Positive Positive Negative Semen was found.
Positive/Negative Inconclusive Inconclusive Inconclusive
Positive/Negative Inconclusive Inconclusive/ Negative Inconclusive

When weak/AP positive results are obtained, the disclosure statement, “Acid phosphatase is an enzyme
found in high concentrations in semen, but can also be detected in other body fluids and is produced by

other organisms” needs to appear in the report.
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IDENTIFICATION OF BLOOD

Negative Not Done No blood was found.

Positive Not Done Presumptive test indicated the possible presence of
blood.*

Positive Negative Presumptive test indicated the possible presence of

blood; however the presence of human blood could not
be confirmed.

Positive Positive Blood was found.**

Negative Positive Blood was found.**

* Analysts may come to the reasonable conclusion that a stain is apparently blood (to be stated in report as
such) assuming the stain appears visually consistent with the analyst's expectation for blood, a positive
catalytic test result, or the stain's existence is obvious given thé contextof the crime. An example would be
a bloodstained t-shirt belonging to a stabbing victim. A positive HemaTrace result is mandated for an
analyst to conclude blood (or human blood) is present if or when the stain is diffuse, the catalytic test result
for the stain is suspect because it is difficult to visualize, the stain is on a substrate, such as rust, known to
possibly cause a weak positive reaction with the catalytic test, or triggers a weak catalytic test. Analyst's are
encouraged where there is any doubt, or where the probative value of stain is critical, to employ the

HemaTrace test to conclusively demonstrate the presence of blood.

**May also be blood of ferret or higher primate in origin. This statement must appear in report or

testimony as qualifier if conclusion is presented as to human blood being present.
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Method: Phadebas Amylase Test
Date: 5/1/2012 Approved by: SAM
REAGENTS:

1. PHADEBAS WORKING SOLUTION
0.02g crushed Phadebas tablet
550uL Nanopure water

This recipe is for 5 sample tests, but can be scaled up as needed.

STANDARDS AND CONTROLS:

1. Human salivary a-amylase standard, Sigma-Aldrich #A1031 (500 pL.of 1:100,000 dilution of stock
standard is required for the test)
[The stock standard was reconstituted to ~2mg/mL with:Nanopure water and is stored frozen. 1/100
dilutions of this stock have been prepared for use when analysts run. this test. ]

2. Neat saliva. This is generally prepared fresh on a swab (of which a ~1/4 swab is used) or on filter
paper (of which an ~5x5mm cutting is used) for each test.

3. Blank (Nanopure water)

4. Substrate control (if appropriate)

PROCEDURE:

1. Clear 1.5mL microcentrifuge tubes should be used for this test. For unknowns, add 500 uL of
nanopure water to an,~5x5 mm cutting or an ~1/4 swab. The frozen amylase standard aliquot should
be diluted 1/1000 prior to use (suggested dilution is 5ul in 5mL). For the controls, 500 uL of the
amylase standard dilution'should be used for the test, 500ul nanopure water should be used as a
negative, and 500uL of nanopure water should be added to the neat saliva sample as the positive
control.

2. Add 10QuL of the Phadebas working solution to each sample and vortex.

3. Incubate the samples at 37°C for 30 minutes.

4. Vortex, then centrifuge the samples at maximum speed for 2 minutes.
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INTERPRETATION:

Positive: The presence of 0-amylase is indicated if the blue color in the supernatant is darker than that

of the 1:100,000 human salivary 0.-amylase standard.

NOTE: Blue substrates may produce blue supernatants during the extraction process even though no a-
amylase is present on them. If this is expected, results may be inconclusive (see below).

Inconclusive: The test is inconclusive if the blue color in the supernatant is lighter than that of the
1:100,000 human salivary a-amylase standard, but darker than that of the reagent blank.
The test may also be inconclusive if the blue color in the supernatant is masked by another
color generated during the extraction process (e.g. red-brown supernatant from a
bloodstain).

Negative: The absence of 0i-amylase activity is indicated if the supernatant is clear.

REMARKS:

Amylase is an enzyme present in saliva at high concentrations, hence theuse of amylase as a presumptive
test for the presence of saliva. Amylase is responsible for the digestion of starches, first to oligosaccharides,
then to maltose and glucose. The Phadebas tablets are composed of starch polymers conjugated to a blue
dye. In the presence of amylase, the blue dye is liberated into the supernatant, generating a blue color in
proportion to the level of amylase activity.

Amylase is also present in most other body fluids (e.g. urine) and tissues, albeit at much lower
concentrations than that found in saliva. Feces, breast milk, and nasal secretions may have high levels of
amylase.
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Method: Detection of Urobilinogen in Fecal Stains

Date: 1/27/98 Revision Date: 01/01/2007 Approved by: SAM

REAGENTS:

1.

10 % ALCOHOLIC MERCURIC CHLORIDE ( HgCl, )

Dissolve 0.3 g of mercuric chloride into 3 mL of reagent alcohol.
Freshly prepare this reagent each time this procedure is conducted. Do not store.

2. 10% ALCOHOLIC ZINC CHLORIDE ( ZnCl, )
Dissolve 0.3 g of zinc chloride into 3 mL of reagent alcohol.
Freshly prepare this reagent each time this procedure is conducted. Do not store.
MATERIALS:
1. Ultraviolet ( UV) light source
2. 6 x 50mm borosilicate glass test tubes. Note: flint glass tubes will not work for this method.
PROCEDURE:
1. Prepare an aqueous extract of the unknowns and controls. Appropriate controls include positive
controls (neat, 1:5, and 1:10 dilutions), a negative control (reagents only) and any substrate controls
(if applicable). Cut out approximately 0.5cm square of the stain, and place it into a 6 x 50mm
borosilicate glass test tube. Add 0.25mL-of distilled water to the substrate.
2. Vortex the extracts, then let the extracts stand for at least 15 minutes.
3. Remove the substrate from €ach tube and transfer the supernatant into a 6 x 50mm borosilicate glass
test tube.
4. Add 3 drops of the'10% alcoholic mercuric chloride to each tube.
5. Add 3 drops‘ef the 10% alcoholic zinc chloride to each tube and shake the tubes to mix.
6. Examine the extracts under UV light.
INTERPRETATION:

Under UV light the extracts will have a stable apple green fluorescence if urobilinogen is present. The

controls should yield the expected results for the test to be interpretable.

A positive urobilinogen result is consistent with the presence of feces.

REFERENCES:
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Gaensslen, R.E., Sourcebook in Forensic Serology, Immunology, and Biochemistry, a publication of the National
Institute of Justice, U.S. Department of Justice, August 1983, pp. 197-8.
Method:
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Method: General DNA Extraction
Date: 03/30/2000 Revision Date: 02/06/2009 Approved by: SAM
REAGENTS:

1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS)

Mix together 1 mL of 1M Tris-HCL, ph= 7.5, 2 mL of .5M EDTA, 1 mL of 5M NaCl, 10 mL of 20%
SDS (w/V) and 86 mL of nanopure water. Autoclave and store at room temperature. The solution is
good for one year.

2. 10 mg/mL PROTEINASE K

Dissolve 100mg of proteinase K in 10mL of autoclaved nanopure water,. Store at -20°C in 200uL
aliquots. The aliquots are good for one year.

3. DTT (IMDTT, 10mM Sodium Acetate, pH=5.2)

Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water. Add 50ul 1M autoclaved sodium
acetate pH=5.2. Store at -20°C in 100uL aliquots. The aliquots are good for one year.

EQUIPMENT:

Microcentrifuge (capable of 10,000-15,000 x g)
PROCEDURE:

1. Place a portion of the stain, substrate, or swab in a sterile 1.5mL microcentrifuge tube (or a 2.0MIl
collection tube) and'add 400-500uL of digest buffer and 15-20uL of 10mg/mL proteinase K.

[The Large Volume protocol on the EZ1 can accommodate up to 900uL of volume in the sample tubes.
Analysts'may choose to-add more digest buffer to samples to accommodate larger sized substrates. The
volume of proteinase K added to the sample should be proportional to the volume of digest buffer.]

[If a bloodstain appears especially dirty, the analyst may add 15ul of IM DTT to aid in the digestion of the
bloodstain. If a tissue sample is embedded in paraffin wax please refer to reference 2 for the process of
removing the wax.]

2. Mix gently and incubate at 56°C for at least two hours. Following incubation the samples can be gently
centrifuged to remove moisture from the lids.

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 39 of 190

J




o

Unit Technical Manual

Forensic Biology

3. At this point any samples can be purified using either phenol/ chloroform/isoamyl alcohol or the
BioRobot® EZ1. Please refer to the desired protocol for the procedure.

REFERENCES:

1. Cetus Amplitype User Guide 1990

2. Fregeau CJ et al. AmpFISTR Profiler Plus and AmpFISTR COfiler Analysis of Tissue Stored in
GenoFix, a New Tissue Preservation Solution for Mass Disaster DNA Identification. ] Forensic Sci
2001; 46(5): 1180-1190.
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Method: DNA Extraction in Preparation for Y-Screen
Date: 03/15/2012 Revision Date: 03/15/2012 Approved by: SAM
REAGENTS:

1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDY)

Mix together 1 mL of 1M Tris-HCL, ph= 7.5, 2 mL of .5M EDTA, 1 mL of 5M NaCl,"10.mL of 20%
SDS (w/V) and 86 mL of nanopure water. Autoclave and store at room temperature. The solution is

good for one year.

2. 10 mg/mL PROTEINASE K

Dissolve 100mg of proteinase K in 10mL of autoclaved nanopure water. Storeat -200C in 200uL
aliquots. The aliquots are good for one year.

3. DTT (IMDTT, 10mM Sodium Acetate, pH=5.2)

Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water. Add 50ulL. 1M autoclaved sodium
acetate pH= 5.2. Store at -200C in 100uL aliquots. The aliquots are good for one year.

EQUIPMENT:
Microcentrifuge (capable of 10,000-15,000 x-g)
PROCEDURE:

1. Place a portion of the stain, substrate, or swab in a sterile 1.5mL microcentrifuge tube or a 2.0mL
collection tube and.add 500 -750uL of digest buffer, 20-30uL of 10mg/mL proteinase K, and 20-30ul
of IMDTT.

2. Mix gently and incubate at 56°C for at least two hours. Following incubation, the samples can be
gently centrifuged to.remove moisture from the lids.

3. At thispoint any samples can be purified using the BioRobot® EZ1and eluted in 40ul. Please refer to
the desired protocol for the procedure.

REFERENCES:

1. Cetus Amplitype User Guide 1990
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Method: DNA Extraction with Microscopic Examination
Date: 03/30/2000 Revision Date: 01/01/2007 Approved by: SAM
REAGENTS:

1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS)

Mix together ImL of 1M Tris-HCL, ph= 7.5, 2mL of .5M EDTA, 1mL of 5M NaCl, 10mL of 20%
SDS (w/V) and 86mL of nanopure water. Autoclave and store at room temperature. The solution is
good for one year.

2. 10 mg/mL PROTEINASE K

Dissolve 100 mg of proteinase K in 10 mL of autoclaved nanopure water. Aliquot solution in 200uL
aliquots and store in -20°C freezer. The aliquots are goodfor one year.

EQUIPMENT:
Microcentrifuge (capable of 10,000-15,000 x g)
PROCEDURE:

Note: This procedure is designed for evidence samples. Reference mouth swabs do not require
microscopic analysis (see "BioRobot EZ1 DNA:Purification of Reference Samples" procedure).

1. Place a portion of the substrate or swab ina 1.5mL microcentrifuge tube and add 0.75 to 1mL of

sterile nanopure water.
2. Incubate the sample at room-temperature for at least 30 minutes with occasional vortexing.
3. Remove thesubstrate and place into a second sterile 1.5mL microcentrifuge tube and retain.
4. Centrifuge the sample in a microcentrifuge for 3-5 minutes at maximum speed.

5. Without disturbing the pellet, remove and discard all but 50-100uL of the supernatant. Resuspend the
cell pellet.

6. Refer to the procedure "Identification of Cellular Material Using Xmas Tree Staining."

7. Add 0.5mL of digest buffer and 15-20uL of 10 mg/mL proteinase K solution. Vortex briefly. [The
original substrate can be added back to increase the DNA yield from the sample].
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8. Incubate the sample at 56°C for at least 2 hours.

9. At this point any samples can be purified using either phenol/ chloroform/isoamyl alcohol or the
BioRobot® EZ1. Please refer to the desired protocol for the procedure.

REFERENCES:
Cetus Amplitype User Guide 1990
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Method: Differential DNA Extraction

Date: 06/29/2000 Revision Date: 11/01/2011 Approved by: SAM
REAGENTS:

1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS)

Mix together 1mL of 1M Tris-HCL, ph= 7.5, 2mL of .5M EDTA, ImL of 5M NaCl, 10mL of 20%
SDS (w/V) and 86mL of nanopure water. Autoclave and store at room temperature. The solution
is good for one year.

2. 10 mg/mL PROTEINASE K

Dissolve 100mg of Proteinase K in 10mL of autoclaved nanopure water. Store at -20°C in 200uL
aliquots. The aliquots are good for one year.

3. DTT (IM DTT, 10mM Sodium Acetate, pH=.5.2)

Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water. Add 50ul 1M autoclaved sodium
acetate pH=5.2. Store at -20°C in 100uL aliquots. The aliquots are good for one year.

EQUIPMENT:
Microcentrifuge (capable of 10,000-15,000 x g)
PROCEDURE:

Note: The initial dH,O wash and microscopic analysis of samples that have previously been screened is
optional. If this process is skipped analysts may start the differential extraction at step 8.

1. Place the sample (swab or other substrate) to be extracted in a sterile 1.5mL tube and add 1mL of
sterile distilled water.

2. Incubate at room temperature for at least 30 minutes.
3. Vortex the tube a couple of times during the incubation to aid in removing the cells from the substrate.

4. Remove the substrate with a pipette tip or plain wood applicator and transfer it to a second sterile
microfuge tube and retain.

5. Spin the sample in a microcentrifuge for 3-5 minutes at 10,000 x g (maximum speed) at room
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temperature.

6. Without disturbing the cell pellet, remove and discard all but 50-100uL of the supernatant.
Resuspend the cell pellet in the remaining supernatant. Place 5ul of the sample onto a well of a slide
(different amounts may be used). Place the slide in an incubator or on a heat block to fix any cells to

the slide.

7. At this point proceed to the procedure "Identification of Cellular Material Using Xmas Tree Staining".
Note: In general, 100 sperm cells are needed to obtain a DNA result. The sperm cells observed
microscopically, however, provide only an estimate of the total number of sperm presentin a sample
extract. An analyst should use appropriate judgement when deciding on whether to proceed with
DNA analysis on a particular sample.

8. Add 400-500uL of digest buffer and 15-20uL of 10mg/mL proteinase K to the resuspended cell pellet
(more digest buffer and proteinase K may be added if the substrate is especially large). [Option: The
original substrate can now be added back to increase the amount of cellular material removed from the
substrate.]

9. Incubate at 56°C for 1-2 hours to lyse nonsperm cells. [Option: Incubation may be longer to ensure
lysing of the nonsperm cells].

10. Spin the sample in a microcentrifuge for 3-5 minutes at maximum speed. Remove the supernatant and
place in a sterile 1.5mL microcentrifuge tube. Thissupernatant contains DNA from any non-sperm
cells present in the sample. The sample can be putaside until DNA purification. [The reagent blank
supernatant will act as a control for the non-sperm fraction].

11. [Option: A second digest with digest buffer and proteinase K may be performed in order to ensure that
the sperm fraction is free of non-sperm cells].

Note: An analyst may elect to skip-directly to step 14 in order to immediately perform the microscopic
analysis. Steps12 and 13'should be performed prior to step 16 if sperm cells are observed in the
samples. In this instance step 14 does not need to be repeated.

12. Wash the pelletas follows: Resuspend the pellet in 0.5-1.0mL digest buffer and vortex briefly. Spin
the sampleiin a microcentrifuge for 5 minutes at maximum speed. Remove all but 50-100uL and
discard.

13. Repeat wash step 12 at least twice. [Additional washes are critical when the number of sperm is low
and the number of non-sperm cells is high].

Note: The number of total washes (both digest buffer and distilled water) performed on the sperm
fractions should be appropriate for the nucleated epithelial and sperm cell counts observed during
microscopic examination. For example: a sample with high sperm cell counts should have a
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minimum of three digest buffer washes and one water wash performed. A sample with low sperm
cell counts and high epithelial cell counts should have more digest buffer washes performed (e.g.
five) in an attempt to obtain a sperm fraction free of non-sperm DNA.

Resuspend the pellet in 0.5-1.0mL sterile distilled water and vortex briefly. Spin the cells in a
microcentrifuge for five minutes at maximum speed. Remove and discard all but 50-100uL of the
supernatant. Resuspend the cells in the remaining supernatant.

15. To verify the presence of sperm and the complete digestion of nonsperm cells proceed tothe
procedure "Identification of Cellular Material Using Xmas Tree Staining".
Note: If the sperm fraction is probative, the entire sample being analyzed should contain
approximately 100 sperm to proceed with DNA analysis. In this circumstance both the sperm and
non-sperm fractions should be continued through DNA analysis.
If the non-sperm fraction is probative and sufficient sperm cells are present, both the sperm and non-
sperm fractions must be DNA typed.
If the non-sperm fraction is probative and insufficient.or nosperm cells are found in the sperm
fraction, only the non-sperm fraction needs to be typed.

16. Add 400-500ulL digest buffer, 20ul. 1M DTT and 15-20uL of 10 mg/mL proteinase K solution to the
re-suspended sperm cell pellet.

17. Incubate for at least 2 hours at 56°C.

18. At this point any samples (€ither non-sperm or sperm fraction) can be purified using either
phenol/ chloroform/isoamylalcohol or the BioRobot® EZ1. Please refer to the desired protocol for
the procedure.

REFERENCES:

Cetus Amplitype User Guide 1990
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Method: DNA Extraction from Hair

Date: 03/30/2000 Revision Date: 03/01/2010 Approved by: SAM
REAGENTS:

1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS)

Mix together ImL of 1M Tris-HCL, ph= 7.5, 2mL of .5M EDTA, 1mL of 5M NaCl, 10mL of 20%
SDS (w/V) and 86mL of nanopure water. Autoclave and store at room temperature. The solution
is good for one year.

2. 10 mg/mL PROTEINASE K
Dissolve 100mg of Proteinase K in 10mL of autoclaved nanopure water.Store at -20°C in 200ul

aliquots. The aliquots are good for one year.

3. DTT (1M DTT, 10mM Sodium Acetate, pH= 5.2)
Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water. Add 50ul 1M autoclaved sodium
acetate pH=5.2. Store at -20°C in 100uL aliquets. The aliquots are good for one year.

MATERIALS/ EQUIPMENT:

1. Microcentrifuge (capable of 10,000-15,000 x g)

2. Xylene and 100% ethanol (for mounted hairs)

3. Diamond scribe (for mounted hairs)

4. 50mL sterile disposable plastic tubes

PROCEDURE:

1. Wash hair to reduce surface dirt and potential contaminants as follows:

2. For loose hairs, fill a sterile 50mL plastic screw-topped tube with sterile nanopure water and place the
hair in'the tube using a pair of sterile forceps. Wash each hair separately.

For mounted hairs, freeze the slide in a -20°C freezer for 20 minutes. Remove coverslip by cracking the
coverslip with a diamond scribe. Alternatively, the coverslip may be removed by soaking in xylene for
several hours after cracking the coverslip with a diamond scribe. Wash away the mounting medium by
squirting the slide with xylene. Place the hair in a 1.5mL microcentrifuge tube and add 100% ethanol.
Finally, wash the hair in the microcentrifuge tube by removing and discarding the ethanol and then adding

water.
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3. Examine the hair under a dissecting microscope. Note the possible presence of body fluids on the hair.

Cut off 0.5cm to 1cm of the proximal (root) end for digestion. Because the hair may contain cellular
material on the surface that may or may not originate from the hair donor, it is advisable to cut off 0.5
to 1cm of the shaft adjacent to the root as a control. The remaining shaft should be retained. [Note:
All evidentiary hairs should be photographed prior to performing DNA testing on them. ]

4. Place the hair sample and its control into separate sterile 1.5mL rnicrocentrifuge tubes. Add 0.5mL

digest buffer, 20ul 1M DTT and 15-20ul. 10mg/mL proteinase K.
5. Incubate at 56°C for at least 6 hours.
6. Add an additional 15-20ul. 1M DTT and 15uL of 10 mg/mL proteinase K to the samples.
7. Incubate at least 6 hours or until the hair is dissolved.

8. At this point any samples can be purified using either phenol/ chloroform/isoamyl alcohol or the
BioRobot® EZ1. Please refer to the desired protocol for the procedure.

REFERENCES:

Cetus Amplitype User Guide 1990
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Method: The Processing and DNA Extraction of Bone Samples
Date: 06/21/2005 Revision Date: 04/01/2008 Approved by: SAM
REAGENTS:

1. LIQUID NITROGEN (16 liters is needed as a minimum) obtained from the 50 gallon tank located in
the Trace Evidence section.

2. 10-20% BLEACH (Sodium Hypochlorite)

Dilute store bought bleach between 1:5 and 1:10 with water.

3. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS)

Mix together ImL of 1M Tris-HCL, ph= 7.5, 2mL of 0.5M EDTA; 1mL of 5M NaCl, 10mL of 20%
SDS (w/V) and 86mL of nanopure water. Autoclave and store atroom temperature. The solution is
good for one year.

4. 10mg/mL PROTEINASE K

Dissolve 100mg of proteinase K in 10mL of autoclaved nanopure water. Store at -20°C in 200uL
aliquots. The aliquots are good for one year.

5. DTT (IMDTT, 10mM Sodium Acetate, pH= 5.2)

Dissolve .77g dithiothreitol in SmL autoclaved nanopure water. Add 50ul 1M sodium acetate pH=
5.2. Store at -20°C in.100uLialiquots. The aliquots are good for one year.

6. AMMONIUM OXAIATE (saturated, pH= 3.0)

Make a saturated solution of ammonium oxalate by adding ammonium oxalate to 100mL of nanopure
water. Adjust to pH= 3.0 by adding HCL.

7. 0.5M EDTA (pH= 8.0)
Dissolve 186.1g disodium ethylenediamine tetraacetate-2H,O to 800mL of distilled water. Stir

vigorously and adjust the pH to 8.0 by adding NaOH pellets (approximately 20g). Adjust final volume
g y J P y g p PP y £Vg J

to one liter with distilled water and autoclave.

EQUIPMENT:
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1. 6850 Freezer Mill with grinding accessories
2. 50mL plastic sterile tubes

PROCEDURE:

A bone kit has been assembled for the analysts that require the tools needed to process bone samples for

casework. The kit includes a vise, clamps to secure the vise to a table, a hacksaw with a supply of blades,
sandpaper, and a Dremel™ tool with accessories. It is intended that the vise be used to secure the bone

sample while sectioning a portion for analysis.

1. Clean the two metal end plugs, the metal impactor, and the plastic vial with soap and water being
careful to remove all of the bone debris. Following this cleaning soak the components in 10% bleach
solution for no longer than 30 minutes.

2. Rinse in water and dry all the components (If the metal plugs and impactor are not dried they will

rust).

3. Swab all components using a nanopure water moistened cotton-tipped swab. This swab will serve as a

control during the extraction procedure and should be extracted alongside the bone sample.

4. Remove a portion of the evidence bone (thé amount of bone sectioned will depend on the age and
condition of the bone as well as the environmental exposure) using a clean hacksaw blade. Clean the
bone piece by removing adhering tissue, decaying marrow, and any other debris. Use the provided
sandpaper to remove the approximately lmm of the outermost surfaces of the bone; including the
central area where the marrow was (the bone section may need to be cut in half length-wise to

accomplish this).

5. Soak the bone sample in a 10-20% bleach solution for approximately 15 minutes. Rinse the bone

section twice with nanopure water:

6.  Wrap the bone piece in a latex glove and use a hammer to break the bone into several smaller
fragments.

7. Tightly place one steel end plug on the plastic grinding vial. Place bone fragments and metal impactor
inside vial. Closé the vial with the other metal end piug.

8.  Open the freezer mill lid by pressing the Lid Up/Down switch. Lift the metal gate handle up and turn
it clockwise to line it up with the slot on the gate. Pull the gate down to insert the vial. Insert the vial,
close, and lock the gate (loosely tighten the gate).

9.  Wearing insulated gloves and other appropriate protective gear gradually fill the tub with 16 liters of
liquid nitrogen. This requires the carboy that is used to transport liquid nitrogen to be filled
completely four times.
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Lower the lid slowly by pressing the Lid Up/Down switch until the coil enters the liquid nitrogen.
Pause to allow boiling of the nitrogen around the warm coil. When the boiling subsides, close the lid
the rest of the way.

When the vapor stream has slacked off (30 seconds or so) check the liquid nitrogen level with the
internal sensor by pressing control keys 2 and 3 simultaneously.

When you press the RUN key (with sufficient liquid nitrogen in the tub, a loaded vial in'the ¢oil, and
the factory settings in place), the Freezer/Mill will perform  the following steps:

a. The mill cools for 8 min., while the TIME display counts down the minutes remaining in the pre-

cooling period. The T3 indicator light should be on.

b. The first grinding period begins and lasts for 2 minutes, while the TIME display counts down the

time remaining in that grinding period, and the RUN indicator light is lit, The CYCLE display
shows 3.

c. The first cooling period begins and lasts for 2 minutes; whil¢ the TIME display counts down and the

T2 indicator light is on. The CYCLE display still shows 3.

d. The second grinding/cooling cycle takes place,the same as in steps b and ¢ combined. The TIME

display will count down, and the appropriate RUN and:COOL indicator lights will be on in turn,
while the CYCLE display shows 2.

e. The third grinding/cooling cycle is like the second (step d) except that the CYCLE display shows 1.
f. At the end of the third grinding cycle, the TIME display will flash END for several seconds, and

then the control panel will return to Program Mode, exhibiting the same parameters as when the
mill was first started.

Wearing protective gear, raise thelid by pressing the Lid Up/Down switch and remove the vial by
opening the locked gate.

Fit the metal end plug extractor'over one end of the vial and turn knob clockwise several turns until
the screw engages the metal-end plug. Squeeze the lever, then turn the knob clockwise and repeat until
the end plug is removed. (If the screw locks up wait briefly for vial to warm up before attempting to
open again. )

When the end-plug is removed from the vial, empty the contents of the vial into a suitable container.
Perhaps the easiest means of gathering the ground bone is first to pour the contents of the vial into a
disposable plastic weighboat and then in turn transfer the contents to a 50ml conical plastic tube.

Clean the two metal end plugs, the metal impactor, and the plastic vial with soap and water being
careful to remove all of the bone debris. Following this cleaning soak the components in 10% bleach

solution for no longer than 30 minutes.

Rinse in water and dry all the components (If the metal plugs and impactor are not dried they will
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rust).
18. If running another bone sample ensure the liquid nitrogen level is appropriate and proceed.

19. After the milling of the bone is complete (refer to 6850 Freezer Mill Procedure), pour the ground
bone into a clean weighboat and then transfer the ground bone into a 50mL plastic tube.

Steps #20-22 are optional and involve decalcifying the bone powder over a three day period using 0.5M
EDTA. In some cases, the decalcifying step will increase the amount of DNA recovered from the ground
bone. If a BioRobot® EZ1 extraction is to be performed then the bone sample must be decalcified.”A
BioRobot® EZ1 extraction is only recommended with relatively fresh bone samples.

20. Decalcifying is accomplished by adding 40mL of 0.5M EDTA, pH = 8.0 to the 50mL plastic tube
containing the ground bone. Place the tube on a rocking shaker overnight and.the following morning
spin the tube in the swinging bucket rotor at approximately 2500rpm for 5 minutes. Pour the
supernatant off into another 50mL plastic tube. Save this tube for step#21. Add 40mL of 0.5M
EDTA to the bone powder and resuspend the pellet. Place the tube on the rocking shaker. The 0.5M
EDTA should be changed approximately 4-5 times over the three day period.

21. The decalcification process should be monitored by the addition of saturated ammonium oxalate pH=
3.0, to the decanted supernatants. The addition of the ammonium oxalate to the decanted supernatant
will produce a cloudy precipitate if calcium is present. If the supernatants remains clear after the
addition of ammonium oxalate the decalcification is.complete. The supernatant can be discarded.

22. Following decalcification, wash the bone pellet three times by adding 40mL of sterile nanopure water,
resuspending the pellet and centrifuging thesample for 5 minutes at approximately 2500rpm. Discard
the supernatant.

23. To the bone powder (no.degalcification) or the bone pellet (decalcification), add 7mL (for organic
DNA purification) or 600-700uL (for BioRobot® EZ1 DNA purification) of extraction buffer, 200uL
of 10 mg/mL proteinase Kiyand 100ul of 1M DTT and mix. Incubate the tube at 56°C for at least 4

hours.

24. Tothe initial incubation add another 200uL of 10 mg/mL proteinase K and 100ulL of IM DTT.
Incubate the tube at 56°C at least 6 hours.

If the samples will be purified using the BioRobot® EZ1, please refer to the BioRobot® EZ1 DNA
purification procedure. If phenol/chloroform/isoamyl alcohol DNA purification is to be performed then
continue with step #25 of this procedure.

25. Add 7mL of phenol/ chloroform/isoamyl alcohol to the bone sample. Vortex the sample, spin the
tube at approximately 3000rpm and transfer the upper aqueous phase to a new 50mL tube. Continue
to purify the sample using phenol/ chloroform/isoamyl alcohol until the aqueous-organic interface is
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clear.

26. [Optional] Add 7mL of butanol to the tube, vortex, spin the tube at approximately 3000rpm for 2
minutes and remove the butanol phase (upper) and discard.

27. The purified sample can now be washed and concentrated. Please refer to the protocol for the use of
the Centricon-100 centrifugal filter devices (DNA Purification/ Concentration Using Centricon YM-
100 Centrifugal Filter Devices) to concentrate the purified samples. Each purified bone sample may
require several centricon filter devices as the extracts may have fine bone powder in them which tends
to clog the devices.

REFERENCES:

Hochmeister MN ez al. "Typing of Deoxyribonucleic Acid (DNA) Extracted from  Compact Bone from
Human Remains. | Forensic Sci. 1991 Nov;36(6):1649-61.
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Method: Organic DNA Purification Using Phenol/Chloroform/Isoamyl alcohol (PCIA)
Date: 05/24/2005 Revision Date: 01/01/2007 Approved by: SAM
REAGENTS:

1. PHENOL/CHLOROFORM/ISOAMYL ALCOHOL (25:24:1)

Add 0.1%(w/v) 8-hydroxyquinoline (Sigma Catalogue #H-6878) to the phenol/chloroform/isoamyl
alcohol (Fisher BP17521-400) to prevent oxidation. Store at 4°C. The solution is good for one year.

NOTE: See additional directions concerning the preparation of phenol/ chloroform/isoamyl alcohol as
outlined in the Reagent Preparation Log.

2. n-BUTANOL
To 50mL of n-butanol add approximately 50mL of autoclaved nanopure water and shake. Following
separation the upper layer is n-butanol which is now saturated with water. The solution is good for one
year.

PROCEDURE:

1. Remove the substrate (if applicable), and-add 0:5mL buffered phenol/chloroform/isoamyl alcohol
solution. Vortex for 15 seconds.

[Phenol/ chloroform extractions must be carried out in a hood with a lab coat and eye protection].
2. Spin in a microcentrifuge for 3-5 minutes at maximum speed.

3. Use a sterile pipette tip or equivalent to transfer the upper aqueous phase to a new sterile 1.5mL
microcentrifuge tube.

4. Repeat steps 1-3.an additional one or two times or until the aqueous phase is clear. For these
additional extractions, the lower phenol-chloroform layer may be removed and discarded, thus
eliminating the need for a fresh microcentrifuge tube.

5. The addition of 0.5 to 0.75mL of water saturated n-butanol is an optional step to further purify the
extracted sample (n-butanol removes any residual phenol-chloroform). Vortex 15 seconds.

6. Spin in rnicrocentrifuge for one minute at maximum speed. Discard the upper layer which is n-
butanol.
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7. The purified sample can now be washed and concentrated in TE buffer. Please refer to the protocol
for the use of either the Microcon-YM100 centrifugal filter devices (DNA Purification/ Concentration
Using Microcon YM-100 Centrifugal Filter Devices) or the Centricon-100 centrifugal filter devices

(DNA Purification/ Concentration Using Centricon YM-100 Centrifugal Filter Devices) to concentrate
the purified samples.

REFERENCES:
Cetus Amplitype User Guide 1990
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Method: Organic DNA Purification Using PCIA with the Phase Lock Gel (PLG) Tubes

Date: 10/10/2011 Approved by: SAM

REAGENTS:

1.

PHENOL/CHLOROFORM/ISOAMYL ALCOHOL (25:24:1)

Add 0.1%(w/v) 8-hydroxyquinoline (Sigma Catalogue #H-6878) to the phenol/chloroform/isoamyl
alcohol (Fisher BP17521-400) to prevent oxidation. Store at 4°C. The solution is good for one year.

NOTE: See additional directions concerning the preparation of phenol/ chloroform/isoamyl alcohol as
outlined in the Reagent Preparation Log.

PHASE LOCK GEL TUBES  Phase Lock Gel Heavy 2mL tubes (Fisher Scientific P/N #FP2302830).

PROCEDURE:

1.

Immediately prior to use, pellet Phase Lock Gel (PLG) at 12,000 -16,000 x g in a microcentrifuge for 20-30
seconds.

2. Transfer the digested solution (max volume 750uL) to a Phase Lock Gel 2mL tube.

[Phenol/ chloroform extractions must be carried out in a hood with a lab coat and eye protection].

3. Add 0.5mL buffered phenel/chloreform/isoamyl alcohol solution. Mix thoroughly by inversion or by
repeated pipetting. Do not vortex.

4. Spin in a microcentrifuge for 5 minutes at 16,000 x g (12,900rpm) to separate the phases.

5. Use a sterile pipette tip or equivalent to transfer the upper aqueous phase to a new sterile 2mL PLG
tube.

NOTE: In order to dispose of the liquid in the organic phase, puncture the gel with a pipette tip to release the
liquid below it.

6. Repeat steps 3-5 an additional one or two times or until the aqueous phase is clear.

7.  The purified sample can now be washed and concentrated in TE buffer. Please refer to the protocol
for the use of either the Microcon-YM100 centrifugal filter devices (DNA Purification/ Concentration
Using Microcon YM-100 Centrifugal Filter Devices) or the Centricon-100 centrifugal filter devices
(DNA Purification/ Concentration Using Centricon YM-100 Centrifugal Filter Devices) to concentrate
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the purified samples.

REFERENCES:
1. Manual Phase Lock Gel™ (PLG) User’s Manual. 5Prime Gaitherburg, MD

2. Penn State University Forensic Science Program Organic Extraction Procedure (Protocol No. PSU 031)
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Method: DNA Purification/Concentration Using Microcon YM-100 Centrifugal Filter
Devices

Date: 05/24/2005 Revision Date: 01/01/2007 Approved by: SAM

REAGENTS:

TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH: 8.0)

Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.

Aliquot into 100mL bottles, autoclave and store at room temperature. The solution is'good for nine

months.

MATERIALS:

1. Microcon-YM 100 Centrifugal Filter Devices (Amicon)

2. Microcentrifuge (capable of 10,000-15,000 x g)

PROCEDURE:

Note: The capacity of the Microcon-YM100 reservoir is approximately 500ul. If the purified extract has a

larger volume it may require adding any remaining amotnt of sample that did not fit into the reservoir after

the first spin. This protocol may also be used to further concentrate previously purified samples.

1. Assemble the Microcon-YM1004nit by inserting the sample reservoir into the filtrate vial.

2. Add approximately 50uL of TE buffer to the upper Microcon-YM100 reservoir.

3. Add the entire extracted DNA sample on top of the TE buffer. Seal with the attached cap.

4. Centrifuge the assembled Microcon spin-column in a microcentrifuge for 12-15 minutes at 2300rpm
(~500x g). The DNA sample will be concentrated in about 5-15ul of TE buffer in the bottom of the
upper Microcon-100 reservoir (molecules with molecular weights of less than 100,000 Daltons will
pass through the filter).

5. Discard the effluent in the filtrate vial. Retain the tube for further wash steps.

6. Add approximately 300uL of TE buffer to the concentrated DNA solution in the Microcon reservoir.

7. Centrifuge the sample(s) at 2300rpm for 12-15 minutes. Discard the effluent and repeat the TE wash
(steps 5-7) at least one more time.
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8. After the last wash, 5-200uL of TE buffer may be added to the Microcon-100 column (depending on
desired final volume/concentration). Collect the DNA sample by inverting the reservoir into a new
microcon tube and centrifuge at approximately 3200rpm (approximately 1000 x g) for 3-5 minutes.

9. The concentrated purified DNA now resides in the tube. Cap the tube and store frozen. Alternatively,
transfer the purified DNA to a different tube, such as a sterile screw-cap tube for storage.

REFERENCES:
Microcon Centrifugal Filter Device User Guide, Revision ]. Millipore 2000
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Method: DNA Purification/Concentration Using Centricon YM-100 Centrifugal Filter
Devices

Date: 01/01/2007 Revision Date: 01/01/2007 Approved by: SAM

REAGENT:

TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH= 8.0)

Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.
Aliquot into 100mL bottles, autoclave and store at room temperature. The solution is'good for nine
months.

MATERIALS:

1. Ultracel-YM 100 Centrifugal Filter Devices (Amicon)

2. Table Top Centrifuge with Fixed Angled Rotor (Sorvall RT6000B or RT6000D)

PROCEDURE:

1. Assemble the Ultracel-YM 100 (Centricon) unit by inserting the sample reservoir into the filtrate vial.

2. Add approximately 1.5mL of TE buffer to'the upper Centricon reservoir.

3. Add the entire extracted DNA sample on top of the TE buffer. Cover the top of the sample reservoir
with the retentate vial.

4. Centrifuge the column in the Sorvall RT6000B (or RT6000D) at approximately 4300 rpm
(approximately 2000 x g) at room temperature for 7 minutes. The DNA sample will be concentrated
in about 40uL of TE buffer in the bottom of the upper Centricon reservoir (molecules with molecular
weights of less than 100,000 Daltons will pass through the filter).

5. Discard the effluent in the filtrate vial.

6. Add approximately 2mL of TE buffer to the concentrated DNA solution in the sample reservoir.
7. Repeat steps 7-8 two more times for a total of three washes.

8. After the last wash, collect the approximately 40uL of concentrated DNA sample by inverting the

sample reservoir into the provided retentate vial and centrifuge at approximately 1800 rpm
(approximately 500 x g) for two minutes.
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9. The concentrated purified DNA now resides in the retentate vial. Transfer the purified DNA to an

appropriate tube and store frozen.

REFERENCES:
Centricon Centrifugal Filter Device User Guide, Revision ]. Millipore 2005
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Method: DNA Purification/Concentration Using Vivacon 2 Centrifugal Filter Devices
Date: 01/01/2007 Revision Date: 01/01/2007 Approved by: SAM
REAGENT:

TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH= 8.0)

Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.
Aliquot into 100mL bottles, autoclave and store at room temperature. The solution is good for nine
months.

MATERIALS:

1. Forensic Grade Vivacon 2 Centrifugal Filter Devices (Sartorus Stedim P/N VNO2H41ETO)

2. Table Top Centrifuge with Fixed Angled Rotor (Sorvall RT6000B.or RT6000D)

PROCEDURE:

1. Assemble the Vivacon 2 unit by inserting the sample reservoir into the filtrate vial.

2. Add approximately 1.5mL of TE buffer to-the upper Vivacon reservoir.

3. Add the entire extracted DNA sample on top of the TE buffer. Cover the top of the sample reservoir
with the retentate vial.

4. Centrifuge the column in/the Sorvall RT6000B (or RT6000D) at approximately 4300 rpm
(approximately 2000 x g).at room temperature for 7 minutes. The sample may need to be spun for a
longer duration (up'to 30minutes) to achieve the desire volume. The DNA sample will be concentrated
in about 40uL of TE buffer in the bottom of the upper Vivacon reservoir (molecules with molecular
weights of less than 100,000 Daltons will pass through the filter).

5. Discard the effluent in the filtrate vial.
6. Add approximately 2mL of TE buffer to the concentrated DNA solution in the sample reservoir.

7. Repeat steps 7-8 two more times for a total of three washes. Nanopure water may also be used in the
wash steps if desired.

8. After the last wash, collect the approximately 40uL of concentrated DNA sample by inverting the
sample reservoir into the provided retentate vial and centrifuge at approximately 1800 rpm
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(approximately 500 x g) for two minutes.

9. The concentrated purified DNA now resides in the retentate vial. Transfer the purified DNA to an

appropriate tube and store frozen.

REFERENCES:
Technical data and Operating Instructions for the Vivacon 2 PCR Grade
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Method: BioRobot® EZ1 DNA purification of Evidence Samples
Date: 01/01/2007 Revision Date: 12/28/2012 Approved by: SAM
REAGENTS:

BioRobot® EZ1 DNA Investigator reagent cartridges. The cartridges contain all reagents required for the
DNA extraction and purification of samples on the BioRobot® EZ1. The reagents in the cartridges
includes guanidine thiocyanate/guanidine hydrochloride, the paramagnetic silica coated beads, ethanol, TE
buffer, and sterile water.

MATERIALS/EQUIPMENT:

1. EZ1 DNA Investigator kit (QIAGEN Catalogue #952034)
2. BioRobot® EZ1 or BioRobot® EZ1 Advanced XL
PROCEDURE:

1. Remove the substrate (if applicable), and transfer the liquid digest to the EZ1 sample tubes provided in
the EZ1 DNA Investigator kit (alternatively, the' 2.0ml collection tube can be used in the instrument).

If the 2.0mL collection tubes are used, centrifuge-the tubes at maximum speed to collect the lysate.

Optional: The addition of RNA may improve the DNA yields of samples that contain low amounts of
DNA. Analysts may add lug of RNA to the sample lysates prior to EZ1 purification of the samples.

a) Add 310uL of TE'buffer to'the supplied tube of carrier RNA (310ug) to obtain a solution of
lug/uL.

b) Dissolve the carrier RNA thoroughly. Add 1uL of the carrier RNA to your sample lysates.
Continue following the protocol at step 2.

Note: The dissolved carrier RNA should be stored at -20°C when not being used.
The following steps deal with the set-up and operation of the BioRobot® EZ1.

2. Insert the DNA Investigator v1.2 (EZ1) or EZ1 DNA Investigator Advanced XL v1.1 (EZ1 Advanced
XL) protocol card into the card slot on the BioRobot® EZ1 and turn the instrument on.

3. Press “START” to display the protocols menu, then select the desired protocol. The Large Volume
protocol should be selected if evidence samples are being extracted.
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4. Select the desired eluent (TE or water).

5. Select the desired elution volume based on the expected yield; 40, 50, 100, and 200uL are options.
Note that the elution volume will be the same for all samples on the same BioRobot® EZ1.

6. Press any key to proceed through the text displayed in the LCD. The text in the LCD prompts the
loading of the BioRobot® EZ1.

The following steps deal with the loading of samples and reagents into the BioRobot® EZ1.

7. Invert the reagent cartridges (1-6 per extraction run per instrument on the EZ1 or’1-14 per extraction
run on the EZ1 Advanced XL) to mix, and then tap the cartridges to deposit the reagents to the
bottom of their wells. Insert the appropriate number of reagent cartridges in‘the cartridge rack.
Additional samples can be accommodated in additional instruments or in subsequent instrument runs.

8. Load the cartridge rack (with cartridges) into the BioRobot® EZ1." Ensure that the reagent cartridges
are seated properly.

9. Load 1-6 (or 1-14) tip holders containing the filter<tips into row 2 of the tip rack.

10. Load 1-6 (or 1-14) opened sample or 2.0mL eollection tubes (from Step 3.) into row 4 of the tip rack.

11. Load 1-6 (or 1-14) uncapped appropriately labeled elution tubes into row 1 of the tip rack. Check to
ensure that the elution tubes are in the order corresponding to the sample tube order so that no sample
mix-ups occur. Close the workstation door.

12. Press “START” to start the'extraction protocol.

13. When the protocol ends,the LCD-displays “FINISHED”. If you intend to run another extraction
protocol, press “ESC” to return-to the “Protocols” menu. Otherwise, press “STOP” twice to return
the motors to the home positions.

14. Open the workstation door. Remove and cap the elution tubes containing your purified DNA.

The BioRobot® EZ1 can be cleaned by rinsing the tube rack, tip rack, and cartridge rack, briefly, in a

solution of 5% Bleach. The UV cross linker may be used to decontaminate the BioRobot® EZ1

components..The EZ1 Advanced XL has a built in UV cross linker that can be used to decontaminate the

instrument for between 20 and 60 minutes. The BioRobot® EZ1 components may also be cleaned using a

diluted neutral soap followed by water.

Unless another extraction protocol is being performed the BioRobot® EZ1 may be switched “OFF”.

REFERENCES:
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1. BioRobot® EZ1 Genomic DNA Kit Handbook. Qiagen February 2003

2. Magtration@ System 6GC Operation Manual Version 1.1. Precision System Science Co. 2002.

3. Montpetit SA, Fitch IT, O’Donnell PT. A simple automated instrument for DNA extraction in
forensic casework, ] Forensic Sci. 2005 May;50(3):555-63.

4. Kishor R, et al. Optimization of DNA extraction from low yield and degraded samples using the
BioRobot EZ1 and BioRobot M48. ] Forensic Sci. 2006 Vol. 51(5): 1055.
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Method: DNA Extraction from Reference Samples Hsing the BioRobot® EZ1
Date: 06/02/2003 Revised: 10/28/2011 Approved by:  SAM
REAGENTS:

1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NacCl, 2% SDS)

Mix together ImL of Tris-HCL, pH = 7.5, 2mL of 0.5M EDTA, 1mL of 5M NaCl, 10mL of 20% SDS
(w/v) and 86mL of nanopure water. Autoclave and store at room temperature. The solution is good
for one year.

2. 10mg/mL PROTEINASE K

Dissolve 100mg of proteinase K in 10mL of autoclaved nanopure water.  Store at -20°C in 200uL
aliquots. The aliquots are good for one year.

3. BioRobot EZ1 DNA Investigator reagent cartridges.

The cartridges contain all reagents required for the DNA extraction and purification of samples on the
BioRobot EZ1. The reagent in the cartridges included guanidine thiocyanate/guanidine hydrochloride,
the paramagnetic silica coated beads, ethanol, TE buffer, and sterile water.

MATERIALS/EQUIPMENT:

1. EZ1 DNA Investigator kit (QIAGEN Catalogue #952034)
2. BioRobot® EZ1 or BioRobot® EZ1 Advanced XL

PROCEDURE:
1. Toasterile 1.5mL tubeor to a 2.0ml collection tube add 190uL of digest buffer, 10uL of 10mg/mL
proteinase K'and the appropriate amount of the reference sample (bloodstain/liquid blood/reference

mouth'swab).

2. Mix gently and incubate at 56°C for at least 30 minutes. During the incubation, the robot may be set-
up for extraction.

3. Remove the substrate (if applicable), and transfer the liquid digest to the EZ1 sample tubes provided in
the EZ1 DNA Extraction kit. If the 2.0mL collection tubes were used, centrifuge them at maximum

speed for 5min to collect the lysate.

The following steps deal with the set-up and operation of the BioRobot® EZ1.

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 67 of 190

J




Unit Technical Manual

Forensic Biology

Insert the DNA Investigator v1.2 (EZ1) or EZ1 DNA Investigator Advanced XL v1.1 (EZ1 Advanced
XL) protocol card into the card slot on the BioRobot® EZ1 and turn the instrument on.

Press “START” to display the protocols menu then select the “Trace”, “Trace TD”, “Norm”, or “Norm
TD” protocol. The Normalization protocols will limit the DNA yield of the samples by employing a
limited amount of paramagnetic beads in the extraction. In the TD protocols the protocol uses a Tip-
Dance technique that can accommodate the purification of a sample with up to a maximum of 4 swab
in the tube. If this option is selected the substrate, if it is less than or equal to ¥4 swab, need not be
removed prior to purification on the EZ1.

Select the desired eluent (TE or water).

Select the desired elution volume; 200uL is recommended for most reference sample extractions
(additional elution volumes available are 40, 50, and 100 uL).

Press any key to proceed through the text displayed in the LCD. The text in the LCD prompts the
loading of the BioRobot® EZ1.

The following steps deal with the loading of samples and reagents into the BioRobot® EZ1.

9.

10.

11.

12.

13.

14.

15.

Invert the reagent cartridges (1-6 per extraction run per instrument on the EZ1 or 1-14 per extraction
run on the EZ1 Advanced XL) for your extraction tomix, then tap the cartridges to deposit the
reagents to the bottom of their wells. Insert the appropriate number of reagent cartridges in the
cartridge rack. Additional samples can'be’accommodated in additional instruments or in subsequent

instrument runs.

Load the cartridge rack (with cartridges) into the BioRobot® EZ1. Ensure that the reagent cartridges
are seated properly in the'cartridge rack.

Load 1-6 (or 1-14)tip holders containing the filter-tips into row 2 of the tip rack.

Load 1-6 (or1-14) opened sample or collection tubes (from Step 3.) into row 4 of the tip rack.
Load, 1-6 (or 1-14) uncapped appropriately labeled elution tubes into row 1 of the tube rack. Check
to ensure that the elution tubes are in the order corresponding to the sample tube order so that no
sample mix-ups occur. Close the workstation door.

Press “START? to start the extraction protocol.

When the protocol ends, the LCD displays “FINISHED”. If you intend to run another extraction

protocol, press “ESC” to return to the “Protocols” menu. Otherwise, press “STOP” twice to return
the motors to the home positions.
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16. Open the workstation door. Remove and cap the elution tubes containing your purified DNA.

The BioRobot® EZ1 can be cleaned by rinsing the tube rack, tip rack, and cartridge rack, briefly, in a
solution of 5% Bleach. The UV cross linker may be used to decontaminate the BioRobot® EZ1
components. The EZ1 Advanced XL has a built in UV cross linker that can be used to decontaminate the
instrument for between 20 and 60 minutes. The BioRobot® EZ1 components may also be cleaned using a
diluted neutral soap followed by water.

Unless another extraction protocol is being performed the BioRobot® EZ1 may be switched “OFF”.

REFERENCES:

1. BioRobot® EZ1 Genomic DNA Kit Handbook. Qiagen February 2003

2. Magtration@ System 6GC Operation Manual Version 1.1. Precision System Science Co. 2002.

3. Montpetit SA, Fitch IT, O’Donnell PT. A simple automated instrument for DNA extraction in forensic
casework, ] Forensic Sci. 2005 May;50(3):555-63.
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Method: NIST Quantitation Setup Using the Qiagen BioRobot® Universal
Date: 06/18/2012 Approved by: SAM
REAGENTS:

1. TE Buffer(10mM Tris-HCI, 0.1mM EDTA, pH 8.0):

Mix together 10mL of 1M Tris-HCI, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure
water. Aliquot into bottles, autoclave and store at room temperature. This solution is good for nine
months.

2. Quantifiler Human (or Duo) DNA Quantification Kit: Applied Biosystems (P/N 4343895 or 4387746
(Duo))

A. Quantifiler Human (or Duo) Primer Mix
B. Quantifiler (or Duo) PCR Reaction Mix

C. Quantifiler Human DNA Standard

The Reaction Mix should be removed from the kit uponreceipt and stored at 2 to 8°C. The remaining
components of the kit should be stored at -15 to -25°C. The primer sets contain a light sensitive dye, and
should be stored protected from light. The expiration date is printed on the kit.

MATERIALS:

1. 96- Well Optical Reaction Plates Applied Biosystems (P/N N801-0560)
2. Optical Adhesive Covers Applied Biosystems (P/N 4311971)
3. MicroAmp Splash free Support Base Applied Biosystems (P/N 4312063)

EQUIPMENT:

1. Qiagen Universal BioRobot Universal Liquid Handler Qiagen Corporation
2. ABI Prism 7000/7500 Sequence Detection System Applied Biosystems

PROCEDURE:

1. This protocol is to setup the 96-well optical plate for gPCR DNA quantitation using Quantifiler™
(Human or Duo) quantitation kits and the NIST Quantitation Standard Curve.
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Important notes to remember for using the BioRobot Universal for setup:

a. Itis recommended that the system liquid carboy be well above the minimum level prior top
commencing a run.

b. Itis recommended that the system be re-initialized and at least one 100mL flush (available from
the Tools drop-down menu) be performed prior to commencing a run.

c. Sarstedt screw-cap tubes are required for use on the instrument as they fit securely in the cooling
blocks. Caps should be removed after tubes are placed in the cooling blocks and replaced prior
to removing tubes from the cooling block.

2. Thaw the appropriate Quantifiler Primer Mix and concentrated DNA standard (which is stered at -
20°C). Vortex the Primer Mix and the refrigerated qPCR Reaction Mix for 5 seconds. Spin the Primer
Mix and DNA standard tubes briefly in a microcentrifuge to remove any liquid from the caps.

3. Preparea 1/10 and a 1/50 dilution of the human DNA standard in TE buffer. These dilutions will serve
as calibrators for the quantitation assay.

4. Determine the total number of samples to be amplified including the calibrators and one qPCR blank.

Create a master mix by Combining the following volumes of reagents into a screw-cap tube:

a. 10.5ul of Primer Mix X # of Samples
b. 12.5ul of qPCR Reaction Mix x # of Samples

Note: Additional master mix (~5-10%) should be created to allow for pipeting error.

5.  Open the Quant Sheet in the most current version of the SDPD SIMS (found on the FB network
H:\Worksheets).

a. The default spreadsheet shows the locations for the DNA calibrators and blank.

b. Fill out the “Sample Name” column with a list of the sample names. Acceptable volumes for
quantitation ate 2 or 8uL (do not change the volume of the standards). For Y-screen analysis, the
volume for the samples should be 8uL (do not change the volume of the standards).

c.CThe Setup Spreadsheet should be saved as a *.csv file type. This is accomplished by using the
“Saveas...” command from the File menu. The .csv file must be saved in the ImportData
folder on the Qiagenuniversal hard drive. (Note: *.csv file names should begin with the
analysts’ initials followed by case # (e.g. initials(XX-XXXXXX).csv).

d. When finished, the QPCR worksheet should be printed for your case notes.

e. Exit the SDPD SIMS.

6. Open QiaSoft™ v.5 software (on the desktop). Log in as “sdpd” and leave the password blank.
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a. Under “applications” select “Forensic” in the drop-down menu (') and then select “SDPD
Quantifiler NIST Setup v1.2”.

Click “Run” button (). Follow the prompts from the protocol for preliminary setup.
Enter the number of samples (excluding DNA Standards).

Enter the appropriate .csv file name.

Check the .csv table to ensure correct setup sheet was selected.

me an T

The System Liquid bottle should be filled above the minimum. The protocol will not continue
if liquid level is below minimum.

The load check is optional.

Enter whether the robot will be creating the DNA standard dilution (Yes/No).

Empty tip waste (if necessary).

o

[

i

Refill the tip racks (if necessary). If tips run out the instrument williprompt you to refill later.
Place the 96-well optical plate on a splash-free support base in the appropriate location on the
deck making sure to tape the sides of the plate to the base.
. Place your DNA samples in the appropriate order (according to the setup sheet filled in
earlier). You may use your printed copy to ensure the sample positions are correct.
Note: The samples are to be placed in the cooling blocks in a left to right.direction, filling each column
completely before the next. No tube or an empty tube‘should be placed in the position for the qPCR blank.
m. Place the Quantifiler Master Mix and TE Buffer (if the instrument is preparing the DNA
Standard serial dilution) in the appropriate places on the deck. Note: if more than 48 samples
are being quantified then the master mix will need to be split into two tubes (follow the
prompts from the instrument).

7.  The BioRobot Universal will now add master mix to the 96-well optical plate, and then add 2 (or 8)uL
of the samples to the master mix.

8. When the protocol has finished, the tubes can be re-capped and removed, and the 96-well optical plate

can be covered with'an optical adhesive cover and carried to the amplification room for loading into
the ABI 7500 SDS.

9.  The qPCR analysis can be continued by following the “Quantitative PCR DNA with the Quantifiler™
Human DNA Quantification Kit” or “Quantitative PCR with the Quantifiler” Duo DNA
Quantification Kit” protocol at step 9.

References:
1. BioRobot 8000 Users manual. Qiagen Corporation.
2. QiaSoft 5 Software System Users Guide. Qiagen Corporation.
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Method: qPCR with the Quantifiler'" Human DNA Quantification Kit using the
NIST SRM Human DNA Quantitation Standard

Date: 05/01/2012 Approved by: SAM

REAGENTS:

1. TE Buffer (10mM Tris-HCI, 0.1 mM EDTA, pH 8.0)

Mix together 10mL of 1M Tris-HCI, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure
water. Aliquot into bottles, autoclave and store at room temperature. This solution is good for one
year.

2. Quantifiler Human DNA Quantification Kit: Applied Biosystems (P/N 4343895)

A. Quantifiler Human Primer Mix
B. Quantifiler PCR Reaction Mix
C. Quantifiler Human DNA Standard

The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8°C. The remaining
components of the kit should be stored at -15 to -25°C. The primer sets contain a light sensitive dye, and
should be stored protected from light. The expiration date‘is printed on the kit.

MATERIALS:

1. 96- Well Optical Reaction Plates Applied Biosystems (P/N N801-0560)

2. Optical Adhesive Covers Applied Biosystems (P/N 4311971)

3. MicroAmp Splash free Support Base Applied Biosystems (P/N 4312063)

EQUIPMENT:

ABI Prism 7500 Sequence Detection System Applied Biosystems

PROCEDURE:

1. Thaw the Quantifiler Primer Mix and concentrated DNA standard (stored at -20C). Vortex the

Quantifiler Primer Mix and the refrigerated Quantifiler PCR Reaction Mix for 5 seconds. Spin the
Primer Mix and DNA standard tubes briefly in a microcentrifuge to remove any liquid from the caps.
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14.

Forensic Biology

Prepare a 1/10 and a 1/50 dilution of the human DNA standard in TE buffer. These dilutions will serve
as calibrators for the quantitation assay.

Determine the total number of samples to be amplified including the set of DNA calibrators and one
gPCR blank. Create a master mix by combining the foilowing volumes of reagents into a 1 .5ml

microcentrifuge tube:

10.5ul of Quantifiler Primer Mix X # of Samples
12.5ul of Quantifiler PCR Reaction Mix X # of Samples

Note: Additional master mix (~10% suggested) should be created to allow for pipetting error.

Vortex the master mix at medium speed for 5 seconds and spin the tube briefly in.a microcentrifuge to
remove any liquid from the cap.

With the 96-well optical reaction plate in a support base dispense 23uL of the master mix into each
sample well.

Add 2uL or 8uL of sample, and 2uL calibrators, and‘the appropriate volume of controls (2 or 8uL) to
the appropriate wells.

Carefully seal the reaction plate with the optical adhesive cover. Use the applicator to ensure the cover
forms a smooth airtight seal over the entire 96-well surface.

Transport the reaction plate to the ABI 7500 SDS in the amplification area.
Turn on the computer (if nécessary).and then the SDS instrument.
Push the plate door in.andslide it out until it provides room to insert the plate.

Position the plate in"the thermal block so that well Al is in the upper left corner and the notched corner
is in the upper right corner.

Gently close the door to by sliding it backward into position.

Launch the 7500 SDS Software and set up a plate document (File> New) either by using a blank
document-or opening a plate document template. The plate document shows the location of
samples/standards on the reaction plate. If a sample import file (.txt) has been created it can be
imported by selecting File>Import Sample Setup and browsing for the appropriate file. If the
sample setup was imported then skip to step 18.

If required, add detectors to the plate document. If the detectors for the Quantifiler kit have been
created, they will be listed in the Detector Manager: Tools>Detector Manager. Highlight the
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Quantifiler Human and IPC detectors in order to make them available to the plate. Click "Add to Plate
Document".

Highlight the entire plate document, then from the Well Inspector (View>Well Inspector) add the
detectors (Quantifiler Human and IPC) to all the wells of the plate document.

Add sample information for each well by double clicking on it (or highlight and View>Well
Inspector). The Well Inspector box will appear. Add the sample name. If clicking on a well where a
quantitation standard is located two changes need to be made to the Quantifiler Human detector.
Change task from "unknown" to "standard" and add the concentration of the standard to the
"Quantity" column.

When finished filling out the plate document save it as a SDS document (*.sds).
Select the Instrument tab and review the Quantifiler amplification profile which should consist of:

Initial incubation at 95°C for 10 minutes.
40 cycles of the following profile:

95°C for 15 seconds

60°C for 1 minute

If need be, delete the initial 50°C incubation stepiand change the reaction volume to 25uL. If any
changes were made save the file and click "Start" orsimply click on “Start”.

Following completion of the run the plate document can be analyzed. Verify the analysis settings
(Analysis>Analysis Settings) which should be:

Detector: All
Threshold: .200000
Baseline Start (cycle): 6
Baseline End (cycle): 15

Once you have verified the settings are correct, analyze your data. Analysis>Analyze

21. Save your file,

22. Exportthe Ct values of your samples by selecting File>Export>Ct. The 7500 software can be
closed at this point and the instrument can be turned off..

23. Import the Ct values into the SDPD Worksheet Maker’s “Quant Data” worksheet. The data is
automatically compared against the NIST standard curve in the workbook and the results are available
in the “Quant Results” worksheet of the workbook. The “Quant Results” worksheet should be
printed (File>Print or use the print icon) and included in the analytical record.
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Assessment of DNA calibrators:
The concentration of the Human DNA standard received with each lot of kit will be determined during the

QC process. The values obtained during this QC will determine the expected values for the calibrators.
Values obtained that are significantly outside the expected quantitation values of calibrators may indicate a
problem with the qPCR run. If problems are indicated the quantitation assay should be interpreted with
caution and a second assay may be required.

Assessment of sample quality:

If a sample has a high human Ct value and a normal IPC Ct value (generally less than 28) the sample has a
low amount of DNA.

If a sample has a low human Ct value and a normal or slightly high IPC Ct value (slightly greater than 28)

the sample has a high amount of DNA. If the sample has a high amount of human DNA it will often out
compete the IPC for amplification components thus decreasing its amplification efficiency.

If a sample has a high human Ct value and a high IPC Ct value (>>28) the sample is likely inhibited.
Appropriate troubleshooting measures should be employed with the sample to overcome the potential

inhibitors.

REFERENCE:
Quantifiler™ Human DNA Quantification Kit User's Manual
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Method: qPCR with the Quantifiler” Duo DNA Quantification Kit using the NIST
SRM Human DNA Quantitation Standard

Date: 05/01/2012 Approved by: SAM

REAGENTS:

1. TE Buffer (10mM Tris-HCI, 0.1 mM EDTA, pH 8.0)

Mix together 10mL of 1M Tris-HCI, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure
water. Aliquot into 100mL or 250mL bottles, autoclave and store at room temperature.’ This solution
is good for twelve months.

2. Quantifiler Duo DNA Quantification Kit: Applied Biosystems (P/N 4387746)

A. Quantifiler Duo Primer Mix
B. Quantifiler Duo PCR Reaction Mix
C. Quantifiler Duo DNA Standard

The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8°C. The remaining
components of the kit should be stored at -15 to -25°C. The primer sets contain a light sensitive dye, and
should be stored protected from light. The expiration date is printed on the kit.

MATERIALS:

1. 96- Well Optical Reaction Plates Applied Biosystems (P/N N801-0560)

2. Optical Adhesive Covers Applied Biosystems (P/N 4311971)

3. MicroAmp Splash free Support Base Applied Biosystems (P/N 4312063)

EQUIPMENT:

ABI Prism, 7500 Sequence Detection System Applied Biosystems

PROCEDURE:

1. Thaw the Quantifiler Duo Primer Mix and concentrated DNA standard (stored at -20C). Vortex the
Quantifiler Duo Primer Mix and the refrigerated Quantifiler Duo PCR Reaction Mix for 5 seconds.
Spin the Primer Mix and DNA standard tubes briefly in a microcentrifuge to remove any liquid from
the caps.
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Prepare a 1/10 and a 1/50 dilution of the human DNA standard in TE buffer. These dilutions will serve
as calibrators for the quantitation assay.

Determine the total number of samples to be amplified including the set of eight human DNA standards
(run in duplicate) and one qPCR blank. Create a master mix by combining the following volumes of
reagents into a 1.5ml microcentrifuge tube:

10.5ul of Quantifiler Duo Primer Mix b'e # of Samples
12.5ul of Quantifiler Duo PCR Reaction Mix X # of Samples

Note: Additional master mix (~10% suggested) should be created to allow for pipetting error.

Vortex the master mix at medium speed for 5 seconds and spin the tube briefly in.a microcentrifuge to
remove any liquid from the cap.

With the 96-well optical reaction plate in a support base dispense 23uL of the master mix into each
sample well.

Add 2uL or 8uL of sample, and 2uL calibrators, and‘the appropriate volume of controls (2 or 8uL) to
the appropriate wells. Note: For quantitation for Y-Screen'DNA analysis, add 8uL of sample to the
appropriate wells.

Carefully seal the reaction plate with the optical adhesive cover. Use the applicator to ensure the cover
forms a smooth airtight seal over the entire.96-well surface.

Transport the reaction plate to the amplification area.
Turn on the computer (if necessary) and then the 7500 SDS instrument.
Press the tray door on the SDS instrument to open it.

Position the reaction plate in the plate holder so that well Al is in the upper left corner and the notched
corner is in the upper right corner and close the tray door.

Launch the 7500 SDS Software and set up a plate document (File> New) either by using a blank
document or opening a plate document template. The plate document shows the location of
samples/standards on the reaction plate. If a sample import file (.txt) has been created it can be
imported by selecting File>Import Sample Setup and browsing for the appropriate file. If the
sample setup was imported then skip to step 18.

If required, add detectors to the plate document. If the detectors for the Quantifiler kit have been
created, they will be listed in the Detector Manager: Tools>Detector Manager. Highlight the Dual
Quant Human, Dual Quant Y and Dual Quant IPC detectors in order to make them available to the
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plate. Click "Add to Plate Document".

Highlight the entire plate document, then from the Well Inspector (View>Well Inspector) add the
detectors (Human, Y and IPC) to all the wells of the plate document.

Add sample information for each well by double clicking on it (or highlight and View>Well
Inspector). The Well Inspector box will appear. Add the sample name. If clicking on a well where a
quantitation standard is located, two changes need to be made to the Dual Quant Human and Dual
Quant Y detectors. Change task from "unknown" to "standard" and add the concentration of the
standard to the "Quantity" column.

Select the Instrument tab and review the Quantifiler Duo amplification profile which should consist of:

Incubation at 50°C for 2 minutes

Incubation at 95°C for 10 minutes

40 cycles of the following profile:
95°C for 15 seconds
60°C for 1 minute

Change the sample volume to 25ul and ensure that the 9600 emulation box is checked.

When finished filling out the plate document save it as a SDS document (*.sds) and click “Start” to start
the run.

Following completion of the run the plate document can be analyzed. Verify the analysis settings
(Analysis>Analysis Settings) which should be:

Detector: All
Threshold: .200000
Baseline Start (cycle): 3
Baseline End (cycle): 15

Once you have verified the settings are correct, analyze your data. Analysis>Analyze.

Save your file.

Export the Ct values of your samples by selecting File>Export>Ct. The 7500 software can be closed
at this point and the instrument can be turned off.

Import the Ct values into the SDPD Worksheet Maker’s “Quant Data” worksheet. The data is
automatically compared against the NIST standard curve in the workbook and the results are available
in the “Quant Results” worksheet of the workbook. The “Quant Results” worksheet should be
printed (File>Print or use the print icon) and included in the analytical record.
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Assessment of DNA calibrators:
The concentration of the Human DNA standard received with each lot of kit will be determined during the

QC process. The values obtained during this QC will determine the expected values for the calibrators.
Values obtained that are significantly outside the expected quantitation values of calibrators may indicate a
problem with the qPCR run. If problems are indicated the quantitation assay should be interpreted with
caution and a second assay may be required.

Assessment of sample quality:

If a sample has a high human Ct value and a normal IPC Ct value (generally less than 30.75) the sample has a
low amount of DNA.

If a sample has a low human Ct value and a normal or slightlv high IPC Ct value ( slightlv higher than 30.75)
the sample has a high amount of DNA. If the sample has a high amount of human DNA it will often out
compete the IPC for amplification components thus decreasing its amplification efficiency.

If a sample has a high human Ct value and a high IPC Ct value (>>30.75) the sample is likely inhibited.
Appropriate troubleshooting measures should be employed with the/sample to overcome the potential
inhibitors.

The relative amount of male and female DNA in a mixture can be determined by dividing the total human
DNA quantitation by the male DNA quantitation and subtracting one. As an example, if the total DNA

quantitation is four times the male DNA quantitation, there is approximately three times as much female
DNA as male DNA.

Assessment of samples quantified for Y-Screen‘analysis:
Based on the results of the Y-screen validation, the following general guidelines should be taken into

account for submission of screened samples for DNA testing. Although higher amounts are more likely to
provide complete and robust results,in general, samples having as low as 0.06ng of total male DNA may
provide some informative results using Identfiler Plus and samples having as low as 0.03ng of total male
DNA may provide some informative results using Yfiler. If 4 swab was tested for Y-screen analysis, the

following are recommended (assuming ng/4ul, not ng/ul):

Quant Submission recommendations

0.005ng/4uL 1% swabs should provide informative Yfiler results

0.013ng/4ul % swab for Yfiler (minimum) and/or 1% swab for Identifiler Plus
0.033ng/4ul ¥4 swab for Identifiler Plus (minimum) and/or remaining Y-

screen extract may provide Yfiler information

Note that other factors, such as the likelihood of multiple semen donors and the ratio of male to female

DNA in the sample, may require the submission of a greater amount of sample for DNA testing.
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REFERENCE:
Quantifiler® Duo DNA Quantification Kit User's Manual
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Method: Quantifiler™ Setup Using the Hamilton Microlab® Nimbus 4
Date: 04/17/2013 Approved by: SAM
REAGENTS:

1. TE Buffer (10mM Tris-HCI, 0.1mM EDTA, pH 8.0):

Mix together 10mL of 1M Tris-HCI, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mE nanopure
water. Aliquot into bottles, autoclave and store at room temperature. This solution is good for nine

months.

2. Quantifiler Human (or Duo) DNA Quantification Kit: Applied Biosystems (P/N 4343895 or 4387746
(Duo))
A. Quantifiler Human (or Duo) Primer Mix
B. Quantifiler Human (or Duo) PCR Reaction Mix
C. Quantifiler Human DNA Standard.

The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8°C. The remaining
components of the kit should be stored at -15 to -25°C.. The primer sets contain a light sensitive dye, and
should be stored protected from light. The expiration date is printed on the kit.

MATERIALS:

1. 96-Well Optical Reaction Plates: Applied Biosystems (P/N 4306737)
2. Optical Adhesive Covers: Applied Biosystems (P/N 4311971)

EQUIPMENT:

1. Hamilton Microlab Nimbus 4 Liquid Handling Workstation: Hamilton Robotics
2. ABI Prism 7500 Sequence Detection System: Applied Biosystems

PROCEDURE:

1. This protocol is to setup the 96-well optical plate for qPCR DNA quantitation using Quantifiler™
(Human or Duo) quantitation kits and the NIST Quantitation Standard Curve.

Important notes to remember when using the Microlab Nimbus for setup:
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a. The pre-run maintenance should be performed prior to the first run of the day (refer to
maintenance protocol in the FB Unit Policy Manual).

b. It is highly recommended that all tip racks are full prior to the start of a run. At minimum,
complete columns of tips must be present sufficient to perform the run.

c. Sarstedt 1.5mL screw-cap tubes are required for use on the instrument for all samples and
controls. 2.0mL screw-cap tubes are required for master mix. Caps should be removed
after tubes are placed in the racks and replaced prior to removing tubes from the racks.

2. Thaw the appropriate Quantifiler Primer Mix and concentrated DNA standard (which is stored at -
20°C). Vortex the Primer Mix and refrigerated qPCR Reaction Mix for 5 seconds. Spin the Primer
Mix and DNA standard tubes briefly in a microcentrifuge to remove any liquid from the caps.

3. Preparea 1/10 and a 1/50 dilution of the human DNA standard in TE buffer, These dilutions will

serve as calibrators for the quantitation assay.

4. Determine the total number of samples to be amplified including the calibrators and one qPCR blank.
Create a master mix by combining the following volumes of reagents in a 2.0mL screw-cap tube.

a. 10.5uL of Primer Mix X # of Samples
b. 12.5uL of qPCR Reaction Mix »x # of Samples

Note: The above is the minimum volume required per sample. The Nimbus requires additional master
mix to perform the setup. The volumes calculated in the current version of the SDPD SIMS should be
prepared.

Note: If the total number of samples is greater than 72, then two tubes of master mix are required. The
first 2.0mL screw-cap tube should contain 1205uL of master mix and the second tube should contain the

remaining volume.

5. Open the Quant Sheet in the most current version of the SDPD SIMS (found on the FB network
H:\Worksheets).

a. The default spreadsheet shows the locations for the DNA calibrators and blank.

b. Fill out the “Sample Name” column with a list of the sample names. If appropriate, edit the
volume for the samples from 2 or 8uL (do not change the volume of the standards).

c. Save the SDPD SIMS workbook to a location accessible on the FB network (the Nimbus
cannot read from a password protected Excel file).

d.  When finished, the qPCR worksheet should be printed for the case notes.

e. Exit the SDPD SIMS.

6. Empty the tip waste (if necessary).
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7. Refill the tip racks on the Nimbus.
8. Place the 96-well optical plate in the appropriate location on the deck.

9. Place the DNA samples in the appropriate order (according to the setup sheet filled in earlier). You
may use your printed copy to ensure the sample positions are correct.

Note: The samples are to be placed in the racks in a left to right direction, filling each column completely

before the next.

10. Place the Quantifiler Master Mix in the appropriate place on the deck.

Note: If more than 72 samples are being quantified then the master mix will need to be split into two tubes

(see step 4 above).

11. Remove the caps from the samples and master mix.
12. Close the instrument door (the door must remain closed during operation).
13. Open the Hamilton Run Control software (on the desktop).

a. Open the current version of the SDPD qPCR and PCR Setup method within the
software.

b. Click the “Run” button:(#).

c. In the user prompt, navigate to the worklist input file (from step 5 above), select “qQPCR
Setup”, and/click “Continue”.

d. Verify that sufficient 300uL and 50uL tips are loaded onto the deck and click “Continue”.

e. Enter the first and last position of the 300uL tips (1=A1, 2=A2, ..., 96=H12) and click
“OK”.

f. Enter the first and last position of the 50uL tips (1=A1,, 2=A2,, ..., 96=H12, 97=Al1,,
98=A2,, ..., 192=H12,) and click “OK”.

14. The Nimbus will now add master mix to the 96-well optical plate, and then add 2 (or 8)uL of the
samples to the master mix.

15. Click “OK” to acknowledge completion of the run.

16. When the protocol has finished, the tubes can be re-capped and removed, and the 96-well optical plate
can be covered with an optical adhesive cover and carried to the amplification room for loading into the
ABI 7500 SDS.
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17. The qPCR analysis can be continued by following the “Quantitative PCR DNA with the Quantifiler™
Human DNA Quantification Kit” or “Quantitative PCR with the Quantifiler Duo DNA Quantification

Kit” protocol at step 9.

REFERENCES:

Microlab® Nimbus Independent Channel Operator’s Manual. Hamilton Robotics.
Microlab® Nimbus Enclosed Version Operator’s Manual. Hamilton Robotics.
Microlab® Nimbus Independent Channel Programmer’s Manual. Hamilton Robotics.
Quantifiler™ Human DNA Quantification Kit User’s Manual. Applied Biosystems.
Quantifiler” Duo DNA Quantification Kit User’s Manual. Applied Biosystems.
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Method: Target Ranges for Single Source Samples Using NIST Standard based

Quantitation

Date: 05/01/2012 Approved by: SAM

The chart below represents the results obtained for the sensitivity study of the Identifiler Plus, Yfiler, and
Minfiler kits using data obtained with the NIST standard. The highlighted areas represent the range for
which results were obtained with peak heights between 100 and 3000rfu

This information is presented for analysts as a guide to determine the amplification targets for single source
samples. Sample type and the expectation of obtaining a mixture will affect the amount of DNA amplified

in casework samples.

Yfiler Results Minifiler Result

ID Plus Results

0.010 0.012 4 low level types 4 low level types 7 low level types

0.031 0.035 Stochastic level profile w/ drop-out Partial profile (11 loci) Complete low level profile (82-841rfu)

0.052 0.058 Full profile w/ stochastic level types Complete Jow levelprofile (140-417rfu) Complete profile (299-1870(H)rfu)

0.105 0.116 Full profile w/ stochastic level types Complete profile (250-630rfu) Complete profile (345-2079(H)rfu)

0.157 0.174 Full profile (546 lowest locus rfu) Complete profile (415-902rfu) Complete profile (470-4900(H)rfu)

0.209 0.232 Full profile (897 lowest locus rfu) Complete profile (580-1500rfu) Complete profile (1261-6900(H)rfu)

0.314 0.347 Full profile (700-3500rfu) Complete profile (1000-1800rfu) Complete profile (1500-7300(H)rfu) w/ minor artifacts
0.418 0.463 Full profile (700-4200xfu) Complete profile (2000-3600rfu) Complete profile (1700-7900(H)rfu) w/ artifacts
0.523 0.579 Full profile (800-3200rfu) Complete profile (2100-4600rfu) Complete profile (2400-8700rfu) w/ pull-up

0.785 0.869 Manageable artifacts (pull-up) Complete profile (2700-6000rfu) w/ pull-up Complete profile (2900-8800rfu) w/ pull-up

1.046 1.158 Numerous Artifacts Complete profile (2800-7000rfu) w/ pull-up Complete profile (300-8800rfu) w/ pull-up/pref amp
0.017 0.019 6 low level types 3 low level types 6 low level types

0.051 0.058 Stochastic level profile w/ drop-out Partial profile (13.5 loci) Complete low level profile (76-650rfu)

0.085 0.09% Full profile justabove stochastie level Complete low level profile (150-650rfu) Complete profile (210-1870(H)rfu)

0.169 0.192 Full profile w/ 1 stochastic level type Complete profile (330-1000rfu) Complete profile (430-2200(H)rfu)

0.254 0.288 Complete profile (640-1700rfu) Complete profile (500-4000(H)rfu)

0.338 0.384 Complete profile (580-1500rfu) Complete profile (470-4100(H)rfu)

0.507 0.576 Complete profile (1000-2700rfu) Complete profile (1100-8200(H)rfu) w/ minor artifacts
0.676 0.768 file (1100-3000 rfu) Complete profile (1500-3600rfu) Complete profile (1050-8600(H)rfu) w/ artifacts
0.845 0.960 Full profile (900-3200 rfu) Complete profile (1300-4600rfu) Complete profile (11500-8700rfu) w/ artifacts

1.268 1.440 Manageable artifacts (pull-up) Complete profile (2300-7700rfu) w/ pull-up Complete profile (3100-9100rfu) w/ pull-up/pref amp
1.690 1.920 Numerous Artifacts Complete profile (2900-8400rfu) w/ pull-up not amplified
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Method: Concentrating DNA Extracts with Microcon YM-100 Filters
Date: 04/01/2011 Approved by: SAM
REAGENTS:

TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH: 8.0)

Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.
Aliquot into 100mL bottles, autoclave and store at room temperature. The solution is good for nine
months.

MATERIALS:

1. Microcon-YM 100 Centrifugal Filter Devices (Amicon)

2. Microcentrifuge (capable of at 1,000 x g)

PROCEDURE:

Note: The capacity of the Microcon-YM100 reservoir is approximately 500uL. If the purified extract has a
larger volume it may require adding any remaining amount of sample that did not fit into the reservoir after
the first spin. This protocol may also be used-to further concentrate previously purified samples.

1. Assemble the Microcon-YM100 unit by inserting the sample reservoir into the filtrate vial.

2. Add approximately 50uL of TE buffer to the upper Microcon-YM100 reservoir.

3. Add the appropriate amount of extracted DNA sample to be concentrated on top of the TE buffer. Seal
with the attached cap.

4. Centrifuge the assembled Microcon spin-column in a microcentrifuge for 12-15 minutes at 2300rpm
(~500x g). The DNA sample will be concentrated in about 5-15uL of TE buffer in the bottom of the
upper Microcon-100 reservoir (molecules with molecular weights of less than 100,000 Daltons will
pass through the filter). Check the microcon assembly periodically during the spin to ensure that the
filter has not dried out.

Important: Spinning the filter to dryness can cause irreversible binding of the DNA to the membrane.

5. Discard the effluent in the filtrate vial. Place the Microcon spin-column right-side up into a new into
filtrate vial.
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8. Add 3-6ulL of TE buffer to the Microcon-100 column (depending on desired final volume). Gently
vortex the filter assembly.

9. Collect the DNA sample by inverting the reservoir into a new microcon tube and centrifuge at
approximately 3200 rpm (approximately 1000 x g) for 3-5 minutes.

10. The concentrated purified DNA now resides in the tube. The volume can be further adjusted as
necessary to achieve the desired concentration. Cap the tube and store frozen. Alternatively, transfer
the purified DNA to a different tube, such as a sterile screw-cap tube for storage.

REFERENCE:
Microcon Centrifugal Filter Device User Guide, Revision ]. Millipore 2000
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Method: DNA Concentration Hsing the DNA Speed-Vac
Date: 05/01/2012 Approved by: SAM
REAGENTS:

TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH= 8.0)

Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.
Aliquot into 100mL bottles, autoclave and store at room temperature. The solution is good for nine

months.

EQUIPMENT:

Savant DNA Speed Vac
NOTES:

Based on an internal study conducted on concentrating samples containing TE buffer, it is not
recommended to concentrate samples containing TE to less than a fourth (%4) their original volume.
Samples whose volume was reduced to less than "4 the original volume started exhibiting signs of inhibition
to the polymerase chain reaction using the Identifiler kit.  Total inhibition of PCR was observed when the
volume was reduced to less than 1/8 the original volume. It is presumed that the concentration of the
EDTA in the TE inhibits PCR by chelating the'magnesium in the reaction. Concentration of samples eluted
in water generally do not exhibit PCR inhibition‘at any level of volume reduction.

PROCEDURE:
1. Place the appropriately labeled 6pen sample extract tubes in the Savant DNA Speed-Vac.
2. Turn on the DNA Speed-Vac. Select one of the three heat level options (low, medium, and high).

Generally either medium or high are selected. The heat level will influence how quickly evaporation

occurs.

3. Close the lid firmly and the DNA Speed-Vac will commence concentrating the samples through a
combination of heat and the application of a vacuum to the inner chamber of the Speed-Vac.

4. After the appropriate amount of volume reduction has occurred, remove and cap your sample tubes.
Any samples whose volume was reduced more than desired can be brought up to the appropriate

volume using either TE buffer or nanopure water.

5. Turn of the DNA Speed-Vac.
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Method: Amplification with the AmpFISTR" Identifiler Plus® kit

Date: 10/19/2010 Approved By: SAM

If DNA extracts are to be stored long-term they must be stored frozen.

REAGENTS:

3. TE Buffer (10 mM Tris-HCI, 0.1 mM EDTA, pH 8.0)

Mix together 10 mL of 1 M Tris-HCI, pH = 8.0 with 0.2 mL of 0.5 M EDTA and 990 mL nanopure
water. Aliquot into 100 mL bottles, autoclave and store at room temperature.. This solution is good

for nine months.

4. AmpFlSTR® Identifiler Plus® PCR Amplification Kits: Applied BioSystems

A. AmpFlSTR® Identifiler Plus® Master Mix

B. AmpFlSTR® Identifiler Plus® Primer Set

C. AmpFISTR® Control DNA 9947A
Store all kit components at -15 to -25 °C upon receipt. Store all components at 2 to 8 °C after initial use.
The primers contain light-sensitive dyes, and should bestored protected from light. The expiration date is
printed on the kit.
MATERIALS:

3. MicroAmp Autoclaved Reaction Tubes with Caps - Applied Biosystems (P/N N801-0612)

4. MicroAmp 9700 Tray - Applied Biosystems (P/N N801-0541)

EQUIPMENT:
GeneAmp PCR System 9700 Thermal Cyclers - Applied Biosystems

PROCEDURE:
18. Fill out an AmpFlSTR® Identifiler Plus” Amplification Worksheet and determine the total number of
samples to be amplified including the positive control (9947A DNA), the negative amplification

control, and all samples.

19. Label a 0.2 mL MicroAmp Reaction Tube for each of the samples to be amplified.
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Vortex the AmpF]STR® Identifiler Plus® Master Mix, AmpFlSTR® Identifiler Plus® Primer Set, and
AmpFlSTR® Control DNA 9947A. Vortex the three tubes for 5 seconds and spin brieﬂy ina
microcentrifuge to remove any liquid from the caps.

Create a master mix by combining the foilowing volumes of reagents into a 1.5 mL rnicrocentrifuge
tube:

a. 10 uL AmpF]STR® Identifiler Plus” Master Mix ~ x (# samples) + 10 %
b. 5uL AmpFlSTR® Identifiler Plus® Primer Set X (# samples) + 10 %

Vortex the master mix for 5 seconds and then spin briefly in a microcentrifuge to remove any liquid
from the cap.

Note: Steps 6-8 must be performed in a biological hood using dedicated pipettes.

23.

24.

25.

26.

27.

28.

Aliquot 15 pL of the master mix into each labeled 0.2 mL reaction tube:

If less than 10 pl of sample is added for any sample, the difference should be made up by adding TE
buffer for a final volume of 10 pl.

Add sample to the labeled 0.2 mL reaction tubes as follows:

For all evidence and reference samples, add approximately 1.5 to 2.0 ng of target DNA in a volume
equal to or less than 10 pL. Note: 1.5 to 2.0 ngis a-suggested target amount. The actual amount added
will depend on the nature of the sample and any additional information obtained from DNA

quantitation.

For reagent blanks add a volume that is equal to the greatest volume from any of the evidence samples
associated with it.

Add 6-7 uL (0.1 ng7uL) of AmpF]STR® Control DNA 9947A to the positive amplification control
tube. Add TE buffer to obtain a final volume of 10 uL.

Add 10 uL of TE buffer or water to the negative control tube.

Transport the tubes to the Amplification Room. Place a MicroAmp tray containing the PCR reaction
tubes into-one of the thermal cyclers. Use the capping tool to firmly close the caps on all PCR reaction
tubes.

Turn the thermal cycler on (if not already done).

Select the ID Plus x28 program.
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a. Initial Incubation
95 °C, 11 minutes

b. 28 Cycles
94 °C, 20 seconds

59 °C, 3 minutes

c. Final Extension
60 °C, 10 minutes

d. Final Hold
4°C, ©

29. Remove the amplified products from the thermal cycler anytime after reaching4 °C, then store in the

freezer.

REFERENCES:
AmpFlSTR® Identifiler Plus® PCR Amplification Kit User’s Manual
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Method: Amplification with the AmpFISTR MiniFiler™ Kit

Date: 07/25/2007 Approved By: SAM

INTRODUCTION:

The AmpFISTR MiniFiler ™ PCR Amplification Kit is designed as an adjunct kit to the AmpFISTR
Identifiler™ kit for genotyping challenged samples that are degraded and/or contain PCR inhibitors. The
key procedural differences between the systems are detailed below. All procedures for the AmpFISTR
MiniFiler ™ PCR Amplification Kit may also be found in the User Guide.

REAGENTS:

1. TE Buffer (10mM Tris-HCI, 0.1mM EDTA, pH 8.0)

Mix together 10 mL of 1M Tris-HCI, pH= 8.0 with 0.2 mL of 0.5M EDTA and 990 mL nanopure
water. Aliquot into 100 mL bottles, autoclave and store at;room temperature. This solution is good
for nine months.

2. AmpFISTR MiniFiler ™ PCR Amplification Kits: Applied BioSystems
A. AmpFISTR MiniFiler ™ Master Mix
B. AmpFISTR MiniFiler™ Primer Set
C. AmpFISTR Control DNA 007

The master mix and primer set should be stored-at -20°C upon receipt, and at 2 to 8°C after initial use. The
control DNA 007 should be stored at 2'to.8°C upon receipt and after initial use. The expiration date is
printed on the kit.

MATERIALS:
1. MicroAmp Autoclaved Reaction Tubes with Caps Applied Biosystems (P/N N801-0612)
2. MicroAmp.9700 Tray Applied Biosystems (P/N N801-0541)
3. 96-well Plate Applied Biosystems

EQUIPMENT:
GeneAmp PCR System 9700 Thermal Cyclers Applied Biosystems

PROCEDURE:

1. Fill out an AmpFISTR MiniFiler™ Amplification Worksheet and determine the total number of samples
to be amplified including the positive control (007 DNA), the negative amplification control, and all
samples.
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Label a 0.2 mL MicroAmp Reaction Tube for each of the samples to be amplified.

Vortex the AmpFISTR MiniFiler™ Master Mix, AmpFISTR MiniFiler™ Primer Set, and AmpFISTR
Control DNA 007. Vortex the three tubes for 5 seconds and spin briefly in a microcentrifuge to

remove any liquid from the caps.

Create a master mix by combining the following volumes of reagents into a 1.5 mL microcentrifuge
tube:

a. 10 uL AmpFISTR MiniFiler™ Master Mix X (# samples) + 10%
b. 5 uL AmpFISTR MiniFiler™ Primer Set X (# samples) + 10%

Vortex the master mix for 5 seconds and then spin briefly in a microcentrifuge toremove any liquid
from the cap.

Note: Steps 6-8 must be performed in a biological hood using dedicated pipettes.

6.

7.

Aliquot 15uL of the master mix into each labeled 0.2mL reaction tube:

If less than 10 pl of sample is added for any sample, the difference should be made up by adding TE
buffer for a final volume of 10 pl.

Add sample to the labeled 0.2mL reaction tubes as follows:
For all evidence and reference samples, add approximately 0.3ng of target DNA in a volume equal to or
less than 10uL. Note: 0.3ng is a suggested target amount. The actual amount added will depend on the

nature of the sample and any additional information obtained from DNA quantitation.

For reagent blanks add a yolume that is equal to the greatest volume from any of the evidence samples
associated with it.

Add 2-4pL (0.1ng/uL) of AmpFISTR Control DNA 007 to the positive amplification control tube.
Add TE buffer to obtain a final volume of 10 uL.

Add 10ull of TE buffer or water to the negative control tube.

Transport-the tubes to the Amplification Room. Place a MicroAmp tray containing the PCR reaction

tubes onto a thermal cycler .

10. Turn the thermal cycler on (if not already done).

11. Select the MiniFiler program.
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a. Initial Incubation
95°C, 11 minutes

b. 30 Cycles
94°C, 20 seconds

59°C, 2 minutes
72°C, 1 minute

c. Final Extension
60°C, 45 minutes

d. Final Hold
4°C, ©

12. Remove the amplified products from the thermal cycler anytime after reaching 4°C, then store in the
freezer.

REFERENCE:
AmpFISTR MiniFiler™ PCR Amplification Kit User’s Manual
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Method: Amplification with the AmpFISTR Yfiler™ Kit

Date: 07/25/2007 Approved by: SAM

Amplification and analysis of Y-STR DNA markers using the AmpFISTR Yfiler ™ STR kit is performed using
similar procedures to those for AmpFISTR Identifiler ™ STR analysis. The key procedural differences
between the systems are detailed here.

REAGENTS:

1. AmpFISTR Yfiler'™ PCR Amplification Kits: Applied Biosystems (P/N 4359513)
A. AmpFISTR Yfiler™ PCR Reaction Mix
B. AmpFISTR Yfiler ™ Primer Set
C. AmpliTaq Gold™ DNA Polymerase
D. AmpFISTR Control DNA 007 (do not use Control DNA 9947A — female DNA)

PROCEDURE:

1. Fill out an AmpFISTR Yfiler™ Amplification Worksheet and determine the total number of samples to
be amplified including the positive control (007), the negative amplification control, and all samples.

2. Labela 0.2mL MicroAmp Reaction tube for each of the samples to be amplified.
3. Vortex the AmpFISTR Yfiler™ PCR Reaction Mix, AmpFISTR Yfiler™ Primer Set, AmpliTaq Gold™
DNA Polymerase, and AmpFISTR Control'DNA 007 for 5 seconds. Spin the tubes briefly in a

microcentrifuge to remové anyliquid from the caps.

4. Create a master mix by combining the following volumes of reagents into a 1.5mL microcentrifuge

tube:
a.  9.2uL of AmpFISTR Yfiler™ PCR Reaction Mix x  (# of samples +10%)
b2 0.8uL of AmpliTaq Gold DNA Polymerase X (# of samples +10%)
c. 5.0uL of AmpFISTR Identifiler Primer Set x  (# of samples +10%)

5. Vortex the master mix at medium speed for 5 seconds and spin the tube briefly in a microcentrifuge to

remove any liquid from the cap.
Note:  Steps 6 - § are performed in a biological hood using dedicated pipettes.

6. Dispense 15uL of the master mix into each labeled 0.2mL reaction tube.
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7. Ifless than 10uL of sample is added for any sample, the difference should be made up by adding TE
buffer.

8.  Add sample to the labeled 0.2mL reaction tubes as follows:

For all evidence and reference samples, add approximately 0.75ng of male target DNA in a volume
equal to or less than 10ul. Note: 0.75 ng is a suggested target amount of DNA. The actual amount
added will depend on the nature of the sample and any additional information obtained from
quantitation (or estimation of the concentration) of male DNA in a sample.

For reagent blanks add a volume that is equal to the greatest volume from any of the evidence samples
associated with it.

Add 5-10uL (0.1ng/uL) of AmpFISTR Control DNA 007 to the positive amplification control tube. If less than
10uL of Control DNA is added, the difference is made up by adding TE buffer.

Add 10uL of TE buffer to the negative control tube.

9.  Transport the tubes to the Amplification Area. Place a MicroAmp tray containing the PCR reaction tubes into
one of the thermal cyclers. Use the capping tool to firmly close the caps on all PCR reaction tubes.

10. Turn the thermal cycler on (if not already done).

11. Select the program named Yfiler.

Initial incubation at 95°C\for 11 minutes.

®

b. 30 cycles of the following profile:
Denaturing at 94°C for 1 minute
Annealing at 61°C for 1 minute

Extending at/72°C for 1 minute
c. Final extension at 60°C for 80 minutes
d. Indefinite incubation at 4°C.

The amplified products can be removed from the thermal cycler at any time after reaching 4°C., Amplified
samples are stored in the freezer.

REFERENCES:
AmpFISTR Yfiler™ PCR Amplification Kit User’s Manual
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Method: Amplification with the AmpFlSTR® Identifiler Direct® kit
Date: 05/01/2012 Approved by:SAM
REAGENTS:

1. Prep—n—GoTM Buffer: Applied Biosystems

Store at room temperature. The expiration date is printed on the packaging.

2. AmpFlSTR® Identifiler Direct® PCR Amplification Kits: Applied BioSystems

D. AmpF]STR® Identifiler Direct® Master Mix
E. AmpFlSTR® Identifiler Direct® Primer Set
F. AmpFlSTR® Control DNA 9947A (2ng/uL)

Store all kit components at -15 to -25°C upon receipt. Storeall components at 2 to 8°C after initial use.
The primers contain light-sensitive dyes, and should be stored protected from light. The expiration date is
printed on the kit.

MATERIALS:

1. 96 Deep Well Plate: Multiple vendors

2. 96 Well Reaction Plate: Applied Biosystems

3. 96 Well Full Plate Cover: Applied Biosystems

EQUIPMENT:

3. GeneAmpPCR System 9700 Thermal Cyclers: Applied Biosystems
PROCEDURE:
1. Fill out an AmpFlSTR® Identifiler Direct® Amplification Worksheet.

2. Remove the cotton tip from a buccal swab and place it into a well of a 96 deep well plate. Repeat for
each buccal swab to be analyzed.

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 98 of 190




Unit Technical Manual

Forensic Biology

Add 400 uL of Prep—n—GoTM Buffer to each well of the deep well plate that contains a swab.
Incubate the deep well plate (containing swabs and buffer) for 20 minutes at room temperature.

Vortex the AronISTR® Identifiler Direct” Master Mix, AronISTR® Identifiler Direct” Primer Set,
and AmpFlSTR® Control DNA 9947A. Vortex the three tubes for 5 seconds and spin briefly in a
microcentrifuge to remove any liquid from the caps.

Create a master mix by combining the following volumes of reagents into a 1.5 mL rnicrocentrifuge
tube:

a. 8.5 L AmpFISTR® Identifiler Direct” Master Mix ~ x (# samples)y+ 10 %
b. 8.5 uL Aron]STR® Identifiler Direct” Primer Set  x (# samples) + 10%

Vortex the master mix for 5 seconds and then spin brieflyin a rnicrocentrifuge to remove any liquid
from the cap.

Note: Steps 8-9 must be performed in a biological hood using dedicated pipettes.

8. Aliquot 17 uL of the master mix into the appropriate wells of a 96 well reaction plate.
9. Add samples to the appropriate wells of the 96 well reaction plate as follows:
For all reference samples, add 2 jaluof lysate from the 96 deep well plate.
For the positive control, add 1 uL of Control DNA 9947A (2 ng/uL).
For the amplification blank; add 2 uL of Prep-n- Go™ Buffer.
10. Cover the 96 well reaction plate with a 96 well full plate cover and transport the plate to the
Amplification Room. Place the plate into one of the thermal cyclers.
11. Turn the thermal cycler on (if not already done).
12. Select the “ID Direct x27” program.
e. Initial Incubation
95°C, 11 minutes
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f. 27 Cycles
94°C, 20 seconds

59°C, 2 minutes
72°C, 1 minute

g. Final Extension
60°C, 25 minutes

h. Final Hold
4°C,

13. Remove the amplified products from the thermal cycler anytime after reaching 4°C, then store in the
freezer.

Note: The remaining sample lysates may be left in the deep well plate.or transferred to separate tubes and
stored frozen. Sample lysates have been successfully amplified after more than five months of being stored
frozen at the SDPD. Once acceptable results have been gbtained, sample lysates may be discarded. In the
event that additional analysis is deemed necessary, the remaining unanalyzed buccal swab could be used or a

new reference could be collected.

REFERENCES:

AmpFlSTR® Identifiler Direct® PCR Amplification Kit User’s Manual
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Method: Identifiler Plus™, Minifiler™, Yfiler™ Setup Using the Hamilton
Microlab® Nimbus 4

Date: 04/17/2013 Approved by: SAM

REAGENTS:

1. TE Buffer (10mM Tris-HCI, 0.1mM EDTA, pH 8.0):

Mix together 10mL of 1M Tris-HCI, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure
water. Aliquot into bottles, autoclave and store at room temperature. This solution is good for nine

months.

2. AmpFlSTR® Identifiler Plus™ PCR Amplification Kit: Applied Biosystems (P/N 4427485)

D. AmpFlSTR® Identifiler Plus™ Master Mix
E. AmpFlSTR® Identifiler Plus™ Primer Set
F. AmpFISTR"™ Control DNA 9947A

3. AmpFISTR" Yfiler™ PCR Amplification Kit: Applied Biosystems (P/N 4365495)

AmpFlSTR® Yfiler™ PCR Reaction Mix
AmpFlSTR® Yfiler™ Primer Set
AmpliTaq Gold™ DNA Polymerase
AmpFISTR" Control DNA 007

ca=w>

4. AmpFlSTR® Minifiler ™ PCR Amplification Kit: Applied Biosystems (P/N 4373874)
A. AmpFlSTR® Minifiler™ Master Mix

B. AmpFlSTR® Minifiler™ Primer Set
C. AmpFI/STR" Control DNA 007

Store all kit'components at -15 to -25°C upon receipt. Store AmpliTaq Gold™ DNA Polymerase at -15 to -
25°C indefinitely. Store all other components at 2 to 8°C after initial use. The primer sets contain a light
sensitive dye, and should be stored protected from light. The expiration date is printed on the kits.

MATERIALS:

1. 96-Well Optical Reaction Plates: Applied Biosystems (P/N 4306737)
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2. Full Plate Covers: Applied Biosystems (P/N N801-0550)
3. MicroAmp 8-cap strips: Applied Biosystems (P/N N801-0535)

EQUIPMENT:

1. Hamilton Microlab Nimbus 4 Liquid Handling Workstation: Hamilton Robotics
2. GeneAmp PCR System 9700 Thermal Cyclers: Applied Biosystems

PROCEDURE:

1. This protocol is to setup the 96-well optical plate for PCR DNA amplification using Identifiler Plus™
Minifiler™, and Yfiler™.

b

Important notes to remember when using the Microlab Nimbus for setup:

d. The pre-run maintenance should be performed prior to the first run of the day (refer to
maintenance protocol in the FB Unit Policy Manual).

e. Itis highly recommended that all tip racks-are full prior to the start of a run. At minimum,
complete columns of tips must be present sufficient to perform the run.

f.  Sarstedt 1.5mL screw-cap tubes are required for use on the instrument for all samples,
controls, and TE buffer. 2.0mL serew-cap tubes are required for master mix. Caps should
be removed after tubes are placed in the racks and replaced prior to removing tubes from
the racks.

2. Identifiler Plus — Vortex the AmpFlSTR® Identifiler Plus"™ Master Mix, AmpFlSTR® Identifiler Plus™
Primer Set, and AronISTR® Control DNA 9947A for 5 seconds. Spin the tubes briefly in a
microcentrifuge to remove any liquid from the caps.

Yfiler — Vortex the AmpFlSTR® Yfiler™ PCR Reaction Mix, AmpF]STR® Yfiler™ Primer Set,
AmpliTaq Gold™ DNA Polymerase, and AmpFlSTR® Control DNA 007 for 5 seconds. Spin the tubes

briefly in a microcentrifuge to remove any liquid from the caps.

Minifiler— Vortex the AmpFlSTR® Minifiler™ Master Mix, AmpFlSTR® Minifiler™ Primer Set, and
Aron]STR® Control DNA 007 for 5 seconds. Spin the tubes briefly in a microcentrifuge to remove
any liquid from the caps.

3. Determine the total number of samples to be amplified including the positive control and one
amplification blank (Note: The Nimbus requires at least 8 samples to run the amplification protocol).
Create a master mix by combining the following volumes of reagents in a 2.0mL screw-cap tube.
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Identifiler Plus

10uL AmpF]STR® Identifiler Plus™ Master Mix X # of Samples
S5uL AmpF]STR® Identifiler Plus™ Primer Set X # of Samples
Yfiler

9.2uL AmpFISTR" Yfiler ™ PCR Reaction Mix x # of Samples
0.8uL AmpliTaq Gold™ DNA Polymerase X # of Samples
S5uL AmpFlSTR® Yfiler™ Primer Set X # of Samples
Minifiler

10uL AmpF]STR® Minifiler™ Master Mix X # of Samples
S5uL AmpF]STR® Minifiler™ Primer Set X # of Samples

Note: The above is the minimum volume required per sample. The Nimbus requires additional master
mix to perform the setup. The volumes calculated in the current version of the SDPD SIMS should be
prepared.

4. Open the Amp setup sheet in the most current version of the SDPD SIMS (found on the FB network
H:\Worksheets).

f. The default spreadsheet shows the deck position of all samples and their destination
positions.

g. Fill out the “Sample Name” column with a list of the sample IDs and the DNA conc.
[ng/uL] column. Ensure that the VolumeSample and VolumeTE are completed
appropriately.

h. Save the SDPD.SIMS workbook to a location accessible on the FB network (the Nimbus
cannot read from a password protected Excel file).

i.  When finished, the PCR worksheet(s) should be printed for the case notes.

j.  Exit the SDPD'SIMS.

5. Empty the tip waste (if necessary).
6. Refill the tip racks on the Nimbus.
7. Place the 96-well optical plate in the appropriate location on the deck.

8. Place the DNA samples in the appropriate order (according to the setup sheet filled in earlier). You

may use your printed copy to ensure the sample positions are correct.
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Note: The samples are to be placed in the racks in a left to right direction, filling each column completely

before the next.

9.

10.

11

12.

13.

14.

15.

16.

17.

Place the master mix in the appropriate place on the deck.

Place four 1.5mL screw-cap tubes each containing 300uL of TE in the appropriate place on the deck.

. Remove the caps from the samples, master mix, and TE.

Close the instrument door (the door must remain closed during operation).
Open the Hamilton Run Control software (on the desktop).

g. Open the current version of the SDPD qPCR and PCR.Setup.method within the
software.

h. Click the “Run” button (P).

i. In the user prompt, navigate to the worklist input file (from step 4 above), select “PCR
Setup”, and click “Continue”.

j- Verify that sufficient 300uL and 50uL tips are loaded onto the deck and click “Continue”.

k. Enter the first and last position ‘of the 300uL tips (1=A1, 2=A2, ..., 96=H12) and click
“OK”.

1. Enter the first and last position of the 50uL tips (1=A1,, 2=A2,, ..., 96=H12,, 97=Al1,,
98=A2,, ..., 192=H12,) and click “OK”.

The Nimbus will now add master mix, TE buffer, and sample DNA to the 96-well optical plate.
Click “OK” to acknowledge completion of the run.

When the protocol has finished, the tubes can be re-capped and removed, and the 96-well optical plate
can be covered with a rubber plate cover and carried to the amplification room for loading into the
GeneAmp 9700 thermalcycler.

The PCR analysis can be continued by following the “Amplification with the AmpFISTR® Identifiler
Plus"™ Kit” protocol at step 9, the “Amplification with the AmpF]STR® Yfiler ™ Kit” protocol at step 10,
and the “Amplification with the AmpFlSTR® Minifiler ™ Kit” protocol at step 10.
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REFERENCES:
Microlab® Nimbus Independent Channel Operator’s Manual. Hamilton Robotics.

Microlab® Nimbus Enclosed Version Operator’s Manual. Hamilton Robotics.

Microlab® Nimbus Independent Channel Programmer’s Manual. Hamilton Robotics.

AmpFlSTR® Identifiler Plus™ PCR Amplification Kit User’s Manual. Applied Biosystems.

AmpFlSTR® Yfiler™ PCR Amplification Kit User’s Manual. Applied Biosystems.
AmpFlSTR® Minifiler ™ PCR Amplification Kit User’s Manual. Applied Biosystems.
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Method: Identifiler Plus™, Minifiler™,Yfiler™ Setup Using the Qiagen BioRobot®
Universal

Date: 03/01/2010 Approved by: SAM

REAGENTS:

1. TE Buffer(10mM Tris-HCI, 0.1mM EDTA, pH 8.0):

Mix together 10mL of 1M Tris-HCI, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure
water. Aliquot into 100mL bottles, autoclave and store at room temperature. . This solution is good for
nine months.

3. AmpFlSTR® Identifiler Plus® PCR Amplification Kits: Applied BioSystems
A. AmpFlSTR® Identifiler Plus® Master Mix
B. AmpFlSTR® Identifiler Plus® Primer Set
C. AmpFISTR” Control DNA 9947A

2. AmpFISTR Yfiler™ PCR Amplification Kits: Applied Biosystems (P/N 4365495)
A. AmpFISTR PCR Reaction Mix
B. AmpFISTR Yfiler™ Primer Set
C. AmpliTaq Gold™ DNA Polymerase
D. AmpFISTR Control DNA 007

3. AmpFISTR Minifiler™ PCR Amplification Kits: Applied Biosystems (P/N 4373874)
A. AmpFISTR Minifiler™ Master Mix

B. AmpFISTR Minifiler™ Primer Set
C. AmpFISTR Control DNA007

The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8°C. The remaining
components of the kit should be stored at -15 to -25°C. The primer sets contain a light sensitive dye, and
should be stored protected from light. The expiration date is printed on the kit.

MATERIALS:

1. 96- Well Optical Reaction Plates Applied Biosystems (P/N 4306737)
2. Full Plate Covers Applied Biosystems (P/N N801-0550)
3. MicroAmp 8-cap strip Applied Biosystems (P/N N801-0535)

EQUIPMENT:
1. Qiagen Universal BioRobot Universal Liquid Handler Qiagen Corporation
2. GeneAmp PCR System 9700 Thermal Cyclers Applied Biosystems
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PROCEDURE:
This protocol is to setup the 96-well optical plate for PCR DNA amplification using Identifiler™.

1. Important notes to remember for using the BioRobot Universal for setup:

a. Itis recommended that the system liquid carboy be well above the minimum level prior to
commencing a run.

b. Itis recommended that the system be re-initialized and a 100mL flush (available from the Tools
drop-down menu) be performed prior to commencing a run.

c. Sarstedt screw-cap tubes are required for use on the instrument as they fit securely in the cooling
blocks. Caps should be removed after tubes are placed in the cooling blocks and replaced prior to
removing tubes from the cooling block.

d. The maximum volume of sample is 10uL. If additional Taq DNA polymerase is to be added, the

maximum amount of sample is 8ul.

2. Yfiler - Vortex the AmpFISTR PCR Reaction Mix, AmpFISTR Yfiler™ Primer Set, AmpliTaq Gold™
DNA Polymerase, and AmpFISTR Control DNA 007 for 5 seconds. Spin the tubes briefly in a
microcentrifuge to remove any liquid from the caps:

Minifiler — Vortex the AmpFISTR Minifiler'™ Master Mix, AmpFISTR Minifiler ™ Primer Set, and
AmpFISTR Control DNA 007 for 5 seconds. Spin the tubes briefly in a microcentrifuge to remove any
liquid from the caps. (Skip to Step 4.)

3. Create a master mix for the appropriate kit by Combining the following volumes of reagents into a
1.5mL Sarstedt screw-cap tube:

Identifiler Plus

10 uL AronISTR® Identifiler Plus®Master Mix X # samples + 10 %
5uL AmpFlSTR® Identifiler Plus® Primer Set X # samples + 10 %
Yfiler

9.2uL of AmpFISTR Yfiler™ PCR Reaction Mix X # of samples + 10 %
0.8ulsof AmpliTag Gold DNA Polymerase X # of samples + 10 %
5.0uls of AmpFISTR Identifiler Primer Set X # of samples + 10 %
Minifiler

10 pL AmpFISTR MiniFiler ™ Master Mix X # of samples + 10 %
5 uL AmpFISTR MiniFiler' Primer Set X # of samples + 10 %

Note: Additional master mix (~10%) should be created to allow for pipetting error.

4. The Amp Setup within the current version of the SDPD Worksheet maker (found on the FB network
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H:\Worksheets) is the primary sheet for using the BioRobot Universal for amplification setup.
a. The Master Amp Sheet shows the deck positions of all samples and their destination positions.

b. Fill out the “Sample Name” column with a list of the sample IDs and the DNA conc. [ng/ul]
column. Ensure that the VolumeSample and VolumeTE are completed appropriately.

c. Delete any unused rows below your samples (Highlight then Edit>Delete). The file can be saved
as an excel workbook for future use.

d. The Master Amp Sheet should be saved as a *.csv file type. This is accomplished by using the
“Save as...” command from the File menu. The .csv file must be saved in the ImportData folder
on the Qiagenuniversal hard drive. (Note: *.csv file names should begin with the analysts’
initials followed by case # (e.g. initials(XX-XXXXXX).csv).

e.  When finished, the PCR worksheet(s) should be printed for the case notes.
f.  Close the .csv file.

5. Open QiaSoft™ v.5 software (on the Qiagenuniversal computer desktop). Log in as “sdpd” and leave
the password blank.

a. Under “applications” select “Forensic” in the drop-down menu (V') and then select either the
“SDPD Identifiler Plus Amplificationv.1” or the “Minifiler — Yfiler Amplification
v.1” protocols.

Click “Run” button (). Follow the prompts from the protocol for preliminary setup.
Enter the number of samples.to be amplified.

Enter the appropriate .esv file name.

o a0

The .csv table will be checked by the software and can be viewed to ensure correct file was
selected.
f. The System Liquid bottle should be filled above the minimum. The protocol will not continue
if liquid-level is below minimum.
g. Empty tip waste (if necessary).
h. Refill the tip racks (if necessary). If tips run out the instrument will prompt you to refill later.
i. Place the 96-well optical plate on the appropriate location on the deck making sure to tape the
side(s) of the plate to the base.
j. Place your DNA samples in the appropriate order (according to the setup sheet filled in
earlier). You may use your printed copy to ensure the sample positions are correct.
Note: The samples are to be placed in the cooling blocks in a left to right direction, filling each column
completely before the next.
a. Four tubes containing TE buffer should be placed in the appropriate location on the deck.
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b. Place the Master Mix in the appropriate place(s) on the deck. Note: if more than 48 samples
are being amplified then the master mix will need to be split into two tubes (follow the
prompts from the instrument).

6. The BioRobot Universal will now add the master mix, TE buffer, and sample DNA to the 96-well
optical plate.

7. When the protocol has finished, the tubes can be re-capped and removed, and the 96-well optical plate
can be covered with a rubber plate cover and carried to the amplification room for loading inte the
GeneAmp 9700 thermalcycler.

References:
1. BioRobot 8000 Users manual. Qiagen Corporation.
2. QiaSoft 5 Software System Users Guide. Qiagen Corporation.
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Method: WellAware Set-up of Samples for Amplification
Date: 12/06/2010 Approved by: SAM
REAGENTS:

This protocol is for manual setup, using the WellAware as a pipetting assistant, of a 96-well optical plate for
PCR amplification using the Identifiler™, Minifiler™, or Yfiler™ amplification kits. Please refer to the
Identifiler amplification protocol for information on master mix preparation and other additional
information regarding this protocol.

MATERIALS:

96-Well Optical Reaction Plate Applied Biosystems (P/N N801-0560)
Full Plate Covers Applied Biosystems (P/N N801-0550)

Aluminum Seal tape for 96-Well Plates Fisher Scientific (P/N 232698)
Pre-scored 96-well plate sealing tape Nunc (P/N 236701)

S w N =

EQUIPMENT:
1. WellAware BioTX
2. GeneAmp PCR System 9700 Thermal Cyclers Applied Biosystems

PROCEDURE:

[Note: fractions of uLs are incompatible with the protocol for WellAware setup of samples. Please round
to the nearest whole number prior to creating your WellAware eSOP file. ]

1. Open the PCR (1-24) worksheet (or the Minifiler or Yfiler Amp worksheets) in the current version
of the SDPD SIMS (found on-the FB network H:\Worksheets). Click on the ‘Make WellAware eSOP’
button to generate'a WellAware eSOP (electronic standard operating procedure). The eSOP is
automatically'saved on the WellAware folder on the FB networks.

2. Navigate to the newly saved file and save it as a text file (.txt) in the appropriate WellAware folder on
the FB network. This is accomplished by using the “Save as...” command from the File menu. The
Text (Tab-delimited) file must be saved in the WellAware folder on the FB network.

[Note: The eSOP requires a case number be entered on the worksheet]

3. When finished, the PCR worksheet should be printed for your case notes.
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4. Power on the WellAware computer (if needed) located in the hood in the amplification set-up room.
Plug in the keyboard to the laptop (if not currently connected). To log into the computer, the
username is BioTx. Open the BioTX Lab Suite software.

5. Under the Modules tab, click on ‘“WellAware’ then under the Electronic SOPs tab, click on ‘Open
Saved eSOP.” Navigate to the WellAware folder on the FB Network and open your saved eSOP.

6. Place a 96-Well Optical Reaction Plate on the bottom right surface of the WellAware screen.
7. Plug the hand sensor into the USB port on the computer.

8. Begin the protocol. [It is recommended that when manually pipetting into a 96-well plate that one of
the pre-scored tape seals be used to minimize potential contaimination.

9. When the protocol has finished the 96-well optical plate can be covered with arubber plate cover and
carried to the amplification room for loading into the GeneAmp 9700 thermalcycler.

10. When the protocol is complete, exit the WellAware software.
11. Unplug the hand sensor from the USB port.
12. Power off (shut down, do not select hibernate) the WellAware computer.

REFERENCE:
WellAware User Guide.
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Method: ABI 3130 Genetic Analyzer Instrument Preparation and Cleaning
Date: 06/01/06 Revision Date: 01/01/2007 Approved by: SAM
INTRODUCTION:

Although the 3130 Genetic Analyzer functions by the same principals as the 310 Genetic Analyzer, there
are certain fundamental differences including the way in which the instrument is prepared for-arun. For
example, the pump block does not need to be routinely removed from the instrument for cleaning, but
rather is flushed with water while in place on the instrument, and the polymer is not injected via a syringe,
but rather is drawn directly from the manufacturer’s bottle.

REAGENTS:

3130 Genetic Anal¥zer Performance Optimized Polymer (POP-4™;
Applied Biosystems (P/N 4352755)

Store at 2-8C. See bottle for expiration date.
(Note: this is not the same as 310 POP-4™used on the 310)

Genetic Analyzer Buffer (10X) with EDTA:
Applied Biosystems (P/N 402824)
Store at 2-8C.

(Note: this is the same buffer used on the 310)

MATERIALS:

3130 & 3100-Avant Capillary Array (36 cm): Applied Biosystems 4-capillary array (P/N 4333464)
96-Well Optical Reaction Plates: Applied Biosystems (P/N 4306737)

Plate Septa for 96-well: Applied Biosystems (P/N 4315933)

3130 and 3100 Series Plate Base 96-well: Applied Biosystems (P/N 431723)

3100 Genetic Analyzer Plate Retainer 96-well: Applied Biosystems (P/N 4317241)

Buffer/Water Reservoirs: Applied Biosystems (P/N 628-3202)

Septa for Buffer/Water Reservoirs: Applied Biosystems (P/N 628-0150)

N O\ G AW N

PROCEDURE:

Powering on the 3130 and launching the Data Collection software

1. Power on the computer monitor, then power on the computer. At the Log On prompt, hit OK (or
Enter) leaving the Password window blank.

2. Before turning on the 3130 instrument, ensure that the oven door is closed and locked, that the
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instrument doors are closed, and the computer is powered on.

3. Power on the instrument by pressing the on/off button on the front of the instrument. Ensure that the
green status light is on and not flashing before proceeding.

4. Click on the Run 3130 Data Collection V3.0 icon on the desktop. As the software launches, the
Service Console appears. Initially the Service Console displays four red circles, indicating that all
applications are off. As each application activates, the red circles (off) change to yellow triangles
(activating) and then to green squares (on). This may take several minutes.

!@ Service Console

Meszaging Service

Data Service

Instrument Service O
Wiewer o

T

Note: the Data Collection Software containg numerous wizards that can be followed to accomplish various
tasks. To access these wizards, launch Data Collection and click on GA Instruments > ga3130 >
SDPD3130A > Instrument Status and select a specific wizard from the Wizards drop-down menu.
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Installing or replacing the capillar¥ array

The capillary array should be replaced after approximately 250 injections per capillary, or removed from
the instrument for storage if the instrument is to be shut down for an extended period of time.

Select the Install Array Wizard for guidance.

Wash the pump block
The pump chamber, channels and tubing should be washed on a weekly basis, or before each batch of runs.

Select the Water Wash Wizard for guidance.

Replenishing polymer
Polymer should be replenished as needed, but unused polymer should be replaced with fresh polymer after

approximately two weeks on the instrument.

1. Remove the polymer from the refrigerator and allow to equilibrate to room temperature. Open

the cap of the bottle slightly to allow de—gassing.

2. Select the Replenish Polymer Wizard for guidance.

Removing bubbles from the pump block

Periodically, check the pump chamber, channels'and tubing for air bubbles. Press the button on the right
hand side of the front of the instrument to turn on the lamp inside the instrument. This will help locate any

air bubbles.

Select the Bubble Removal Wizard for guidance.

Preparing buffer and(filling reservoirs

It is recommended that the 1X 3130 buffer in the anode and cathode buffer reservoirs should be replaced
before each batch of runs, however, multiple runs have been completed using the same buffers with no
adverse affects.

1. Add 5mL of 10X 3130 Genetic Analyzer buffer to a 50mL graduated cylinder and make up to 50mL
with nanopure water. Mix.

2. Check that the oven and instrument doors are closed and press the Tray button on the front of the
instrument. The autosampler will move to the forward position. (Note: the autosampler will not

move if the instrument doors are open.)
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Wait until the autosampler stops and open the instrument doors.

Remove the cathode buffer (position 1), waste (position 2) and water (position 4) reservoirs at the
front of the autosampler. (Note: position 3 is and should remain vacant.)

Remove and discard the septa, and rinse the reservoirs with nanopure or distilled water. Do not use
any detergents when rinsing these reservoirs.

Rinse the cathode reservoir with 1X 3130 buffer and then fill to the line with 1X 3130 buffer
(approximately 16mL).

Fill the waste and water reservoirs to the line with nanopure water (approximately 16mL).
Place fresh septa on the reservoirs and place the reservoirs back in their respeective positions.

Remove the anode buffer reservoir from the bottom of the lower polymer block by firmly pulling
down and twisting slowly.

Clean and rinse the reservoir with nanopure water;‘and then rinse with 1X 3130 buffer.
Fill the anode reservoir to the line with 1X3130 buffer (approximately 16mL).
Replace the anode reservoir on the lower polymer block.

Close the instrument doors and press the Tray button to return the autosampler to its original
position.

Calibration of the autosampler

Only a trained instrument specialist should calibrate the 3130 autosampler. Under no circumstance should

an analyst attempt to calibrateythe’ autosampler.

(See also Procedures for Performing a Spatial Calibration, Spectral Calibration, and Flushing and Filling the

Water Trap)

REFERENCES:
Applied Biosystems 3130/3130x] Genetic Analyzers Getting Started Guide.

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 115 of 190

J




Unit Technical Manual

Forensic Biology

Method: Preparation of AmpFISTR Identifiler Plus ™ (Identifiler Direct, Minifiler™ or
YﬁlerTM) Samples for Analysis on the Applied Biosystems 3130 Genetic
Analyzer

Date: 06/01/2006 Revision Date: 04/01/2011 Approved by: SAM

REAGENTS:
1. HIDI Formamide: Applied Biosystems (P/N 4311320)

Dispense the formamide into 500ul aliquots and store frozen. The frozen formamide can be used up to
1 year after being aliquoted.

Caution: Formamide is a known teratogen and is harmful by inhalation; skin contact, and ingestion.
Use in a fume hood and wear chemical resistant gloves and safety glasses when handling.

2. GeneScan-500 [LIZ] Internal Size Standard: Applied Biosystems (P/N 4322682)
The tubes may be stored for up to six months at 4°C:

3. AmpFISTR Identifiler Plus"™ (Identifiler Direct, Minifiler™ or Yfiler™) Allelic Ladder: (included in

the Identifiler Plus™, Identifiler Direct, Minifiler™ or Yfiler ™ kits)
Store at 2 to 8°C, protected from light.

MATERIALS:

1. 96-Well Optical Reaction Plates:" Applied Biosystems (P/N 4306737)

2. Plate Septa for 96-Well plates:  Applied Biosystems (P/N 4315933)

3. MicroAmp Splash Free Support Base: Applied Biosystems (P/N 4312063)
4. 96-well cooling block: Stored in-the reagent freezer

PROCEDURE:

Note: Prior to preparing samples, the 9700 thermal cycler can be turned on so that the top plate can come
to temperature.

1. Take outa new 96-well reaction plate.

2. Create a master mix by combining the following volumes of reagents into a 1.5mL microcentrifuge
tube.
8.7ul formamide x (# of samples + 10%)
0.3uL GS500 [LIZ] x (# of samples + 10%)
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Vortex the master mix.
Aliquot 10uL of formamide into the formamide blank well (suggestion: A1) if used as a control.

Aliquot 9uL of the master mix into each of the appropriate wells on the 96-well reaction plate to
accommodate the numbers of amplified samples and allelic ladders samples.

Add 1uL of AmpFLSTR Identifiler Plus™ (Identifiler Direct, Minifiler™ or Yfiler™) Allelic Ladder to
the appropriate well(s) on the reaction plate. A second ladder is recommended when setting up.your

3130 plate.

Add 1uL of amplified sample to each sample well of the reaction plate.

Note: The 3130 instrument samples wells in sets of four (a through D and E through H). Any extra wells

in a set of four should have either formamide of formamide/internal size standard included in them so that

the capillaries are not descending into empty wells.

8.

10.

11.

12.

13.

Place a 96-well septa mat onto the reaction plate, and place the reaction plate in the 9700 thermal
cycler. The plate may be spun down prior to denaturing.

Denature the samples by running the denature 95 3min protocol. Important: Do not clamp down
the cover plate of the 9700 onto the septa mat-covered reaction plate as it will melt. Simply slide the
cover plate forward to cover the reaction plate without clamping it down.

After the denaturation protocol is finished; chill the reaction plate by immediately placing it the 96-well
cooling block (-20°C) for three mindtes.

Place the reaction plate into a'3130 base plate (it will only fit in one orientation) and secure a plate

retainer on top of the reaction plate: Check to ensure that the retainer clip is properly seated.

Press the tray button on the front of the 3130 Genetic Analyzer. When the tray presents itself, open
the doors of the instrument and place the tray onto the right side position (only option available at this
time) of the autosampler (the tray will only fit in one orientation). Close the instrument doors.

To start a run on'the 3130 Genetic Analyzer please see the Capillary Electrophoresis of
Ampliﬁed Samples protocol.

REFERENCES:

AmpFISTR Identifiler Plus™ PCR Amplification Kit User’s Manual
AmpFISTR Identifiler Direct™ PCR Amplification Kit User’s Manual
AmpFISTR Yfiler™ PCR Amplication Kit User’s Manual

AmpFISTR Minifiler ™ PCR Amplification Kit User’s Manual
Applied Biosystems 3130 User’s Bulletin.
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Applied Biosystems 3130 User’s Manual.

Forensic Biology

Applied Biosystems 3130 Getting Started Guide.
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Method: Preparation of AmpFISTR Identifiler Plus™, Identifiler Direct™, Minifiler™,
or Yfiler™ Amplified Samples for Analysis on the ABI 3130 Using the
Automated CAS-1200

Date: 04/01/2008 Revision Date: 04/01/2011 Approved by: SAM

REAGENTS:

1. HIDI Formamide: Applied Biosystems (P/N 4311320)
Dispense the formamide into 500uL aliquots and store frozen. The frozen formamide can be used up to
1 year after being aliquoted.

Caution: Formamide is a known teratogen and is harmful by inhalation, skin contact, and ingestion.
Use in a fume hood and wear chemical resistant gloves and safety glasses when handling.

2. GeneScan-500 [LIZ] Internal Lane Size Standard:
Applied Biosystems (P/N 4322682)
The kit may be stored up to six months at 4°C.

3. AmpFISTR Identifiler Plus™, Identifiler Diréet™ , Yfiler™, or Minifiler™ Allelic Ladder: (included in
the Identifiler Plus™, Identifiler Direct™ | Yfilet™, or Minifiler™ kits)
Store at 2 to 8°C, protected from light.

MATERIALS:

3130 and 3100 Series 96-well Plate Base: Applied Biosystems (P/N 4317237)

3100 Genetic Analyzer 96-well Plate Retainer: Applied Biosystems (P/N 4317241)
96-Well Optical Reaction-Plates:  Applied Biosystems (P/N N801-0560)

Plate Septa for 96-Well Plates: Applied Biosystems (P/N 4315933)

96-Well Cooling Block: Stored in the reagent freezer

Gl W N =

EQUIPMENT:

1. CAS-1200 Corbett Robotics
2. GeneAmp PCR System 9700 Thermal Cycler Applied Biosystems

PROCEDURE:

Note: Prior to preparing samples, the 9700 thermal cycler can be turned on so that the top plate can come
to temperature.

1. Remove the cover from the 96-well optical reaction plate that contains amplified samples.
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2. Place the amplified sample plate on the C1 Sample plate area on the deck of the CAS-1200. Place a
new 96-well optical reaction plate on the C2 Reaction plate area on the deck of the CAS-1200.

3. Create a master mix by combining the following volumes of reagents into a 5mL tapered tube:
e 17.4ul formamide x (# of samples + 20%)

® 0.6ul GeneScan-500 [LIZ] x (# of samples + 20%)

This mixture can be stored at 2-6°C for up to two weeks.

4.  Vortex the master mix. Place the tube of master mix into Well A on the M1 (Mix Plate) deck on the
CAS-1200. See diagram for deck layout and proper tube placement.

5. Place a 2mL flat tube containing ample AmpFISTR Identifiler Plus"" ( Identifiler Direct, Minifiler' or
Yfiler™) Allelic Ladder in Well A on the R1(Reaction Plate) déck’on the CAS-1200. Make sure the
Ladder has been mixed (via vortexing) and spun down (in‘a microeentrifuge) prior to loading on the

deck.

6. Place a 1.5mL tapered tube containing at l¢ast.100uL formamide into Well I on the R1 (Reaction
Plate) deck on the CAS-1200.

7. Choose the “3130 Plate Set-up 2uL” protocol (or verify that this is the protocol that is currently open).
8. Look at the C1 Sample Plate on the computer monitor.

8A. If you have more samples than are lit up with the colored indicators on the Sample
Plate:

Select the Sample Plate (there should be a red square around the plate).

Highlight (click’and drag) to add the extra wells that you need to correspond with the number of
samples that'were amplified, including the positive and negative controls (a red square around the well
indicates that the well has been selected).

Right click and select “Add selected wells to sample bank.”

In the Update Sample Bank window, select “Existing bank” (the only choice is “Amplified samples
Identifiler”). Click “Add selection.” The added wells should now light up with color indicators, and the
Reaction Plate should automatically correlate with the Sample Plate. There will be seven additional
wells that are color indicated on the Reaction Plate: 1 for formamide only, 1 for master mix only, and

2 for ladder (one in the first well and one in the last well).
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To replace the tips, remove the empty tip rack from the tip rack holder on the instrument, and replace with a full
rack of tips (the full tip rack will only seat one way on the tip rack holder). Using the mouse, highlight (click and

drag) the tip positions that are now available based on where the tips were just added. Right click and choose “Set
selected tips to ‘Available’.

10.

11.

12.

13

14.

Forensic Biology

8B. If you have fewer samples than are lit up with the colored indicators on the Sample
Plate:

Select the Sample Plate (there should be a red square around the plate).

Highlight (click and drag) to select the wells that you need to remove to correspond with the number of
samples that were amplified, including the positive and negative controls (a red square around the well
indicates that the well has been selected).

Right click and select “Remove selected wells from sample bank.”

In the Update Sample Bank window, click “Delete selection.” The previously lit wells should turn
clear, and the Reaction Plate should automatically be updated to correlate with the/Sample Plate.
There will be seven additional wells that are color indicated on the Reaction Plate: 1 for formamide
only, 1 for master mix only, and 2 for ladder (one in the first well and one in the last well).

Ensure that there are enough 50uL Tecan tips for the run:

Refill the tip racks in plate positions A2, B1, and B2 (if necessary). -Although plate position A1 is for
200uL tips, 200uL tips are not used in this protocol. If there are not enough tips for the run, the instrument
will prompt you in the Checklist window when you attempt to start the run.

b

To signal the CAS-1200 to begin the protocol, either click on the green dot with the arrow in it on the
shortcut tool bar, or choosé “Control” on the tool bar and select “Start.” In the Checklist window, click
on each message box, such that there’s an X in each box. Verify that the tip disposal box is not too full
(empty it, if necessary), and click OK.

The CAS-1200 willnow add the master mix, formamide blank, ladders and DNA samples to the 96-
well optical reaction plate.

When the protocol has finished, the sample plate on C1 on the deck (the plate containing the original

amplified samples) can be covered with a foil cover for freezer storage.

. Remove the reaction plate from the C2 deck position and place a plate septa mat on it. Denature the

samples by placing the plate in the 95°C heat block for three minutes. Choose the protocol entitled
Denature 21ul. Important: Do not clamp down the cover plate of the 9700 onto the septa mat-
covered reaction plate as it will melt. Simply slide the cover plate forward to cover the reaction plate
without clamping it down.

Chill the plate immediately in a freezer block for three minutes.
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15. Place the plate into a 3130 and 3100 Series 96-well plate base (it will only fit in one orientation) and

cover with a 3100 Genetic Analyzer 96-well plate retainer. Check to ensure that the retainer clip is

properly seated.

Deck Layout Diagram
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16. Press the Tray button on the front of the 3130 CE instrument. Once the autosampler has moved

forward, open the doors and place the tray onto the autosampler with position A1 at the upper right.

Close the instrument doors.

17. To start a run on the 3130 Genetic Analyzer please see the Capillary Electrophoresis of

Amplified Samples protocol.

Select sample re-preparation using the CAS-1200:
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In order to re-prepare select samples from the 96-well plate of amplified samples, highlight all of the wells

that you do not want re-prepared and delete them from the sample plate following step 8B.

REFERENCES:

CAS-1200 Liquid Handling System Manual
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Method: Decontaminating the CAS-1200 using the automated UV protocol
Date: 04/01/2008 Approved by: SAM
EQUIPMENT:

1. CAS-1200 Corbett Robotics
PROCEDURE:

1. Remove the box of ejected tips and use the plug that is attached to the side of the tip ejector chute to
plug the tip ejector chute.

2. With the 3130 Plate Setup 2.8uL program open, click on the UV Light/icon (the yellow light bulb).

3. Inthe UV lamp control window, choose the length of time you wish the UV lamp to be active by
sliding the flashing cursor right or left (a minimum of 5 minutes is recommended).

4. Select Start.

5. When the UV light operation has completed, click OK, unplug the tip ejector chute, and re-position
the ejected tips box.

REFERENCES:
CAS-1200 Liquid Handling System Manual
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Method: Capillary Electrophoresis of Amplified Samples on the Applied Biosystems
3130 Genetic Analyzer

Date: 06/01/06 Revision Date: 05/01/2012 Approved by: SAM

MATERIALS:

ABI PRISM® 3130 Data Collection Software
PROCEDURE:
1. Launch the ABI Prism 3130 Collection Application.

2. In the navigation pane of the Data Collection software click GA Instruments > ga3130 > Plate
Manager. Click NEW to open the New Plate dialog box. Alternatively if a 3130 plate record (*.txt
file) has been created using the SDPD Worksheet maker y2.2 it can'be imported to the database by
clicking on import in the Plate Manager then browsing for the appropriate file.

3. Complete the information in the New Plate Dialog box (note: It is suggested that Plate Records be
saved with analysts’ initials at the beginning.of the name so that they can be located more easily in the
database.) and hit OK. The GeneMapper Plate Editor opens.

New Plate Dialog

A

Name: | Example I Plate Name (see above note)

De=cription.  Casework sauples

A

Description (optional)

. Application will be

A

Application: |GeneMapper-31 304 i

Plate Type:  |[955vel |‘: CMDMN 212NA

Owner Matne: | SDPD |

Onerator Marme: | SAM |

a. GeneMapper Plate Editor: In the Sample Name column of a row, enter a sample name,
then click the next cell. The value of 100 is automatically displayed in the priority column
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for the entered samples.

Well

GeneMapper Plate Editor
File  Edit

Plate Mame: | al

‘ Operator:

Plate Sealing:

Sarmple Mame | Comnert

Qwvner.

Friority | Sample Type

Size Standard | Panel

A1

1>

BEO1

col
ool

E01
CFOl

%

Description |

4

[

[LESEWWOTK SammpIE:

[ concel |

b. An optional Comment column is available.

!@ GeneMapper Plate Editor

®

File Edit
Plate Hame: |71 | operstor: = |
Plate Sealingr | a- | mer:
| User-Defined 3 Fesuits Gioup 1 \lnstrument Profocal 1 | Results Group 2 Instrument Proocol 2| Resuts Group 3 Instrument Protocol 3|

| SDRD Pesulis Group | SDPD_identfier_Protoco, A
"SDPD_Resuls_Group.~ | SDPD_ldentifier_Protoca,,
SDRDLResuits_Group SDPD_Identfier_Protoco,

Doi " BDPD_Resuils Group SDPD_ldentifler_Protoce,| SDPD_Resuits_Group SDPD_ldentiler_Protoce,

EO1 SDPD Restls_Group | SDPD_denifier_Protoco,|
FO1 SDRDL Aesuits_Group SDPD_identifier_Protoca,

G0l _Resuts_Group | SDPD_identfier_Protoca, =
HO1 “I"SDPD_Results_Group SDFD_ldzntfiler_Frotico,
AD2 SDPD_Resuls_Group | SDPD_ideniifier_Protoca,
b E02 SDPD_Results_Group SDPD_ldentfler_Frotoca,,
coz SDPD_Results_Group SDPD_Identifiler_Protoco,
Doz SDPD_Resuls_Group | SDPD_identfier_Proface,
€02/ SDPD_Resuits_Group | SDPD_identilier_Protoco,
Foe SDPD_Fesults_Group | SDPD_Identifier_Protoca,
G0Z SDPD_Results_Group | SDPD_identiier_Protoca,
HO2 SDPD_Results_Group SDPD_Identfier_Protoco,
AD8 SDPD_Resuls_Group | SDPD_ideniifier_Protoca,
| BO3 SDPD_Results_Group SDPD_identfler_Protoca,
felic) SDPD_Results_Group SDPD_Identifier_Protoco,
o3 SDPD_Results_Group SDPD_ldentfler_Protoce,,
E03 SDPD_Restlts_Group SDPD_Identfier_Protoco,

FO3 SDPD_Results_Group SDPD_ldentfier_Protoce,| SDPD_Results_Group SDPD_ldentfier_Protoce,

G03 SDPD_Resuits_Group | SDPD_identiier_Protoco,

HOE SDPD_Resuits_Group SDPD_Identfier_Protoco, ~

& I
b | el | [ cancat
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In the Sample Type column, the Size Standard column, the Panel column, and the Analysis
Methods column, select the appropriate selection from the drop-down list for the kit being
used. Scroll across to the Results Group 1 column, select SDPD_Results_Group from
the drop-down list which is the same regardless of kit type. In the Instrument Protocol 1
column, select the appropriate protocol from the drop-down list. Note: The
SDPD_Identifiler_Protocol will be the standard protocol used for most kits and is set
with a 5 second injection (see the Table below for the appropriate selections for each kit).
For all columns with the exception of Sample Type, fill down to select for all samples.

See below for details on altered injection times and re-injections.

Kit Analysis Method Panel Size Standard Protocol

ID Plus ID-X Identifiler Identifiler_Plus_Panels_v1X CE_G5_IdentifilernPlus_GS500  SDPD_lIdentifiler_Protocol
Plus _

Minifiler ID-X Minifiler Minifiler_GS500_v1X CE_G5_HID_GS500 SDPD_Identifiler_Protocol

Yfiler ID-X Yfiler Yfiler_viX CE_GSNSIOO‘ SDPD_Identifiler_Protocol

-

ID Direct ID-X Identifiler IdentifilerDirect_GS500_v1X  CE_G5_ldentifilerDirect_GS500 SDPD_ldentifiler_Protocol

Direct

Click OK to save your changes and close the plate editor.

Important: For amplification blanks and reagent blanks the injection time used should be equal to the

greatest injection time from any of the evidence samples associated with it.

After clicking OK within the plate editor, the completed plate record is stored in the Plate Manager

database. Once in the Plate manager database; the'plate record can be searched for, edited, exported, or

deleted.

4. If you want to inject a sample more than once within a run:

a. Select Edit> Add Sample Run. Additional Results Group and Instrument Protocol
columns-are added to the right on the Plate Record.

b. Complete the Results Group and Instrument Protocol columns for the additional
injections:~Note: If samples are slated to be injected more than once, subsequent
injections of these samples will occur immediately after the first injection. Click OK to
save your changes and close the Plate Record.
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In the navigation pane of the Data Collection software click GA Instruments > ga3130 >
SDPD3130A > Run Scheduler. Click Find All or locate your plate record using the Search

button B Founation Data Collection Version 3.0
° Pl Yen ServieTeck Wamds el
q
— ¥
Link
——

Miherusd Corted

- Mo User is logged in

Pt Pistess Misiching Thasss Crberia
Typeof Search  Barcede

Scan or Typt Piatn ©

v
IMvaidaton_2
l}(umulun_‘;
‘widatbun_4
5_1_08

GeneMapper
GeneMapper

S tevice Log
ISpecrans 106
CuneMapper PrucEERe " I
speeiralDSEd Spectnl Callestion  processsd 96
. |
Locate your plate record in £
this window. F =
i)
’
_ V| v Al
|
T, 1
Systen st} | System Stntus ke %‘m“

B

[ Apend Rewts:

6. Link the plate record to the 3130 by highlighting your pending plate record, then double-clicking on
the yellow plate (B:). A “B” will appear to the left of the linked plate record and the plate will turn

green .

FIoNew  Service Tools

B Foundation Data Colle

Wizards Help

EEIRun Histary

= CPSOPDIA 04

= [Enstrument Status
EHEPT Chart
ElevertLog

Find Platz = Metching These Criteria

Tyt Y

Sgan or Type Plate D

4
M G& Instruments > ga3130 = SDPDF1E0A. = Run Scheduler

[ Append Resutts

B Spatial Run Schesuler Link | Plate Name Application Status Size
i \ 3130 _Validation_2 GeneMapper processed 96
ECapmar\es V\.ewer 3120_Validation_3 GeneMapper processed 98
Caplirray Viewer 3130 Validation_4 GeneMapper processed 86
Shectral Viswer
Y tanual Cartrol gtralRunG_2_06 Spectral Calibration  pending
B service Log [F] Trai a 5 al Calibration  pending 96
TrainingNgeciralSpecrtaldd 1106 Spectral Calibration  pending a6 B
.= Genemapper pracessed 86
speciralDS33 Spectral Calibration  processed 98
—
<«
< ¥
\
Systern Status@ | Traming_Spectral s cireaty inked \ [ Mo Current Run

N
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7. Once the plate is linked, the run can be started by clicking the green arrow P> . If desired, the oven can
be preheated in GA Instruments > ga3130 > SDPD3130A > Manual Control prior to starting
the run. To turn the oven on you must first send the command to turn the oven on followed by
sending the command to heat the oven to 60°C.

8. After the run is complete and you determine that re-injections are necessary you may do the following
to start those re-injections.

a. Locate you plate record in the plate record manager (GA Instruments > ga3130 >
Plate Manager) and click Edit.

b. Select Edit > Add Sample Run. Additional Results Group, Instrument Protocol
columns are added to the right on the plate record.

c. Complete the Results Group and Instrument Protocol columns for the additional
injections. Note: If altered injection times are desired instrument protocols have been
created for additional injection times. These can be selected fromethe drop-down menu. If
an injection time other than those available is required, a new Protocol will have to be
created. Click OK to save your changes, and then close the plate record.

d.  Complete steps 5 and 6 to initiate the re-injection rin,

9. When the run is complete:

¢ Rename the Run Folder uniquely and move it into the individual Analyst’s Folder on the FB
network [H:3130-310 Run Folders\ Analyst folder)] prior to any analysis.

REFERENCES:

ABI PRISM" 3130 Genetic Analyzer User’s Manual

ABI PRISM" 3130 Genetic Analyzer Getting Started Guide
ABI PRISM" 3130 Genetic Analyzer User’s Bulletin
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Method: Performing a Spectral Calibration on the Applied Biosystems 3130 Genetic
Analyzer

Date: 06/01/2006 Revision Date: 03/01/2010 Approved by: SAM

INTRODUCTION:

A spectral calibration creates a “matrix” that is used during a run to spectrally separate the raw data from
the instrument into the 5-dye components saved to the sample files. (Note: on the 3130, the spectralis
applied to the raw data in real-time whereas on the 310s the matrix is applied upon analysis).. A spectral

calibration should be performed:

e Ifadecrease in spectral separation (pull-up and/or pull-down) is observed

e After the laser or CCD camera has been realigned or replaced bya service engineer

REAGENTS:
1. HIDI Formamide: Applied Biosystems (P/N 4311320)

Dispense the formamide into 500ul aliquots and store frozen. The frozen formamide can be used

up to 1 year after being aliquoted.

Caution: Formamide is a known teratogen and is harmful by inhalation, skin contact, and
ingestion. Use in a fume hood and wear chemical resistant gloves and safety glasses when handling.

2. DS-33 Matrix Standards (Dye Set G5): Applied Biosystems (P/N 4345833)
Store at 2 to 8°C, protected from light. Stable for one year.

(This is the matrix standard set used when analyzing amplified DNA fragments generated using the
Indentifiler kit; and labeled with 6FAM-, VIC-, NED-, PET-, and LIZ-)

MATERIALS:

1. 96-Well Optical Reaction Plates: Applied Biosystems (P/N 4306737)

2. Plate Septa for 96-well: Applied Biosystems (P/N 4315933)

3. MicroAmp Splash free Support Base PE Applied Biosystems (P/N 4312063)
4. 96-well cooling block: Stored in the reagent freezer

PROCEDURE:

Preparing the Spectral Calibration Chemistry
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1. Remove DS-33 Matrix Standard tube from the refrigerator, vortex to mix, then spin briefly in a

microcentrifuge.

2. Fora 36cm array, combine 5-7ul of standard with 193-195uL formamide (for a total volume of 200uL)
in a 1.5mL microfuge tube. Vortex to mix, then spin briefly in a microcentrifuge.

3. Aliquot 10uL of standard/formamide mix into 4 wells (sugg: A1-D1) of a 96-well optical reaction
plate.

4. Place a 96-well septa mat onto the reaction plate, and place the reaction plate in the 9700 thermal

cycler.

5. Denature the samples by running the spectraldenature protocol. Important: Do not clamp down
the cover plate of the thermal cycler on the septa covered reaction plateas it will melt. Simply slide the
cover plate forward to cover the reaction plate without clamping it down.

6. After the denaturation protocol is finished, chill the reaction plate immediately in the 96-well cooling
block (-20°C) for two minutes.

7. Place the reaction plate into a 3130 base plate (it will only fit in one orientation) and secure a plate
retainer on top of the reaction plate. Check to ensure that the retainer clip is properly seated.

8. Press the Tray button on the exterior of the 3130.Genetic Analyzer. When the tray presents itself,
open the doors of the instrument and place the)tray onto the right side position of the autosampler (the
tray will fit on the autosampler in one orientation only). Close the instrument doors.

Performing a Spectral Calibration

1. In the navigation pane of the Data Collection software, click: GA Instruments>ga3130>Plate
Manager.

2. Click New. The New Plate Dialog box opens. Enter the details shown below (add the appropriate
date to the name):
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!ﬂ Mew Plate Dialog, @

MName: | SpectralRuns_2_06 |

Descrigtion:

Applicstior:  [Spectral Calibration v|

Plate Type: |96l 5

Cravner hiame: | SDRD |

Operator Name: | SDF‘Dl |

4. The Spectral Calibration Plate Editor dialog box opens.

® In the Sample Name column of A0Q1, enter sample name (e.g. G5MatrixStd)

® Click on the Comment cell. The value 100 automatically displays in the Priority column

¢ In the Instrument Protocol 1 column, select the spectral instrument protocol G5Spectral

from the drop-down menu

e Highlight the entire row and select Edit > Fill Down Special. The software automatically

fills in the appropriate well numbers«(i.c. A1-D1)

@ Spectral Calibration Plate Editor @

File Edit
Plate Name: | | operator: |
Plate Szaling; [-=0n | owner o0 ]
el Satiple Mate | Cotarmert Priority Instrumert Pratocol 1
AD1 | DEccMatig ] 00 | Gspectal -
BOT | DeccMati=g,| W00 | Gespectal
Q01 | DSeeMati | 00| Gespectal
oot DE5SMatrixs: | 100 Gespectral
E01
Fo
(=T —
Hol [
Az
Boz ||
a2 ||
o2 ||
B0z ||
Foz ||
oz [ |
W2 [
mz
s ||
cos [ |
s ||
g ||
Fos |
Gs |
wos || 3
Description | [ Cancel
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Click OK.

5. In the navigation pane of the Data Collection software, click:

GA Instruments > ga3130 > SDPD3130A > Run Scheduler > Plate View.

6.  Search for your plate record. Select Barcode in the Type of Search drop-down list and type in the
plate name then click Search. The plate record will appear in the lower box. Alternatively, you can
select Find All and all previous plate records will appear. (You can also perform an Advanced
search for the plate record. See page 41 of the Applied Biosystems 3130/3130x] Genetic Analyzers
Getting Started Guide.)

7. Highlight the desired plate record and then click on the plate position indicator to the right to link the
plate. The plate map color will change from yellow to green when it is successfully linked and a “b”
will appear beside the linked plate record.

! Foundation Data Collection Yersion 3.0 - Mo User is lopged in
_» _I ] -He.l - £
'_’-ra::':::m N it ik » 3130 » SOPE31308 » m—u—;m-\nm— A
) ;Ejll‘:-h--v" Type of Search  Darcode v .y
By rtocs Manager
Th Mok ie Marager Sean or Type Plats D
2 Duevri A
. ﬁ;‘b’:w"“f;“::“ Search Fird A1 ] Append Fnsmas
= IR Seheduer y i -
-r.::.!v"
BB cngmaries iewer
[
[l Soectral Viewer
Fmarussl Cortrod
Elsrrder Log J
ing_SpeetralSpecdalDal 106 Ep. B
sosatloss I
S ’ -
NI
O]
i
i i
i
i
sl
| . —
. »
2 2 00 ha: 1

8.  In the toolbar of the Data Collection software window, click # to begin the run.

9. The Processing Plates dialog box opens. Click OK. The Spectral Calibration run time is
approximately 35 min.

10. After the run, the pass or fail status of each capillary is recorded in the Event Log section of the
Instrument Status window:

® Click GA Instruments > ga3130 > SDPD3130A > Instrument Status > Event
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Log.
¢ Event Messages will indicate whether or not each capillary was successfully calibrated.

® Each capillary should have a Q-value above 0.95 and a Condition Number in the range
7to 12.

Evaluating the Spectral Calibration Data

Note: the spectral calibration of each capillary should be evaluated even if the Spectral Calibration Results
box indicated that they passed. If the spectral calibration failed, see the Applied Biosystems3130/3130x1

Genetic Analyzers Maintenance, Troubleshooting and Reference Guide.

1. Click GA Instruments > ga3130 > SDPD3130A > Spectral Viewer.

I8 Foundation Data Collaction Varsion 3.0
Bl Yew SerdceToos Wiosrds bl
> EE B ® & |[ple|v|rlo| AR
= G2 Petrurents
R irecuts Grovs
K= Datnbase Marager
Elgsna
Elrue Mannger
BBy Frotoco Manager
Tl Wb Merrazer
o i rastory
= CHST0a1a0a
= Ewwstrument Soz
LEPT Chast
[Elrwent Log
1 sy Foun St
= WIRun Scheduer
WiFiste View

- Mo Usar fs logped in

: @A Instruments » ga31 30 » SDPD3130A » Speciral Viewer

T Marnasl Corlred
Easerace Loy
1000
Inliensity ves Bean Mumbir
Copillary Dista Tias War I8 17 2080 BET 9008
| A0
TR
(| e Sed G5 v
| Acthve Colention fnf Dy Sat G5
bz woed for Capliary 1. 1 Tue Mar 20 172050 PST 2005
Conation ¥
| | @ Ve 0S4 List o Calbrations for Drye Set G5
| Tue Mar 200 17:20:50 W51 2006 -
Crveniide Sgeclral
Rgnanme.
| HIZ
< ¥
| SvstemStatas P 06 ha: 1

2. Select G5:from the Dye Set drop-down list (if it is not already displayed).

3. In the plate diagram, dark green boxes should be present at A1-D1. The dark green boxes confirm
that the four capillaries passed the spectral calibration. Tan colored boxes in the plate diagram indicate

failed spectral calibration.

4. Select a well in the plate diagram. The dark green box will turn light green, and the spectral profile
and raw data corresponding to that well/capillary will be displayed. No spectral profile will be
displayed if the spectral calibration failed. Evaluate each well/capillary for the following:
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a. Verify that the order of the peaks in the spectral profile from left to right are: Blue-
Green-Yellow-Red-Orange [In the top window]

b. Verify that the order of the peaks in the raw data from left to right are: Orange-Red-
Yellow-Green-Blue [In the bottom window]

5. Verify that the peaks in the spectral profile are sufficiently robust (>750rfu) and do not contain gross
overlaps, dips or other irregularities

6. The spectral run name will default to the day, date and time of the run. The name may be changed by
clicking Rename.

Activating the Spectral Calibration

Note: arun cannot start unless a calibration file that matches the dye set and capillary array length to be

used for the run is active.

1. In the navigation pane of the Data Collection software, click: GA Instruments > ga3130 >
SDPD3130A > Spectral Viewer.

2. Select G5 from the Dye Set drop-down menu.

3. Select a spectral calibration from the List of Calibrations.

4.  Click Set.

Evaluating a Spectral

The manufacturer’s engineering specifications state that pull-up between 1-5% is within tolerable limits. In
general the average pull-up expected.is approximately 3% with some outliers being around 5%. If the
average pull-up observed is.in excess of 3%, a new spectral should be created. If the average pull-up
observed is consistently above 5%, even after attempts at new spectrals, it may indicate a problem with the
instrumentation and the DNA Technical Manager needs to be informed.

REFERENCES:

1. Applied Biosystems 3130/3130x] Genetic Analyzers Getting Started Guide.
2. Applied Biosystems DS-33 (Dye Set G5) Matrix Standard Kit product insert
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Method: Performing a Spatial Calibration on the Applied Biosystems 3130 Genetic
Analyzer

Date: 06/01/2006 Revision Date: 01/01/2007 Approved by: SAM

INTRODUCTION:

The 3130 Genetic Analyzer Data Collection software uses images collected during the spatial calibration to
establish a relationship between the signal emitted by each capillary and the position where the signal is
detected on the CCD camera. A spatial calibration should be performed when you:

® Install or replace a capillary array

® Temporarily remove the capillary array from the detection block

® Move the instrument
PROCEDURE:

Creating a Spatial Calibration file

1. In the navigation pane of the Data Collection software, click: GA Instruments > ga3130 >
SDPD3130A > Spatial Run Scheduler.

. Foundation Data Collection Yersion 3.0 - Mo User is logged in E@E

Fle View Service Tools Wizards Help
® B

2 AGA Instruments
Results Group ¥
= Database Manager
= Elgax130
[EPiate Manager
@ Protocol Manager
{JaModule Manager
# CERun History
= (CPSDPDE 304
# [Edinstrument Status
= ERun Scheduler
B Capillaries Viewer
BB capriray Viewsr
R spectral Viewet
™ anual Cantrol
[ service Log

GA Instruments = gad1 30 > SDPDI30A = Spatial Calloration Viewer

[u} 20 40 &0 80 100 120 140 160 180 200 220 240
Intensity vs Pixel M um ber

4 Capilary Postions Spatial Protocals
Capilary | Poslion (pixels) Lett spacing | Right spacing Protocol: [31303patialFil_1 v
23 0 15
z 114 15 15 e
3 123 18 16
4 145 16 o

System Status@ | Piate Training_Spectral has been unlinked from Say 1
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2. In the Spatial Protocol section, select one of the following:

e Protocol > 3130SpatialNoFill_1, if the capillary contains fresh polymer, otherwise select;
e Protocol > 3130SpatialFill_1

(Note: you do not need to fill the capillaries each time you perform a spatial calibration.)
3. Click Start.

The calibration run lasts approximately:

® 2 min. without filling the capillaries, or;

® 6 min. when filling the capillaries

(Note: the spatial profile window turns black when you start a spatial calibration.)

Evaluation the Spatial Calibration file

1. Evaluate the spatial calibration profile using the following criteria:

Peak Attribute Acceptable Criteria
Height Similar,; Tobust height for all peaks.
Orange crosses One orange cross marking the top of every peak. No

misplaced crosses.

Shape Single sharp peak for each capillary.

Small shoulders are acceptable.

Spacing The difference between adjacent positions is 13 to 16

pixels. Theoretical spacing between capillaries is 15.

120 140
Intensity ws Fixal M um ber
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2. Examine each row in the 4 Capillary Positions table and verify that the values in both the Left spacing
and Right spacing columns range between 13 and 16 pixels. The “+” sign denotes the top of each peak.
If a “+7is out of alignment, it may be manually moved as follows:

To move the cross:

Type a new value in the Positions (pixels) box for the capillary of interest.
Click outside of the box or press Enter.

4 Capillary Positions — B,

Capillary Position (pixels) Left spacing Right spacing
[ 35 0 16 |
_2. 114 15 16 .
3 129 15 1E
4 145 16 0

Accepting or Rejecting a Spatial Calibration

Based on the above criteria (Height, + position, shape, and spacing), if the calibration:

® Passed, click Accept to write the calibration data to the database and .ini file. This will
irrevocably replace the current spatial file.

® Failed, click Reject then see the Applied Biosystems 3130/ 3130x Genetic Analyzers Maintenance,
Troubleshooting and Reference Guide.

Spatial Protocols

| T E
, Protocch 31303patiafilt v

[ Accept ] ’ Reject ]

REFERENCES:

Applied Biosystems 3130/3130x] Genetic Analyzers Getting Started Guide.
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Method: Flushing and Filling the Water Trap on the Applied Biosystems 3130 Genetic
Analyzer

Date: 06/01/2006 Revision Date: 01/01/2007 Approved by: SAM

INTRODUCTION:

The PDP water trap at the top of the pump block should be flushed with distilled or deionized water once a
week to remove any diluted polymer and to clear air bubbles. The trap should be filled with water at all

times.

MATERIALS:
1. A 20mL syringe, preferably the all-plastic Luer lock syringe (Applied Biosystems P/N4324463) that
was supplied with the instrument.

(Note: syringes smaller than 20mL should not be used, as they may genérate excessive pressure within the
trap.)

2. Distilled or deionized water.
PROCEDURE:
1. Fill the syringe with nanopure water.

2. Attach the syringe to the forward—facing Laer fitting at the top of the pump block. Hold the fitting
with one hand while threading the syringe onto the fitting clockwise with the other hand.

3. Open the Luer fitting by grasping the body of the fitting and turning it and the attached syringe
approximately one-half turn counterclockwise.

4. Open the exit fitting at the top left side of the pump block by turning it approximately one-half turn
counterclockwise.

5. Hold an empty tube or beaker under the exit fitting to receive approximately 5mL of flushed water
waste. Flush the trap by pushing steadily on the syringe plunger.

(Note: do not use excessive force. Take approximately 30 seconds to flush 5mL.)
6.  Once flushing is complete, re-tighten Luer fittings and remove the syringe.
REFERENCES:

Applied Biosystems 3130/3130x] Genetic Analyzers Getting Started Guide.
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Method: GeneMapper ID-X™ Analysis of Data
Date: 06/01/2006 Revision Date: 05/01/2012 Approved by: SAM
INTRODUCTION:

GeneMapperTM ID software is an automated genotyping software package that combines the precision-sizing
capabilities of the GeneScan® Analysis software with the allele-calling power of Genotyper® software, but
includes additional features and enhancements. The software will genotype samples based on allelic bin
definitions stored within the Panel Manager. The AmpFISTR panels and bins are pre-installed in the Panel
Manger within the software. Custom SDPD Analysis Methods have also been created in the GeneMapper
Manager for use in analyzing raw data files for Identifiler Plus, Identifiler, Yfiler, and Minifiler amplifications,
respectively. An analysis method defines the analysis parameters to be used for the analysis of samples imported
into the Project Window. When the GeneMapperTM ID software is installed on any computer, the Panel, Bin
Set and Analysis Method have to be defined prior to the analysis of raw datafiles. See also the procedure for
importing panels and bins.

MATERIALS:
Applied Biosystems GeneMapperTM ID Software
PROCEDURE:

1. Open the GeneMapperTM ID-X software by clicking on the icon located on the computer’s desktop and
log-in. Using the drop-down menuselect your user ID as the User Name. The password is case
sensitive. Upon successful log-in‘the Project Window will open. The project window is the primary
window for the user interface:

2. To add samples to the Project Window. Select File>Add Samples to Project.
For samples run on the 3130:
¢ Navigate toForensic Biology on FB server H:\3130-310 Run Folders to locate the desired run
folder.
e Select the desired run folder and click Add To List. The selected folder will appear in the
Samples To Add box on the right. Note: Multiple run folders can be added to the same project.
Click Add to import the files into the project and close the dialog box.

3. For each sample within the Project Window select the appropriate Sample Type, Analysis
Method, Panel, Size Standard (see below). Unknowns should be designated Sample, Allelic
Ladders should be designated Allelic Ladder, the positive PCR control should be designated as Positive
Control, and any reagent blanks, amplification blanks, or formamide blanks should be designated as
Negative Controls.
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Kit Analysis Method Panel Size Standard Protocol

ID Plus ID-X Identifiler Identifiler_Plus_Panels_v1X CE_G5_ldentifiler_Plus_GS500  SDPD_lIdentifiler_Protocol

Minifiler réui Minifiler Minifiler_GS500_v1X CE_G5_HID_GS500 SDPD_lIdentifiler_Protocol

Yfiler ID-X Yfiler Yfiler_v1X CE_G5_HID_GS500 SDPD_Identifiler_Protocol

ID Direct ID-X Identifiler IdentifilerDirect_GS500_v1X  CE_G5_IdentifilerDirect_GS500 SDPD_Identifiler_Protocol
Direct

Note: In general, analysis parameters will not change with the exception of the analysis range which will be

dependent on the electrophoresis of each run.

4.

Click » (Analyze), and the Save project dialog box opens. Save the project with a uniquely identifying
name [e.g. initials(Case #)]. After analysis, the project is automatically sayed, and the Genotypes Tab
becomes available. Analyzing the data sizes and genotypes the samples in the project. There must be at

least one ladder in each run folder analyzed for the analysis to be successful.

Accurate application of the size standard to the samples can be verified in a variety of ways. Using the
Process Component Quality Values (PQVs) such as the Sizing Quality flag is an efficient method of
verifying the sizing of individual samples. In the Samples tab of the Project Window the sizing quality
of each sample is displayed as a symbol (@ =Pass, © = Check sizing for problems, or ® = Low
Quality, sizing failed). Alternatively, individual or multiple samples can be selected in the project
window and the Size Match Editor used to/view the size standard for each sample. It is possible to
overwrite the Sizing Quality PQV in this windew for individual samples. This could be done, for
example, if the 450bp size standard peak was not detected for a particular sample, but it was
determined that the absence of this standard.would not affect the sizing of any peaks within the sample.

The migration of the sampleswithin the run can also be verified in a number of ways. For Identifiler,
Minifiler, and Yfiler, one method isto select all the samples within the Project Window and then
select Display Plots. From the plot settings drop-down menu, select Overlay Liz. Using the
cursor, zoom in on the 250bp peak in the plot window, and select all the 250bp peaks by clicking
within them. Select View>Table Filter>Show Selected Rows (or press CTRL+S). The 250bp
peak should size consistently and overlap. The difference in the migration of this fragment should be
<lbp.across the entire run. Note: If it is >1bp the project may require some troubleshooting to obtain
reliable genotyping of the samples. Close the sample plot.

The individual sample files can be reviewed and printed for the analytical record. If needed, labels can
be edited within the samples. To edit labels, select the labeled peak to be edited. With the desired
peak highlighted, right-click and select the applicable option of changing or deleting the label. An Edit
Allele Comment dialog box will open and a reason for the change can be input. Sample plots with
edited labels should be printed for the analytical record with the edit displayed in the plot and with the
Allele Edit Comment displayed in the Table.
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PQVs can be used to assess the quality of a variety of aspects of each sample.  Below is a list of some of
the PQVs that can be used to assist in the analysis of the sample data:

OS = Off-Scale data. If off-scale data is present in the sample, * is automatically displayed
within the size standard region of the signal. Otherwise a ® is displayed

SQ = Sizing Quality. The sizing quality is calculated based on the similarity of the size standard
fragment pattern and the actual size standard peak distribution pattern in the sample.

AE = Allele Edit. This box will be checked when the marker allele calls have been edited.

ADO= Allele Display Overflow. This box is checked when the number of alleles at any locus
exceeds the number that can be displayed (this number is selected by the user.

AN = Allele Number. is automatically displayed when the number of alleles at any locus is
greater than the user defined expected allele number. Note: Currently set to 4'in the
SDPD Analysis Method.

Bin=  Out of Bin Allele. is automatically displayed when the apex‘of a called peak is outside
the boundary of a bin.

PHR = Peak Height Ratio. is automatically displayed when there aretwo alleles present at any
locus and the ratio between the lower allele height and the higher allele height is below the
user defined threshold. Note: Currently setto 0.6 in"the SDPD Analysis Method.

LPH = Low Peak Height. is automatically displayed when alleles are lower than the specified
values and do not result in the proper intensity. Note: Currently set to 200rfu for
homozygotes and 75rfu for heterozygotes in the SDPD Analysis Method.

SPU = Spectral Pull-up. is automatically displayed when any locus displays pull-up. Pull-up is
defined by the system to be when the height of a labeled peak is less than 5% of any larger
peak within +/- 1 data point.

BP = Broad Peak. © is automatically displayed when the peak width of a labeled peak is wider

than 1.5bp.

SP = Split Peak. is automatically displayed when the GeneMapperTM ID software detects a
split peak.

CC = Control Concordance. is automatically displayed when the result for any positive
control sample does'not match the defined alleles for any locus. is also automatically

displayed when peaks are detected in negative controls.

GQ = Genotype Quality. Is an overall assessment of the quality of an individual locus based on a
mathematical formula using the previously mentioned PQVs as variables. The user can
define the weights applied to the above PQVs in this formula in the Analysis Method.

Note: Other PQVs exist but not all are applicable to human identification testing. For more information

please see the GeneMapperTM ID software user’s guide.

9.

When the analysis of the GeneMapperID project is completed the project file should be exported to the
appropriate folder on the Forensic Biology network. To export the project: highlight the project in the
Projects tab in GeneMapper Manager and click the Export button. Browse for the appropriate
folder on the network (Forensic Biology on FB server (H:)>GeneMapper ID
Projects>Analysts folder) and save the exported project using the Project name. Use of analysts
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initials at the start of the file name will be useful in locating projects as the number of files increases and
is highly recommended [e.g. inits(XX-XXXXXX;etc)] .

10. The original project should be deleted from the GeneMapperID database once the project is exported.
To delete the original project: highlight the project in the Projects tab in GeneMapper Manager
and click the Delete button. Prior to deleting the project it is recommended to check that the file was
exported to the appropriate folder.

11. To view exported GeneMapperID projects. Open GeneMapper Manager and from the Projects
tab click Import. Browse to Forensic Biology on FB server (H:) > GeneMapper ID Projects
and select the desired project. Click OK. The project will have been imported to the GeneMapperID
database and can be opened as usual. When the imported project is no longer needed it should be
deleted from the database (see step 10.).

REFERENCES:

AmpFISTR Identifiler Plus"™ PCR Amplification Kit User’s Manual
AmpFISTR Identifiler Direct'™ PCR Amplification Kit User’s Manual
AmpFISTR Yfiler™ PCR Amplification Kit User’s Manual
AmpFISTR Minifiler ™ PCR Amplification Kit User’s Manual
PowerPlex®Y Amplification Kit User’s Manual

GeneMapperTM ID Software version 3.1 User Manual.
GeneMapperTM ID Software Tutorial.
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Method: AmpFISTR Identifiler Plus Interpretation Thresholds

Date: 04/01/2011 Approved by: SAM

® A peak detection threshold of 50rfu will be used for analysis of AmpFISTR Identifiler Plus data. Peaks
below 50rfu are not reported, but can be used qualitatively to determine the possible presence of a
mixture.

® Homozygous allele peaks are often approximately twice the height of heterozygous allele peaks as a
direct result of allele dosage.

® At heterozygous loci, the ratio of the height of the shorter peak to the height of the higher peak is
generally above 60% (see Table below), however, peak height ratios tend towards larger/imbalances as
the height of the tallest peak decreases toward the stochastic threshold.

Max. Min. Avg.

PH Ratio Ratio

0-100 33.33 71.94

100-200 22.16 66.97

200-300 21.29 68.89
300-400 21.50 73.93 20.11

83.61

87.15

88.25

89.35

86.52

86.91

88.10

400-500 49.21
500-600 52.88
600-700 57.72
700-800 62.91
800-900 48.30
900-1000 66.73

1000+ 63.32

® n-4bp stutter peakswill be filtered by the software when they are below the percent cutoff value for a
locus. The stutter cutoff values used by the software are presented below:

Marker Stutter Cut-off Value
D8S1179 10.32%
D21S11 10.67%
D7S820 9.69%
CSF1PO 9.2%
D3S1358 12.27%

THO1 4.08%
D13S317 9.93%
D16S539 10.39%
D2S1338 12.44%
D195433 11.21%

vWA 12.45%

TPOX 6.38%

D18S51 13.68%
D5S818 10.06%

FGA 13.03%
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® N-+4 Stutter does occur more frequently than in past AB kits due to the different reaction mix formulation. On
average, nt4 stutter products are less than 2% of the parent peak, however n+4 stutter peaks as high as 3% have
been observed at several loci.

e Validation efforts have established the stochastic thresholds (or homozygote peak height threshold)
above which both alleles of a heterozygote pair will most likely be detected. When evaluating an
evidence profile, care should be taken when interpreting DNA peaks less than the designated rfu values

as allelic drop-out may have occurred.

<5 second injection 200rfu
7 second injection 280rfu
10 second injection 400rfu

Probability of Identity using the Applied Biosystems Identifiler Plus kit.

The Probability of Identity (P)) [Sensabaugh 1982] is the probability that two individuals selected at random
will have an identical Identifiler kit genotype. For the Identifiler kit the P, are as follows:

1 in 200 quadrillion in the U.S. Caucasian population,
1 in 760 quadrillion in the African American population,
1 in 130 quadrillion in the Hispanic population.

The P, expresses the average 15 locus DNA profile frequencies using the Applied Biosystems Identifiler kit.
This data was taken from the Identifiler user’s manual page 4-55.

REFERENCES:
SDPD Identifiler Validation studies
AmpFlSTR® Identifiler™ Plus User’s Manual
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Method: AmpFISTR Minifiler Interpretation Thresholds

Date: 07/25/2007 Revision Date: 08/14/2009 Approved by:

SAM

A peak detection threshold of 75rfu will be used for AmpFISTR Minifiler data. Peaks below 75rfu are
not reported.

Homozygous allele peaks are often approximately twice the height of heterozygous allele peaks as a
direct result of allele dosage.

At heterozygous loci, the ratio of the height of the shorter peak to the height of the higher peak is
generally above 78% (see Peak Height Ratio validation study). Occasionally, however, heterozygous
allele peak pairs have been observed with an imbalance as low as 35%.

n-4bp stutter peaks will be filtered by the software when they are below:the'percent cutoff value for a
locus. The stutter cutoff values used by the software are presented below:

Marker Stutter Cut-off Value
D13S317 14.0%
D7S820 11.0%
D2S1338 18.0%
D21S11 16.0%
D16S539 15.0%
D18S51 18.0%
CSF1PO 14.0%

FGA 15.0%

Apparent Single Source Samples

An apparent single souree profile consists of no more than two relatively balanced alleles at each locus.
(Single source samples-with three allele peaks at a single locus have been reported, though are

extremely rare.)

Allelic dropout is a phenomenon observed commonly when amplifying low levels of DNA, and is
defined as having only one allele of a heterozygote pair (or possibly no alleles) detected above the peak
detection threshold at a given locus. Our validation efforts determined that both alleles of a
heterozygote pair will be detected when one of the alleles reaches at least 450rfu (>99% of the time,
however allelic drop-out was observed when the larger peak was approximately 680rfu). When
evaluating an apparent single source evidence profile, care should be taken when interpreting a single
DNA peak below 450rfu as allelic drop-out may have occurred. As a conservative measure of
interpreting inclusions, when single allele peaks are detected below 450rfu at any locus, that locus
(those loci) will be excluded from the calculation. In an apparent single source sample, when two
alleles are present at a locus below 450rfu, those alleles may be used in a statistical calculation, as allelic
drop—out is not a concern.
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Mixtures

A mixed DNA profile will have more than two alleles present at a locus, and/or a significant imbalance
in peak height between peaks at a locus. Generally, evidence of a mixed DNA sample exists at multiple

loci.

In most cases involving DNA mixtures in which biological fluids have been identified, caution is
warranted in attributing a particular biological fluid to one of the DNA contributors in the mixture, as
either source could be the origin of that body fluid in question (sperm fractions involving male:female
mixtures may be an exception). Instead, the presence of the body fluid will be noted in the.report and
a statement given as to whether the subject is included or excluded as one of the potential sources.of the
DNA mixture.

Please refer to the “Interpreting DNA Mixtures” protocol for additional information with regards to
mixtures. In general, due to the increased imbalance observed in single source'samples.with the
Minifiler kit, analysts should use a more conservative approach when interpreting mixed DNA samples
generated with the Minifiler amplification kit.

Probabﬂity of Identity using the Applied Biosystems Minifiler kit.

The Probability of Identity (P)) [Sensabaugh 1982] is the probability thattwo individuals selected at random
will have an identical Identifiler kit genotype. For the Identifiler kit the P, are as follows:

1 in 12 billion in the U.S. Caucasian population,
1 in 15 billion in the African American population,
1 in 4.8 billion in the Hispanic population.

The P, expresses the average 8 locus DNA profile frequencies using the Applied Biosystems Minifiler kit.

This data was taken from the Identifiler user’s manual page 5-46.

REFERENCES:
SDPD Minifiler Validation studies
AmpFlSTR® Minifiler™ User’s Manual
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Method: AmpFISTR Yfiler Interpretation Guidelines

Date: 07/25/2007 Approved by: SAM

® A peak detection threshold of 100rfu will be used for AmpFISTR Yfiler amplification kit. Peaks below
100rfu are not reported.

® n+t3bp stutter products have been observed in the DYS392 locus and n-2/n+2bp stutter at DYS19 in
the AmpFISTR Yfiler system. The GeneMapperID software product does not currently have the
capacity to filter such stutter products, but data for these artifacts is contained within the validation

studies. The stutter cutoff values used by the software are presented below:

Marker Stutter Cut-off Value
DYS456 13.21%
DYS3891 11.79%
DYS390 10.4%
DYS38911 13.85%
DYS458 12.2%

DYS19 11.4%
DYS385 13.9%
DYS393 12.58%
DYS391 11.62%
DYS439 11.18%
DYS635 10.75%
o 54 v 16.22%

(note n-3 stutter position)

Y GATA H4 11.08%
DYS437 8.59%
DYS438 N 4.28%

(note n;5'stutter position)
DYS448 N 4.96%
(note n-6 stutter position)

Apparent single source profiles

® An apparent single source Y-STR DNA profile (or haplotype) consists usually of one allele at each Y-
STR locus, except for DYS385 where gene duplication results in two alleles. (Note: single source
samples with additional allele peaks have been reported.)

® InaY-STR DNA profile that consists of peaks heights 100rfu or above, the results at all loci will be
used to determine the frequency of that haplotype in a given database (see Y-STR Haplotype Frequency
Calculations).
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Mixed DNA profiles

® Mixed Y-STR DNA profiles are apparent when more than one allele is present at some or all of the loci

(in a male DNA mixture, more alleles may be expected at DYS385 than at other loci). Generally,
evidence of a mixed DNA sample exists at multiple loci.

e Ifasignificant difference in allele peak height exists in a male DNA mixture, a predominant Y-STR
DNA profile may be deduced. Under these circumstances, allele peaks from secondary donor(s) may
be reported as “weak” alleles. Weak is to be used when the height difference is less than 1/3. The
frequency of the predominant haplotype in a given database may be determined using the rules for
apparent single source profiles, above.

REFERENCES:
SDPD Yfiler Validation studies
AmpFlSTR® Yfiler™ User’s Manual
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Method: AmpFlSTR® Identifiler Direct® Interpretation Thresholds

Date: 04/01/2012 Approved by: SAM

® A peak detection threshold of 50rfu will be used for analysis of AmpFlSTR® Identifiler Direct” data.
Peaks below 50rfu are not reported.

® Homozygous allele peaks are often approximately twice the height of heterozygous allele peaks as a
direct result of allele dosage.

® At heterozygous loci, the ratio of the height of the shorter peak to the height of the higher peak is
generally above 70% (see Peak Height validation study), however, peak height ratios tend towards
larger imbalances as the height of the tallest peak decreases toward the stochastic threshold.

e A global filter of 20.00% will be applied to data as opposed to marker specific stutter percentages.

e Validation efforts have established the stochastic thresholds (or homozygote peak height threshold)
above which both alleles of a heterozygote pair will most likely be detected.

<5 second injection 150rfu
7 second injection 210rfu
10 second injection 300rfu

Probability of Identity using the Applied Biosystems Identifiler Direct” kit.

The Probability of Identity (P)) [Sensabaugh 1982] is the probability that two individuals selected at random
will have an identical Identifiler Direct” kit genotype. For the Identifiler Kit" kit the P, are as follows:

1'in 200 quadrillion in the U.S. Caucasian population,
1'in 760 quadrillion in the African American population,

1 in 130 quadrillion in the Hispanic population.

The P, expresses the average 15 locus DNA profile frequencies using the Applied Biosystems Identifiler

Direct”® kit.~This data was taken from the Identifiler Direct® user’s manual page 105.

REFERENCES:
SDPD Identifiler Direct Validation studies
AmpFlSTR® Identifiler Direct® User’s Manual
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METHOD: Autosomal STR Interpretation Guidelines (Summary Document)
Date: 06/01/2004 Revision Date: 11/01/2011 Approved by: SAM
Introduction

The Scientific Working Group on DNA Analysis Methods (SWGDAM) states that:

“The interpretation of DNA typing results for human identification purposes requires professional
judgment and expertise. Additionally, laboratories that analyze DNA samples for forensic casework
purposes are required by the Quality Assurance Standards for Forensic DNA Testing Laboratories
(effective July 1, 2009) to establish and follow documented procedures for the interpretation of DNA
typing results and reporting. Due to the multiplicity of forensic sample types and the potential
complexity of DNA typing results, it is impractical and infeasible to coyer every aspect of DNA
interpretation by a preset rule. However, the laboratory should utilize written procedures for
interpretation of analytical results with the understanding that specificity in the standard operating
protocols will enable greater consistency and accuracy among analysts within a laboratory. It is
recommended that standard operating procedures for the interpretation of DNA typing results be
sufficiently detailed that other forensic DNA analysts can review, understand in full, and assess the
laboratory’s policies and practices. The laboratory's interpretation guidelines should be based upon
validation studies, scientific literature, and experience.”

Here we present a number of general interpretation guidelines for interpreting samples in forensic DNA
casework. The rationale behind these guidelines is to establish a set of standards to ensure that conclusions
are supported by reliable data, derived using ascientific approach, and that interpretation of results is as
objective as possible and is consistentfrom one analyst to another.

The interpretation of DNA results should take into account the DNA results obtained, the nature of the
sample, the condition of the profile; any forensically valid assumptions made, and should be scientifically
justifiable and based on the collected experience and knowledge of the laboratory and the scientific
community. These guidelines are designed to provide a general foundation for interpretation.

Please refer to the complete Autosomal STR Interpretation Guidelines document if more information is
desired on any section within this summary document. See Appendix A for a glossary of terms.

DNA interpretation should take place in the following order:

Preliminary Evaluation of Data and Allele Designation (section 1)
Interpretation of DNA Typing Results (section 2)

Comparison of DNA Typing Results (section 3)

Statistical Analysis of DNA Typing Results (section 4)

Reporting of DNA Typing Results and Conclusions (section 5)
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Section 1 — Preliminary Evaluation of Data and Allele Designation

1.1

1.2

1.3

1.4

Detection of peaks

The detection of peaks in the data is performed by the GeneMapper ID-X software. The analytical
thresholds (peak detection thresholds) for the autosomal STR kits are listed within documents specific
to each individual kit.

Evaluation of internal standards

The internal size standard should be evaluated to ensure that for each sample it has produced the
expected pattern of peaks. These peaks should generally be between 1000 and 2000rfu for a 5
second injection and not show signs of poor resolution. If a sample has issues in the size standard that
prevent proper sizing, or has signs of poor resolution, the sample should be reinjected or reprepared.

For Identifiler Plus and Minifiler analysis, GS500 LIZ peaks from 75-450bp are required. If no DNA
peaks larger than 350bp are detected, it is possible to adjust the analysis range to 75-400bp.

Evaluation of allelic ladders

The GeneMapper ID-X software compares the ladder injections in the run with the expected sizes.
GeneMapper ID-X analysis of at least one of the injected allelic ladders must produce the known
allele peaks associated with the ladder in order for the software to type the other samples of the run.
If a ladder injection passes the evaluation:by the software, the ladder can be relied upon without

further manual evaluation or reinjection:
Designation of alleles

Allele assignments are made by comparing the base pair size of the peaks in the amplified samples
with the base pair size of thealleles within the allelic ladder(s). Allele assignments are performed
automatically by GeneMapper ID-X. Analysts may on occasion need to manually edit “off-ladder”
peaks to designate them as true alleles, or to redesignate peaks originally called as alleles by the
software as‘artifacts.

1.4.1 _Ifmultiple allelic peaks are improperly called as off-ladder alleles, it may be necessary
to only designate a subset of the allelic ladder injections as ladders, create separate projects
using only those samples and ladder combinations that eliminate off-ladder alleles, or reinject
samples and allelic ladders.

1.4.2  Occasionally an allele will be detected that is outside the ladder range for a given locus.
Alleles that fall above or below the ladder alleles (even those in virtual bins) will be
designated as greater than (>) or less than (<) the respective ladder allele.
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Occasionally an allele will fall outside the ladder range between two loci. An analyst
should consider the size of the apparent allele and the expected zygosity in an attempt to
determine to which locus the allele belongs. A list of variant alleles is maintained by NIST on
the STRBase website (www.cstl.nist.gov/strbase/var tab.htm). This list can be consulted

to assist in assist in determining to which locus the allele belongs. The allele will then be
renamed with the appropriate (>) or (<) allele designation for the appropriate locus.
Supporting documentation should be included in the administrative documents for the case.

Off ladder alleles that occur within the ladder ranges (i.e. microvariants that contain an
incomplete repeat motif) should be designated by the number of complete repeats and,
separated by a decimal point, the number of base pairs in the incomplete repeat (e.g. D21511
29.1 allele). Microvariants will be confirmed through a re-injection of the sample as a
means of demonstrating the reproducibility of the retention time and sizing of the peak. If a
microvariant is observed in multiple samples from the same case, re-injection for
confirmation purposes is unnecessary. Tri-allelic patterns should be confirmed through

reamplification.
1.5 Designation of artifacts

Some data contained within the electropherograms may not represent actual alleles that originate in

the sample. Non-allelic peaks such as stutter, non-template dependent nucleotide addition (minus-

A), nonspecific amplification products, spikes, raised baseline, pull-up, or disassociated primer dyes

should be identified prior to the comparisons of reference samples to the data. Generally, non-

allelic data such as stutter, non-template.dependent nucleotide addition, disassociated dye, and
incomplete spectral separation are reproducible; spikes and raised baseline are generally non-
reproducible.

1.5.1  Off —scale data is‘often the result of over-amplification and can cause several other
interpretationaldifficulties, such as: “minus-A” products, increased stutter, and pull-up (see
below). If off-scale data is present in a sample, the sample may be re-injected with a
decreased injection time, reamplified using less input DNA, or the amplified product may be
diluted for reinjection.

1.5.2_ Pull-up results from poor spectral separation and is characterized by signal from a peak in
one fluorescent dye color producing a smaller, artifactual peak in another, often adjacent,
dye color. Amplification of less sample, injection of a sample for less time, dilution of
amplified product, or running the samples after creating a new spectral for the instrument
can reduce pull-up peaks.

1.5.3  Minus-A (-A) is a form of PCR product that does not possess an extra nucleotide at the 3’
end. Over-amplification can result in prominent “minus-A” products. Re-amplifying using
less input DNA will likely reduce minus-A peaks. Incubating amplified products at 60°C for
an additional time period may also reduce minus A.
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1.5.4  Stutter peaks are minor peaks appearing one repeat unit smaller (e.g. n-4 in tetranucleotide
loci) or larger (n+4 in tetranucleotide loci) than a primary STR allele. If a called peak is
suspected to be stutter, the validation study should be consulted to determine the expected
stutter percentage for that allele. If the observed percentage is within the expected stutter
percentage range for that allele, but above the filter threshold, an analyst may determine the
peak to be stutter. For alleles that are at the larger base pair range of a locus, if the suspected
stutter peak is above the stutter filter, but based on the validation consistent with the
expected percentage of stutter for an allele of that size an analyst may determin¢ the peak to
be stutter. Additional factors such as spectral overlap or the presence of a potential stutter
peak between two true alleles may enhance stutter peaks above the expected values.
Ultimately, re-amplification can help determine if a peak is truly stutter or if it may be DNA
from a secondary source. Unfiltered stutter peaks that are more than two standard
deviations from the mean observed for an allele during the validation study will be listed in
the table of results if the sample is not reamplified or if the unfiltered stutter is determined to
be reproducible through re-amplification.

1.5.5 Spikes are artifacts of electrophoresis, which may resemble DNA peaks. Often spikes will be
narrower than true DNA peaks and will be filtered by the GeneMapper ID-X software.
Multi-color spikes can be identified by the presence of peaks occurring in several colors at the
same data point location. Single-color spikes can be identified by the presence of a sharp
peak occurring in a single color in the raw data, with no spectral overlap into the other
colors. Since spikes are generally random, reinjection of a sample should eliminate a
questioned spike.

1.6 Evaluation of analytical controls

If the analytical controls are properly designated, the GeneMapper ID-X software will flag controls
that fail to meet expectations. Controls that have passed GeneMapper ID-X verification can be relied
upon without further evaluation.

1.6.1 The reagent blank is a check for possible contamination of the sample preparation reagents by
extraneous DNA. If DNA types are detected in the reagent blank this is an indication of a
possible contamination event or that extraneous DNA was introduced into the sample from
some unintended source. Based on an evaluation of the DNA types in the reagent blank, the
results of associated samples may be deemed inconclusive. The analyst and the DNA Technical
Manager will confer on an appropriate action based on the particular circumstance.

Samples extracted in a batch where the reagent blank shows DNA types greater than the
interpretation threshold may need to be re-extracted. Not all contamination events will
necessitate reanalysis and will be judged on a case-by-case basis.
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In some cases, re-extraction of samples affected by a reagent blank containing detectable DNA
may not be possible. Results for these samples may be reported if any possible concerns
related to the reagent blank are adequately explained.

1.6.2 The negative amplification control (Amplification Blank, NAC, or No DNA Control) is a
check for possible contamination of samples during the amplification process. The appearance
of DNA types in this control indicates that problems similar to those described for the reagent
blank may have occurred during the amplification.

The interpretation of detectable DNA in the amplification blank should take into account the
results obtained from any samples and reagent blanks amplified in the same’batch. A batch
where both the amplification blank and the reagent blank give the same typing result, or where
only the amplification blank gives a result, may be caused by a problem limited to the
amplification process. In this case, re-amplification of the samples may resolve the problem. A
batch that shows a typing result for the reagent blank, but not for the amplification blank is
more likely to be caused by an extraction-related problem.

If the reagent blank and amplification blank give different typing results, both the extraction
and amplification processes are potentially suspect and should be repeated.

1.6.3 The positive amplification control (PAC) is a check for effectiveness of the amplification and
the Short Tandem Repeat (STR) analytical processes. This control should always show
interpretable results consistent with the known genotype published in the DNA kit literature.
No other interpretable peaks should be present. Peaks that are determined to be artifacts
(elevated stutter, pull-up, etc) are'not considered interpretable peaks.

Results from samplesiassociated with a positive amplification control for which these criteria are NOT
met must be jointly evaluated by the DNA analyst and the DNA Technical Manager (or his/her
designee). ‘Ona case-by-case basis, the DNA Technical Manager will evaluate the results obtained and
determine the appropriate interpretation, taking the observed control results into account. If the
observed control results bring the reliability of a sample result into question (as determined by the DNA
Technical Manager), the sample result will not be interpreted or reported. The evaluation of the
control results and the DNA Technical Manager’s approval (or his/her designee’s) of the process must
be documented in the analyst’s case notes and, in an Unexpected Results Summary (see FB policy
manualsection 1.6). If the results from samples associated with the failed positive control are deemed

usable, the failure of the positive control must be included in the final report.

If the cause of the positive amplification control cannot be determined, samples associated with the
failed positive amplification control should be reamplified. Samples associated with the failed positive
control that were consumed for the original amplification would require re-examination (re-extraction)
of the original evidence. If no evidence remains then the samples will be reported as inconclusive.

If the cause of the positive amplification control cannot be determined, the only time the

results from samples associated with a failed positive amplification control that were consumed
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for the original amplification will be reported is when they form the basis of an exclusion. In
this instance, troubleshooting of the problem must lead to the determination that the
amplification for that sample is reliable and full disclosure of the unexpected result (failed
positive amplification control) as well as the exclusion will be documented in the final report.

1.7 Evaluation of samples that have been reinjected, reamplified, and/or reextracted

1.7.1 Analysts should evaluate multiple data sets for an item amplified with the same autosomal
STR kit to determine if there are indications of differences in peak proportions between the
injections/amplifications for the sample. Analysts must indicate in the table of results if the
represented result is a composite of multiple amplifications/or injections (see section 5).

When generating a composite DNA profile, the analyst must use the highest RFU value of a
reproducible peak when determinations of contribution level are done. /f significant
differences exist between the data generated from reamplification of the same DNA extract the
analyst may choose to consider the data as separate results instead of generating a composite

profile.

1.7.2 Analsysts should evaluate data for an item amplified with multiple autosomal STR kits to
verify that no unexplainable discordances exist between loci common to the kits. Possible
reasons for discordances include; but are not limited to; degradation or inhibition affecting one
of the amplifications to a greater degree than the other, variation in primer sequence, stochastic
effects of low level samples, and the slight differences in peak proportions typically
encountered during multiple amplifications of mixed samples.

Section 2 — Interpretation of DNA Typing Results

In general, interpretation of DNA samples will be completed prior to comparison of reference samples. All
interpretation of samples will be performed using the actual electrophoresis data and not the table of
results. DNA interpretation will-include the following steps:

Determine whether a sample is a mixture (section 2.1)

Estimate the number of contributors to a sample (section 2.2)

Determine whether stochastic effects are likely (section 2.3)

Identify whether a sample is degraded and/or inhibited (section 2.4)

Determine contribution level in mixed DNA samples (section 2.5)

Document relevant assumptions (section 2.6)

Determine which loci and combinations of DNA types are useful for statistical support of
inclusions (section 2.7).

These steps will be documented in the analytical record on an interpretation worksheet prior to comparison
to reference samples.
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2.1 Determination of whether a sample is a mixture

A mixed DNA profile possesses certain common attributes that will tend to indicate the presence of

more than one contributor to the observed results. The attributes may include:

®  Greater than two alleles present at a locus, unattributable to a mutation or a tri-allelic pattern.
® Significant imbalance in peak height between peaks at a locus (peak height ratios <60%):.

® Generally, evidence of a mixed DNA sample exists at multiple loci.

To determine whether a mixed DNA profile exists, the DNA profile must be evaluated in its entirety.
If a DNA mixture exists, a conclusion to that fact should be stated in the Forensic Biology report, and
may be stated independently of the conclusion(s) surrounding potential individual contributors (see

section 5).
2.2 Estimation of the number of contributors to a sample

Conclusions with respect to the minimum number of contributors must be included in a report.
Generally, an estimate of the minimum number of contributors is based on the locus that exhibits the
greatest number of allelic peaks and the fact that each contributor would contribute at most two alleles
to the locus (although tri-allelic patterns could be present, but are extremely rare). Additional
information such as expected peak height ratios can be used to determine minimum number of
contributors. While the minimum number of contributors to a mixture can be established with a high
probability, an absolute determination of the number of contributors cannot be ascertained.
Assumptions as to the number of contributors can be made if the data appears consistent with a given

number of contributors (see section 2.6)
2.3 Determination of whether stochastic effects are likely

Our validation efforts.determined that for single source samples amplified with Identifiler Plus injected
for five seconds, both alleles of a heterozygote pair will be detected when one of the alleles reaches at
least 200 RFU (greater.than 99% of the time). With Minifiler, the stochastic threshold was determined
to be 450 RFU. Please refer to the Identifiler Plus Interpretation Thresholds document for the

stochastie thresholds for altered injection times.

The analyst should consider the possibility that one or more DNA types may have dropped out if data is
detected'below the stochastic threshold. DNA types below the stochastic threshold will be designated
with an asterisk (e.g. 16*) in the table of results (see section 5).

2.4 Determination of whether inhibition and/or degradation is present

2.4.1 Inhibition of the PCR process can be caused by a variety of substances and is generally
described as a reduction in efficiency of the PCR process. Examples of the effects of inhibition
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can be observed in the SDPD Inhibition presentation on the FB network in the presentations

folder.

Evaluation of the IPC in the Quantifiler assays can be helpful to determine whether inhibitors
may be present. Because a larger amount of DNA may be amplified than used for quantitation,
a sample with an IPC result within expectations may still show evidence of inhibition when

amplified.

Several options exist to reduce inhibition. Purifying the sample using the QIAGEN BioRobot
EZ1 reduces some inhibitors as compared to organic purification. Reducing the amount of
template DNA amplified can also reduce the amount of copurified inhibitors intreduced into
the PCR process. The Identifiler Plus and Minifiler kits have been optimized to reduce the
effects of PCR inhibitors and can be used to improve previous results from kits (Profiler Plus,
Cofiler, or Identifiler) more susceptible to inhibition.

DNA is generally stable if stored properly; however, degradation of DNA can occur over
time, through exposure to the elements, or through the/action of bacteria. Degradation can be
identified by a classic pattern in samples where rather robust results are obtained at the smaller
(base pair) loci while little to no results are.obtained at the larger (base pair) loci. The overall
results have been described as being in a ski slope pattern.

In general, inhibition will affect all contributors to a DNA mixture equally and could raise the
concern of actually detecting all alleles that should be present in the mixture. Degradation,
however, may not affect all contributors equally (differential degradation) and mixtures
containing degraded DNA can pose a challenge to the analyst attempting to interpret them.
Analysts are encouraged to exercisescaution when interpreting a mixture that is thought to
contain, or is known to contain, degraded DNA.

Amplification of single source samples with Minifiler may provide better results than Identifiler
or Identifiler Plus if degradation is suspected.

2.5 Determination of contribution levels in mixed DNA samples

Thedndividual peak heights of alleles within a mixture can provide information regarding the relative

contribution level (major/minor) to the overall mixture for people possessing those types. This

assessment begins by determining whether there appears to be multiple significant contributors (section

2.5.1). Once balance has been evaluated, the mechanism for identifying DNA types more likely from

minor DNA contributors can be determined. The determination of the appropriate method for

assigning DNA types likely from minor contributors is critical in the interpretation of complex

mixtures.

Validation studies conducted on 2-, 3-, and 4-person mixtures indicates that the partitioning model

presented below can be extremely helpful in the interpretation of complex mixtures. This model will

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 158 of 190




o

Unit Technical Manual

Forensic Biology

not apply to all mixtures and consideration should be taken in applying the partitioning model,
especially for complex mixtures outside the scope of the validation (i.e. mixtures of 5- or more
people). In mixtures known to contain at least 5— or more people, for instance, if the loci with the
most DNA types detected contain data indicating that any DNA type could pair with any other at the
marker (based on validated peak height ratio expectations), there may not be any contributors
contributing more DNA than another. Not applying the partitioning model would be the best approach
to interpreting mixtures in these instances.

The two methods for assigning minor DNA types in a mixture are by using 1/3 the tallest peakat a
marker or using a threshold of <10% the total rfu detected at a locus (these are explained further in
sections 2.5.1.1 and 2.5.1.2). Using a threshold of %4 the tallest peak at a marker will generally
provide a subset of DNA types that includes the genotype of the single strongest DNA contributor in a
mixture and is used when there is an indication that the mixture is imbalanced in contributions levels
between the contributors. Using the threshold of <10% the total rfu detected-a marker will provide
the subset of DNA types that include the genotypes for the two or three strongest contributors to the

mixture.

DNA types identified as more likely from minor DNA contributers will be designated by brackets (e.g.
[16]) in the table of results (see section 5).

In general, a major DNA contributor is an‘individual who appears to contribute a significant portion of
the DNA to a mixture. A DNA contributor should be contributing more DNA than at least one of the
other contributors to the mixture to be considered amajor contributor. Major contributors to a DNA
mixture do not possess DNA types that are-designated as minor alleles unless a significant amount of

stacking of alleles is likely.

In general, a minor DNA contributor is an individual who appears to contribute a small portion of the
DNA to a mixture. Minor contributors possess multiple DNA types that are designated as minor
alleles. If no alleles from minor contributors are identified in the mixed DNA sample then the mixture
should be considered unresolvable in terms of determining major and minor DNA contributors.

When a DNA profile presents as a mixture of three or more individuals with at least one major DNA
contributor, at'least one minor DNA contributor and a contributor at a level somewhere between the
majorand minor contributor(s), that contributor will be a mid-Ievel contributor or second
significant contributor. Additional terms such as “significant minor” may be used to further clarify
assumptions about the contribution levels in the mixture provided they are clearly defined in the case
notes (see'section 2.7.1.4 c¢). The interpretation of the presence of a significant second contributor to a
mixture should be based on a discernable difference in peak intensities between the second significant
contributor and any other minor alleles present in the mixture. Alleles designated as likely originating
from the significant second contributor should be documented in the analytical record.

2.5.1 In general, mixtures having multiple major contributors (a balanced mixture) in a mixed DNA
profile can be determined by examining the results using the following criteria:
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One locus with at least 5 alleles greater in height than V3 the tallest peak at that locus (five
including the tallest peak) and/or three loci with four alleles within 50% of the tallest allele
at those loci (four including the tallest peak).

If the above indicators are not met, but the overall information in the profile indicates that the
situation of at least two significant contributors is likely, analysts should adopt the <10% the
total rfu at a marker for the designation of minor contributor alleles. Some two person
mixtures may not have 3 loci with 4 DNA types and therefore peak proportions at the other
loci should be evaluated for indications of balance. Loci with two alleles that have close'to 1:1
or 3:1 ratio, or three alleles with some combination close to a 2:1:1 ratio i§ indicative of

balance between significant contributors.

Additional factors or phenomena such as inhibition or degradation within the sample may lead
an analyst to adopt a more conservative interpretation and statistical assessment of any potential
inclusions. Analysts should be able to articulate the basis for their interpretation, such as low
level mixtures that may have peaks below the detéction threshold that suggest balance in the
mixture.

2.5.1.1 Minor contributor types in mixtures with a single major contributor indicated

In mixtures with a single major DNA contributor indicated (imbalanced mixtures) a
DNA type is considered to be from aminor contributor if it is less than Vs the intensity
of the tallest peak at a marker.

Validation data has shown in mixtures that have varying contribution levels from the
DNA donors, individuals that generally contribute greater than 50% of the DNA in a
sample will not possess any alleles designated as “minor” in the mixture. In these
situations “minor” alleles can be used as an interpretational tool for determining major

vs. minor. contributors to a mixture.

In'some circumstances the imbalance in a sample will be so extreme, that the genotype

from a single major contributor (predominant) see 2.7.1.4a can clearly be deduced.
2.5.1.2'Minor contributor types in mixtures with multiple major contributors

In mixtures with multiple major contributors (balanced mixtures), minor contributor
alleles will generally be less than 10% of the total RFU at a locus. 10% is meant as a
guideline and phenomena such as the overall intensity of the types in the mixture,
stutter and baseline artifacts may affect the percentage from locus to locus. If the
percentage of an allele is such that it is suggestive that it may be from a more significant
contributor it should not be considered minor. When the overall peak heights in a
mixture are low, it is more likely to have stochastic issues affect expected peak height
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ratios of the contributors, as such, 7% will be used as the threshold for loci with less

than 1600 total rfu in mixtures with multiple major contributors (balanced mixtures).
2.5.1.3 Minor contributor types in mixtures obtained using the Minifiler amplification kit

The Minifiler amplification kit inherently has more peak imbalance than the Identifiler
Plus DNA testing kit with peak height ratios between paired peaks sometime observed
as low as 32%. As such using <1/3 the tallest peak as an indicator f a DNA type from
a minor DNA contributor is inappropriate. In Minifiler derived mixtures, minor
contributor alleles will generally be less than 10% of the total RFU at a locus. 10% is
again meant as a guideline and phenomena such as stutter and baseline artifacts may
affect the percentage from locus to locus; however, deviations from this should be rare
and generally used for more conservative interpretations of mixtures. If the
percentage of an allele is such that it is suggestive that it may be from a more significant
contributor it should not be considered minor.

When identifying DNA types in a mixture that are mor¢ likely from minor contributors, the
robustness of the DNA profile should be taken into consideration in evaluating and interpreting
a DNA profile. As results approach the stochastic range (e.g. 200 RFU for Identifiler Plus),
peak height ratios of less than 30% may be observed. Based on the increased imbalance
expected with lower levels of DNA; loci where the tallest peak is less than or equal to 350rfu
should not be used to determine major/minor contributor DNA types. In some mixtures
where the majority of the types detected are stochastic level and only a few DNA types are
above 350rfu, analysts may determine that-assigning major vs minor alleles should not be done
due to the low level of the data!

2.7 Documenting Assumptions

In certain circumstances, assumptions regarding DNA profiles may be made to assist the analyst in

drawing conclusions'and to put the evidence in the proper context. All assumptions regarding any

interpretation will be presented in the report and should also be in the notes (see section 5).

2.74

2.7.2

While the absolute number of contributors to a DNA mixture cannot be determined in most
instances. In certain circumstances, especially fairly robust samples with few contributors,
factors such as allelic dropout, degradation, inhibition, masking of alleles, partial profiles, etc.
are believed to play a less significant role and the number of contributors to a mixture or the
number of major contributors to a mixture can be assumed with confidence and should be

supported by the data.

In certain circumstances assumptions regarding the presence of a contributor in a DNA
mixture is permissible (i.e. intimate samples — see complete document for additional instances

where it may be done). In these circumstances the DNA profile from the assumed
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contributor(s) can be used to assist interpretation of the additional contributor(s) DNA
profile/types (section 2.7).

The assumption of the presence of one or more contributors may require the analyst to change
the minimum number of contributors to a mixture. It also may be possible that the assumption
of the presence of a contributor may change the confidence with which an assumed number of
contributors can be made.

2.8 Determining the Loci to be used for Statistics/ Comparisons

Prior to making comparisons, the profile should be evaluated to determine what loci and/or
combinations of DNA types are acceptable to support a conclusion statistically. Much of the
evaluation to determine what parts of the DNA results can be used for statistical weight takes into
account the presence of DNA types below the stochastic threshold and whether assumptions regarding
the number of contributors have been made. If all DNA types are above the stochastic threshold, all
DNA types can be used for comparison, but it may useful to further refine the genotypes for
comparison if a limited number of combinations are likely:

If an analyst believes that filtered stutter peaks should be evaluated for comparison, the mean stutter
percentage observed for the allele during validation and other studies should be used to assess whether
excess stutter is likely. Peaks in stutter positions that are more than 2 standard deviations above the
mean observed stutter indicate the presence of excess stutter and that DNA contribution from a source
other than stutter is likely. If a peak in a stutter position is deemed to have originated from a separate
contributor to the sample, then all stutter-peaks.in the mixture should be evaluated in the same manner
and included in the assessment of the mixture. | After the evaluation of stutter peaks in the mixture it
may be necessary to reassess the minimummnumber of DNA contributors to the sample.

2.8.1 Samples with an assumed number of contributors.

2.8.1.1 An apparent single source sample consists of no more than two relatively balanced
alleles at each locus. Single source samples with three allele peaks at a single locus
and/or partial null alleles have been reported, though are extremely rare. For single
source samples, allele number and peak height ratios should be appropriate for the
level of the detected DNA.

Alleles used for comparison:

When two alleles, or one allele detected above the stochastic threshold, are detected at
a locus, allelic dropout is not a concern. These alleles are used for comparison. When
one allele is detected and the allele is below the stochastic threshold, allelic dropout is
possible. The allele is used for comparison, but the analyst should consider that any
other allele could be paired with the detected allele.
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2.8.1.2 When the data supports it, an analyst may make an assumption as to the number of
DNA contributors in a mixture. It is not recommended that analysts make
assumptions on mixtures of four or more individuals as the data in those mixtures

becomes much harder to interpret.

When the number of contributors to a DNA mixture is assumed to be two or three
people, there are restrictions on the genotypes that could have contributed to the
profile. Given the number of assumed contributors, the number of detected alleles,
and the ratio of the contributors, it is possible to remove certain allele combinations

from consideration.

Alleles used for comparison:
All alleles at loci where the analyst is confident that all DNA types are detected will be
used for comparison for mixtures of two or three people.

Loci with DNA types below the stochastic threshold can be used in some circumstances
in mixtures of two or three people:

a) Ifall DNA types from all contributors appear to be present at a locus, all
alleles at the locus, including those below the stochastic threshold, will be used
for comparison.

b) If DNA types below the stochastic threshold are observed and at least one
allele is present from each-contributor (three alleles in a two person mixture
or five alleles in a‘three person mixture), all alleles can be used for comparison
if the analyst considers the possibility that the DNA type(s) below the
stochastic threshold can be paired with an undetected allele.

¢) Iftthe analyst does not have confidence that at least one allele has been detected
from each contributor, the locus should not be used for comparison if DNA
types below the stochastic threshold are detected unless a predominant
contributor or major contributors are present (see section 2.7.1.4a).

2.8.1.3 Mixtures of two or three contributors where a forensically valid assumption regarding

a contributor can be made

In addition to the guidelines in section 2.7.1.2, when the number of contributors is
assumed and a forensically valid assumption regarding a contributor is made, further
refinement of the mixture is possible. In these circumstances, possible combinations
representing the source(s) of the DNA foreign to the assumed contributor(s) should be
considered for comparison as described below. DNA types foreign to the assumed
contributor(s) are referred to as obligate foreign alleles.
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Loci used for comparison:

Loci where the analyst is confident that all DNA types are detected can be used for

comparison. Loci with DNA types below the stochastic threshold can be used if all of

the types below the stochastic threshold are due to the assumed contributor and/or if

at least one DNA type from the foreign contributor(s) is present, in a similar fashion to
2.7.1.2aand 2.7.1.2b.

2.8.1.4 Some samples may not allow for confident assumption as to the number of total

contributors, but do allow for an assumption as to the number of major

contributors.

a)

b)

Assumption of one major contributor. If the overwhelming contribution to the
DNA in a mixture appears to originate from a single individual then the term
predominant DNA contributor will apply. A predominant DNA profile will be
one where a single source genotype from the single strongest contributor to the
mixture is able to be deduced from all of the DNA markers tested. In general, all
alleles from predominant DNA contributors will be designated as major. Factors
that will affect deducing a predominant DNA profile such as the genotype of an
assumed additional contributor‘or other issues commonly observed in PCR
systems (stutter, peak height ratios, preferential amplification, etc) should all be
considered in the interpretation of a predominant genotype.

In some circumstances a single major contributor will be apparent, but some
ambiguity may exist for the genotype of the major contributor at a few loci due to
stacking of minor contributor alleles. Peak height ratio expectations may limit the
ambiguity, but if uncertainty still exists, an analyst may choose all combinations of
types that are not designated as minor at the ambiguous loci or all loci (see
example‘in the complete document).

Alleles/lociused for comparison:

The DNA types for a predominant contributor will be considered for comparison
in a similar fashion as single source samples (section 2.7.1.1).

Minor contributors to a mixture with a single major contributor, but no
assumption as to the number of total contributors will be evaluated in a similar
fashion as in section 2.7.2.2

Assumption of two major contributors. In balanced mixtures, it is possible that
two DNA contributors will contribute significantly more DNA than any other
contributors. In this circumstance, an analyst can treat the two major contributors
in a fashion similar to section 2.7.1.2.
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Minor contributors to a mixture with two major contributors, but no assumption
as to the number of total contributors will be evaluated in a similar fashion as in
section 2.7.2.2

c) Assumption of one major contributor, one mid-level DNA contributor, and at
least one minor DNA contributor. In certain mixtures, it is possible to identify a
“mid-level” contributor that is contributing more than at least one other
contributor but less than another. In these circumstances, the assumptions of the
analyst should be documented in the case packet. Additional terms such as “mid-
level” or “significant” can be used provided they are clearly defined in the case
notes. Alleles designated as likely originating from the significant second
contributor should be documented in the analytical record.

Alleles/loci used for comparison:

The interpretation of the presence of a significant second contributor to a mixture
should be based on a discernable difference in peak intensities between the second
significant contributor and any other.minor/alleles present in the mixture. Alleles
designated as likely originating from the significant second contributor should be
documented in the analytical record. Care should be taken with any alleles thought
to be from a second significant contributor if those alleles are either in the
stochastic range.

2.8.2  Even when the number of total contributors and/or the number of major contributors
cannot be confidently assumed,the sample may be evaluated for the presence of possible
major contributors (section 2.7.2:1) and minor contributors (section 2.7.2.2). In some
circumstances, the mixture ‘cannot:be resolved into major and minor components (section
2.7.2.3) or is not useful for.comparison (section 2.7.2.4).

2.8.2.1 Major contributors with no assumption of the number of contributors. Major
contributors should not have types that are designated as minor contributor alleles (see
section 2.5);the subset of alleles in a DNA mixture above the level of minor
contributor alleles are considered possible major contributor DNA types. It may be
possible that the number of major contributors can be assumed even if the number of
total contributors cannot be confidently determined (see section 2.7.1.4).

Loci used for comparison:

Loci with all possible major contributor DNA types above the stochastic threshold will
be used for comparison to the major contributor DNA types. If the mixture contains
multiple major contributors (i.e. a balanced mixture), caution should be exercised in
using loci for comparison where the total signal detected is less than 700rfu. At this
level it is possible that major contributor alleles may be below the detection threshold
of 50rfu (using the 7% threshold). Variables including the peak heights, number of
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detected alleles, and the minimum number of contributors will all play a part in
determining whether a locus should be used for comparisons.

If possible major contributor DNA types at a locus are detected below the stochastic
threshold, in a mixture evaluated without assumptions; the locus will not be used for
comparison purposes to possible major contributors. The locus will be not be used for
comparison due to the concern that one or more major contributors may have DNA
types that were not detected.

2.8.2.2 Minor contributors with no assumption of the number of contributors. Minor
DNA contributors should show proportional contribution across the DNA mixture.
There can be more than one minor DNA contributor to a mixture.. In general, minor
DNA contributors will possess weaker DNA types across severalloci (see section 2.5).
Masking and allelic drop-out are more likely with minor DNA:contributors. Caution
should be taken when interpreting a mixture with only one or two minor DNA types
in a complex mixture as allele sharing may have caused the allele designation to be a
“minor” type(s). The validation data indicates that it is possible to have alleles less than
1/3 the height of the tallest in mixtures with relatively equivalent contributors due to
allele stacking effects.

If no assumptions are made‘about the number of minor DNA contributors then all
combinations of alleles at a locus should be considered as possibly originating from a

minor contributor and not just genotypes containing the designated minor alleles.

Loci used for comparison:

Loci with minor contributor-alleles present and where the analyst is confident that all
DNA typesare detected will be used for comparison to possible minor contributors.
Analysts should be able to articulate their reasoning for the use of loci for comparison
to’potential minor contributors. Peak heights, number of detected peaks, minimum
nuber of potential DNA contributors may all play a role in an analysts decision use a
logts for comparison purposes. Loci with DNA types below the stochastic threshold
will not be used for comparison purposes to possible minor contributors due to
concern that one or more minor contributors may have DNA types that were not
detected. If fewer than four loci are useful for comparison to possible minor
contributors, the profile will be considered uninterpretable with respect to minor
contributors.

2.8.2.3 Mixtures with no major contributors and no assumption of the number of
contributors. Samples with no DNA types designated as minor contributor alleles (see
section 2.5) are not resolvable into major or minor contributors. Mixtures, such as
those of more than four contributors, may have DNA types designated as minor
contributor alleles, but ambiguity may still exist as to whether one or more
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contributors is donating more DNA than others in the mixture. Such samples will be
evaluated for possible DNA contributors.

Loci used for comparison:

Loci where the analyst is confident that all DNA types are detected will use all alleles
for comparison to possible DNA contributors. Loci with DNA types below the
stochastic threshold will not be used for comparison purposes to possible DNA
contributors due to concern that one or more DNA contributors may have DNA types
that were not detected. If fewer than four loci are useful for comparison to possible
DNA contributors, the profile will be considered uninterpretable.

2.8.2.4 Uninterpretable mixtures are mixtures where no assumptions can be confidently
made and where all observed alleles are below the stochastic threshold are not useful
for comparison and are considered uninterpretable. A mixture may be useful for
comparison to possible major contributors and may be uninterpretable with respect to
possible minor contributors.

3. Comparison of DNA Typing Results

3.1

3.2

3.3

3.4

Inclusion. 1If a person of interest has no unexplainable differences from the alleles or allele
combinations determined to be useful for statistical support of inclusions, and thus comparison,
they are included as a source of the DNA or possible contributor to the DNA mixture.

Exclusion. If a person of interest has-unexplainable differences from the alleles or allele
combinations determined to be useful for comparisons, they are excluded as a source of the DNA
or possible contributor to the DNA mixture.

Inconclusive. Some mixtures such as those with five or more contributors may not be suitable for
comparison, unless aminimal number of major contributors exist. Comparisons to these mixtures

will be considered inconclusive.

An analyst.may determine that due to a combination of variables including (but not limited to) the
numberof DNA contributors as well as a lack of information in the results that no comparisons
can be made to the profile (or comparison for possible minor contributors).

Uninterpretable. Mixtures with no assumptions made to the number of contributors, that have
less than 4 loci available for comparison, will be deemed uninterpretable

If the positive amplification control does not provide the expected results, or if DNA types are
detected in the negative amplification control or the relevant reagent blank, the sample may not be
useful for comparison (see section 1.6) and would thus be uninterpretable.

4. Statistical Analysis of DNA Typing Results
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When a comparison leads to a conclusion that an individual is included as a possible source of the DNA or a
possible contributor to a DNA mixture, an assessment of the significance of that inclusion should be
performed by calculating the rarity of such an inclusion. If the inclusion has little probative value a
calculation may not be necessary. If an individual is included as a possible contributor to the DNA from
multiple items in a case, calculations may only be necessary for the most probative item(s) and/or the
item(s) with the highest discrimination potential.

Calculations will only be performed on loci and/or allele combinations that have been deemed acceptable
for comparison purposes (section 2.7).

All calculations will be generated for the Caucasian, African American and Southwestern Hispanic
populations using the DNA allele frequency data taken from ] Forensic Sci 1999, 44(6): 1277-1286 and for
the D251338 and D195433 loci from Forensic Science Communications 2001, 3(3).unless noted. If a
different database is used for calculations, it should be included in the administrative documents with the
case file and noted in the report.

The product rule will be used for calculations by determining the probability at each locus and multiplying
the results for each locus together.

In general, Popstats is used for statistical calculations. In some circumstances the SDPD 2p calculator can
be used for low level samples. There is also the SDPD RMP calculator, which can be used for mixtures,
that allows for the exclusion of certain genotypes from the calculation.

4.1 For single source samples and samples with a predominant DNA profile the significance of a
match should use the random match probability (RMP) formulae for single source samples. Loci
with two alleles (heterozygotes).or with a single allele above the stochastic threshold
(homozygotes) can be calculated using Popstats. For loci with a single allele below the stochastic
threshold the analyst can.use the SDPD 2p calculator in combination with the Popstats results or
can decide not to use the locus for statistical weight if the added value would be insignificant to the
overall conclusion.” The formulae for the Random Match Probability for single source samples are
shown below:

- [=2pq (heterozygote)
f=p +pl-pb (homozygote)  (8=0.01 in most instances)
f=2p-p (single peak below stochastic threshold)

4.2 There are two methods used for calculations when an assumption is made regarding the
number of contributors or the number of major contributors to a mixture: the likelihood ratio
(section 4.2.1) and the random match probability (section 4.2.2). Both methods can be restricted
(taking into account peak height ratios and mixture ratios) or unrestricted. The RMP can also be
modified based on an assumed number of contributors to exclude unreasonable genotypes from

consideration. Both methods can take into account the presence of an assumed contributor.
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If the number of contributors can be assumed with confidence, the likelihood ratio takes
into account all of the information in the sample. The likelihood ratio is the ratio of two
probabilities of the same event under two mutually exclusive hypotheses. Given the same
data, it is possible to calculate more than one likelihood ratio under a different set of
assumptions and hypotheses.

P(E|CY
T horv . A
P(E|Cy),

In general, the likelihood ratio formula is:

Typically the calculation in the numerator is the probability of obtaining the evidence
under the hypothesis that a person of interest is one of the contributors to the DNA
mixture along with additional known or unknown people. The calculation in the
denominator is the probability of obtaining the evidence under the hypothesis that a
randomly selected individual is contributing to the DNA mixture along with additional
known (generally the same as the numerator) or unknown'contributors. If the result of the
ratio is a number greater than one, the DNA results are more probable if the person of
interest is a contributor to the mixture. If the result of the ratio is less than one, the DNA
results are more probable if the‘evidence is a mixture of DNA from randomly selected
individuals.

In the SDPD lab, the likelihood ratio.has been more commonly calculated when a
contributor is assumed and thé number of contributors is also assumed, but it can also be
calculated without the assumption of a contributor. Likelihood ratios are also used in
parentage and Kinship calculations, but these will be dealt with later (sections 4.4 and 4..5).

Please’see the’complete document for additional scenarios where likelihood ratios could be
useful. Popstats can’calculate likelihood ratios; however it does not employ formulas to
deal with restrieted likelihood ratios or scenarios where allelic dropout is possible.

Although commonly used for single source samples, random match probabilities (RMP)
calculations can also be performed for mixtures with an assumed number of contributors
or for major contributors to a mixture with an assumed number of major contributors.

The RMP calculates the probability of each genotype that could reasonably represent a
contributor. The RMP differs from a combined probability of inclusion (see section 4.3) in
that fewer possible genotypes exist due to the assumption regarding the number of
contributors.

When a mixture is encountered that appears to have a single major contributor, but where

some ambiguity exists in the genotype at one or more loci (see section 2.7.1.4a for an

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 169 of 190




Unit Technical Manual

Forensic Biology

example), an RMP incorporating multiple genotypes at the ambiguous loci can be
performed.

In balanced mixtures of DNA from two people, the RMP could be calculated by using only
the possible combinations that could have contributed to the mixture (e.g. heterozygote
combinations where four alleles are detected).

In circumstances where DNA types below the stochastic threshold are detected and where
dropout has possibly occurred, a modified version of the 2p - p2 calculation in'section 4.1
can be performed using the following formula for the alleles below the stochastic threshold

(p, g, 1, eto):
2ptqtr+..)-(ptqtrt..)

In mixtures of DNA where the presence of a specific contributor is assumed, an RMP could
be calculated for the combinations of DNA types foreign to the assumed contributor. Such
calculations focus on the obligate alleles in the mixture.

4.3 Combined Probability of Inclusion

When no assumptions regarding the number of contributors can be made with confidence, the
combined probability of inclusion (CPI) is used to express the significance of an inclusion. The
probabilities of all possible combinations at each locus are calculated and summed to generate a
probability of inclusion or PI. The PLfer each of the loci acceptable for comparison are multiplied
together to generate the CPI. The PLfor each marker and the CPI are calculated as:

=(pptqtr+t..)
- CPI =PI, * PL* P, * ...

A CPI using the possible major contributor DNA types (e.g. types above minor) can be calculated
to express the significance of an inclusion as a major contributor. A separate CPI calculation using
all DNA types can be performed to express the weight of an inclusion of a minor contributor. For
samples without major and minor contributors, a CPI using all alleles can be performed to express
the significance of an inclusion as a possible DNA contributor.
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4.4 Parentage

In cases involving disputed parentage, a parentage calculation will be provided using the formulae
integral in the Popstats software. If manual calculations are necessary because the parents and child
are from a racial group for which Popstats does not have relevant population data, the formulae can
be found in the “Help” section of Popstats. Calculations for three parentage scenarios are
performed: when one parent is alleged and the other is known (section 4.4.1), when one parent is
alleged and the other is unknown (section 4.4.2), and when both parents are known and the child is
alleged (section 4.4..3).

4.4.1  The scenario when an allegation of parentage exists and DNA types from the child, the
known parent, and the alleged parent exist is referred to as a parentage trio. In this
circumstance, a Parentage Index (PI) is calculated. The Pl is the Likelihood Ratio of the
probability of the genetic evidence given that the alleged parent is the biological parent of
the child versus the probability of the genetic evidence given that a randomly selected,
unrelated individual is the biological parent of the child.” See the complete document for

information on considering mutations.

4.4.2  In cases where one parent is alleged and the other parent is either unknown or for which
DNA results are unavailable, a single parent case exists. These are often referred to as a
“motherless paternity” or “fatherless maternity” cases. These calculations are performed by
Popstats within its kinship tools.

4.4.3  When the child of two parents'is disputed, a Reverse Parentage Index (RPI) will be
calculated. This is the Likelihood Ratio of the probability of the genetic evidence given that
the alleged child is the biological child of the parents versus the probability of the genetic
evidence given that the alleged child is not the biological child of the parents.

4.5 When the biological relationship, or kinship, of two individuals is disputed, a Kinship Index (KI)
will be calculated. Thisis the Likelihood Ratio of the probability that the two individuals’
genotypes are associated by kinship, versus the probability that the two individuals’ genotypes are
associated by chance. In cases involving disputed kinship, a kinship calculation will be provided
using the formulae integral in the Popstats software.

5. Reporting of DNA Typing Results and Conclusions

The following are meant as guidelines for reporting conclusions for DNA testing in Forensic Biology Unit
reports. There are many ways to state a conclusion in a DNA report and the suggestions listed below do
not cover every possible scenario. Alternative wording may be used to express a conclusion so long as the
conclusion is correct, supported by the data, and is appropriate based on the statistical probability limits

employed by the Unit.
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5.1 Reporting of DNA typing results

If all samples tested gave no DNA typing results, an analyst may convey these results with a written
statement to that effect in the results section of the report.

If DNA typing results were obtained for one or more samples, the DNA typing results for all
samples will be reported in tabular form. If a low number of samples were tested, the table may be
placed in the results section of the report. If a larger number of samples were tested, or if the
analyst desires, the table should be placed at the end of the report with a statement in the results
section directing the reader to the location of the table. If multiple items are tested, the table
should include a clear indication of the item being presented. A brief description of each item is
desired. An example of a table of results is shown below:

Description D8S1179 | D21S11 | D7S820 | CSF1PO | D3S1358 | THO1 | D13S317 | D16S539 | D2S1338 ]pS vWA |[TPOX| D18S51 | Amel | D5S818 | FGA
100XXXX 13, 14 30 9,10« | ND 14, 15 9 8, 11 13%, 14 24% 13 |14, 15[8%, 11| ND | X,Y | 10,12 | 21*
Stain from pants

13, 14, 15, 28,30 | 8,9,10 | 11,12 |14,15,17| 6,9 8,11 11, 12413,{ 19424, 26 | 13,14, 14, | 8,11 | 15,17, | X,Y | 10,11, | 20,
100XXXY 16 [32.2%] [13%] [18] [9.3] [13] 14 [22] 14.2 15, 16 18, 20 12 21, 24
Baseball cap [10] [10%] [15.2] [12%] [19%],
[27%]
100XXYY 13, 14 30 9,10 NT 14,15 NT 8,11 NT NT NT 14, 15| NT 15,17 | X, Y | 10,12 |20, 21
John Smith

1
2

[l
*

o

= DNA results are a composite of two injections

= DNA results taken from Criminalist Joe Blow’s report for case #XX-XXXXXX dated April 7, 2002
= DNA type(s) likely from minor contributor(s).

= DNA type detected below the stochastic threshold

ND = No DNA types detected
NT = Not tested

If results from previous analyses are reported with results from current analysis, a reference to the

report from which the previously obtained results are taken should be included in the table.

The table of results will indicate which types are minor contributors alleles and which types were
detected below the stochastic threshold. If a composite profile is used, a note to that effect should
be placed in the table, The table should specify if no results were obtained or if testing was not
performed at a locus. If abbreviations or symbols are used in the table, a key to the symbols should

be provided with the table.

In‘an effortto streamline the reporting process, especially in cases without suspects,
uninterpretable samples may be omitted from the table of results. Victim profiles may also be
omitted from the tabular results unless the profile comprises an element of a potentially probative

evidence sample.

Asterisks indicating DNA types below the stochastic threshold are not required for reference
samples containing heterozygous genotypes with one or more DNA types below the stochastic

threshold.
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5.2 Reporting of conclusions

Conclusions for each item should be present in the conclusions section of the report. It is

acceptable to group similar conclusions for multiple items together.

5.2.1

In general, conclusions should state whether a mixture was obtained, and if a mixture was
obtained, the minimum number of contributors should be stated. The conclusion should
indicate if the sample is not suitable for comparison purposes. A brief description of the
reason that it is not suitable should be included. In the case of a mixture that is only
suitable for comparison to possible major contributors, an indication should be included
that the sample is not suitable for minor contributor statistical assessments and therefore
unsuitable for comparison to possible minor contributors (see 5.2.1.1).. It may in some
circumstances be relevant to indicate whether male or female DNA'is present in the sample
even if no statistics/ comparisons can be made to the male DNA.

If the sample is suitable for comparison and if comparisons are made, the conclusion should
indicate whether the persons of interest are included or excluded. If the comparison is
determined to be inconclusive, a statement giving reasonsleading to the inconclusive

determination should be included in the report.

If an inclusion is made, and if the inclusion warrants a probability calculation (see section

4), the applicable probabilities should be listed.

Any assumptions made regarding the comparisons and/ or the probability calculations will

be listed in the conclusion.

If the inclusion‘of an‘individual requires a larger number of contributors than the minimum
based on allele number and peak height ratios, a statement to that effect should be
included.

A statement as to whether DNA types or a subset of the DNA types from an item will be
uploaded into CODIS should be included, if applicable.

5.2.1.1 Statement when the mixture, or a portion of the mixture (i.e. minors), is

unsuitable for statistical calculations or comparions:

Due to the number of possible DNA contributors and the low level of the detected
DNA types, the results in this mixture do not meet the laboratory’s criteria for use
in statistical calculations and therefore no comparisons can be made to reference
samples.

Implemented: 05/15/2013 Issuing Authority: J. Simms, Quality Assurance Manager Page 173 of 190




Unit Technical Manual

Forensic Biology

Statement when the mixture, or a portion (i.e. minors) of the mixture, is
unsuitable for statistical calculations or comparions, but a search of the CODIS
databases will be attempted:

Due to the number of possible DNA contributors and the low level of the detected
DNA types, the results in this mixture do not meet the laboratory’s criteria for use
in statistical calculations and therefore no comparisons can be made to reference
samples. Sufficient information exists in the mixture to allow for searching against
the CODIS databases. Any hits obtained should only be treated as iMiye
leads as no statistical weight can be applied to possible matches.

5.2.2  Examples of inclusions in common scenarios

5.2.2.1 Examples of inclusions as a possible source of a single source or predominant
sample

If the profile frequency is rarer than 1'in 300 million; the terms “match” or “very
likely the source” may be used to describe the inclusion:

The (predominant) DNA prof‘iN the evidence (Item 1) matches the DNA
profile obtained fr ohn Doe. The approximate probabilities that a person
selected at random%possess the same (predominant) DNA profile as the
evidence are:

If the profile frequency is more common than 1 in 300 million, a term such as “is
included as a possible source” may be used:

Jo e is included (or could not be excluded) as being the source of the
fromr'the evidence (Item 1). The approximate probabilities that a person
lected at random would possess the same DNA types as the evidence are:

5.2.2.2 Example of an inclusion as a contributor to a mixture with no assumption as to the
number of contributors

A mixture DNA from at least two (or however many) people was recovered
from the evidence (Item 1). John Doe is included as being a possible DNA (or
major or minor) contributor to the DNA mixture from the evidence. The
approximate probabilities that a person selected at random would be included
as a possible DNA (or major or minor) contributor to the mixture are:

5.2.2.3 Example of a conclusion where an assumption is made
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A mixture of DNA was obtained from the evidence (Item 1). The results
support that it is a mixture of (fill in relevant assumption).

5.2.2.4 Example of an inclusion as a contributor to a mixture when the number of

contributors is assumed (likelihood ratio scenario)

A mixture of DNA was recovered from the evidence (Item 1). The DNA
results are consistent with a mixture of two people. John Doe is included as a
possible DNA contributor to this mixture. Assuming two contributors to the

DNA mixture, the DNA results suggest (see verbal wording below) support
that this represents a mixture of DNA from John Doe and one unknown
individual rather than if it is a mixture of DNA from two unknown individuals

as expressed in the following table:

The following represents suggested Wording to convey the strength of the

likelihood ratio calculation

Likelihood Ratio Results Verbal wording Support for
1,000,000+ | Extremely strong Hx
100,000 | Very strong
10,000 | Strong
1000 | Moderately strong
100 | Moderate
10 | Limited
1 | Inconclusive
0.1 | Limited Support for
0.01 | Moderate Hy
0.001 [ Moderately strong
0.0001 | Strong
0.00001 | Very strong
0.000001 | Extremely strong

Verbal wording suggestions obtained from Dr. Chris Maguire — Northumbria University Center for Forensic Science

5.2.2.5 Example of an inclusion as a contributor to a mixture when an assumption is made

regarding the number of contributors and with one or more assumed contributors

A mixture of DNA from at least two people was recovered from the evidence
(Item 1). John Doe and Jane Victim are both included as possible DNA
contributors to this mixture. Assuming that Jane Victim is a DNA contributor
to the mixture and there is only one additional DNA contributor, then John
Doe is (included as/very likely) the source of the DNA foreign to Jane Victim.
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The probabilities that a person selected at random would be included as a
contributor to the DNA foreign to Jane Victim are:

5.2.2.6 Example of an inclusion in a paternity case

John Doe cannot be excluded as being the biological father of Baby Doe based
on the DNA evidence. Itis (X/Y) more likely to observe these DNA results if
John Doe was the true biological father than if a random (ethnicity) man was
the father. The probability of John Doe being the biological fatmgter
than 99.9999%.

5.2.2.7 Inclusions to single source profiles on non-probative samples

As a general rule, inclusions on samples that have no apparent probative value do
not require the significance of the inclusion to be supported with a probability of
inclusion statement, as long as the wording chosen for the conclusion is
appropriate based on the statistical probability limits employed by the Unit.

The words “match” and “very likely the source” may be used for inclusions to single
source or predominant profiles on non=probative samples if a 15 locus match is
obtained, given the minimum 15 locus profile frequencies using the Applied
Biosystems Identifiler Plus kit (see below). The term “consistent with originating
from” is also acceptable but is notsubject to statistical limitations so long as the
data supports its use.

If less than a 157locus inclusion to a single source sample is obtained and an analyst
still wishes to mse “match” or “very likely the source” it may be necessary to have a
profile frequency calculation in the analytical record to support the application of
those'terms, but that does not have to appear in the report.

Given the minimum 8 locus profile frequencies using the Applied Biosystems
Minifiler kit (see below), the words “match” and “very likely the source” may only
be used for conclusions on non-probative samples if their use is supported by a
profile frequency calculation in the analytical record, which does not have to
appear in the report.

5.2.2.8 Non-probative inclusions to mixtures

A mixture of at least two (or however many) people was recovered from the
evidence. John Doe is included as being a possible DNA contributor to the
mixture from the evidence. There is at least one unknown DNA contributor
to the mixture. DNA from the evidence will be searched against the databases
of the Combined DNA Index System (CODIS).
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5.2.3 Examples of wording when a comparison is inconclusive

A mixture of DNA from at least five people was obtained from the evidence
(Item 1). Due to the complexity of the mixture, it is inconclusive whether
John Doe can be included as a possible contributor to the DNA mixture.

During DNA testing of the evidence (Item 1), the positive amplification
control did not provide the expected results. Therefore no conclusions will be
drawn from this item.

Results obtained from the evidence (Item 1) do noanéetk lalj)ratory

requirements for comparison and are thus inconchiii
5.2.4 Examples of exclusions in common scenarios

5.2.4.1 Example of an exclusion to a single source or predominant DNA profile

The (predominant) DNA %ﬁom‘t& evidence is from an unknown

male/female. John Doe is exc s the source of the (predominant) DNA
from the evidence.

If minor DNA types are presentin a mixture scenario where a predominant profile
is deduced, it may berequired-to state John Doe’s possible inclusion as a possible
minor contributor.

5.2.4.2 Example ofaniexclusion to a DNA mixture

f at least two (or however many) people was recovered from the
. John Doe is excluded as a possible DNA contributor to the mixture.

types from the mixture will be searched against the databases of the
¢ombined DNA Index System (CODIS).

5.2.5 Reporting Staff Matches
When an evidence DNA profile is found to match a staff member of the laboratory the
analyst should refer to the “Reporting DNA results matching laboratory staff”

portion of the CODIS section of the Forensic Biology Unit Policy Manual.

5.2.5.1 Example of wording for staff matches
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The DNA profile from Evidence Item X was found to match my DNA profile. No
other item in this case contains this profile and therefore interpretations of these
items were not affected.

The DNA profile from Evidence Item X was found to match DNA from a
laboratory analyst from Unit X. No other item in this case contains this profile and
therefore interpretations of these items were not affected.

Minor contributor scenario

...also detected in this sample was DNA that is consistent with ) M)rofile.
The presence of this DNA in the sample did not affect the overa rpretation for
this item. No other item in this case contains this profile’and the interpretations of
these items were not affected.

5.2.6 Streamlining conclusions

It may be appropriate in some circumstances to streamline the reporting of the

conclusions. The following are examples of streamlined conclusions.

5.2.6.1 Single source profile examples

DNA results from evidence &X will be searched in CODIS.

The DNA obtained fro eWem X is from an unknown male. The DNA profile
will be searched in S.

5.2.6.2 Predominant DNA profiles

RNWqu evidence Item X will be searched in CODIS.

imeNio’minant DNA obtained from evidence Item X is from an unknown male.
:fhislalfofile will be searched in CODIS.

5.2.6.3 Mixtures

DNA types from evidence Item X will be searched in CODIS.

A subset of DNA types from a mixture obtained from evidence Item X will be searched in
CODIS.

DNA results from evidence Item X are unsuitable to be searched in CODIS, but can be
compared with reference samples.

Implemented: 05/15/2013

Issuing Authority: J. Simms, Quality Assurance Manager Page 178 of 190




o

Unit Technical Manual

Forensic Biology

The DNA results from evidence Item X are unsuitable to be searched in CODIS, but they

can be compared with reference samples if submitted.

5.2.6.4 Unsearchable results

DNA results from evidence Item X are unsuitable to be searched in CODIS or compare

with reference samples.
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METHOD: Y-STR Interpretation Guidelines
Date: 06/01/2004 Revision Date: 04/01/2011 Approved by: SAM
Introduction

The Scientific Working Group on DNA Analysis Methods (SWGDAM) states that:

“The interpretation of DNA typing results for human identification purposes requires professional
judgment and expertise. Additionally, laboratories that analyze DNA samples for forensic casework
purposes are required by the Quality Assurance Standards for Forensic DNA Testing Laboratories
(effective July 1, 2009) to establish and follow documented procedures for the interpretation of DNA
typing results and reporting. Due to the multiplicity of forensic sample types and the potential
complexity of DNA typing results, it is impractical and infeasible to coyer every aspect of DNA
interpretation by a preset rule. However, the laboratory should utilize written procedures for
interpretation of analytical results with the understanding that specificity in the standard operating
protocols will enable greater consistency and accuracy among analysts within a laboratory. It is
recommended that standard operating procedures for the interpretation of DNA typing results be
sufficiently detailed that other forensic DNA analysts can review, understand in full, and assess the
laboratory’s policies and practices. The laboratory's interpretation guidelines should be based upon
validation studies, scientific literature, and experience.”

Here we present a number of general interpretation guidelines for interpreting samples in forensic Y-STR
casework. The rationale behind these guidelines is to establish a set of standards to ensure that conclusions
are supported by reliable data, derived using ascientific approach, and that interpretation of results is as
objective as possible and is consistentfrom one analyst to another.

The interpretation of Y-STR results should take into account the DNA results obtained, the nature of the
sample, the condition of the profile; any forensically valid assumptions made, and should be scientifically
justifiable and based on the collected experience and knowledge of the laboratory and the scientific
community. These guidelines are designed to provide a general foundation for interpretation.

DNA interpretation should take place in the following order:

Preliminary Evaluation of Data and Allele Designation (section 1)
Interpretation of DNA Typing Results (section 2)

Comparison of DNA Typing Results (section 3)

Statistical Analysis of DNA Typing Results (section 4)

Reporting of DNA Typing Results and Conclusions (section 5)

This document will reference the Autosomal STR Interpretation Guidelines document where information
applicable to Y-STR interpretation is available.
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Section 1 — Preliminary Evaluation of Data and Allele Designation

Please refer to section 1 of the Autosomal STR Interpretation Guidelines document as all the information
therein is relevant to Y-STR interpretation.

Section 2 — Interpretation of DNA Typing Results

In general, interpretation of Y-STR data will be completed prior to comparison of reference samples. All
interpretation of samples will be performed using the actual electrophoresis data and not the table of
results. DNA interpretation will include the following steps:

Determine whether a sample is a mixture (section 2.1)

Estimate the number of contributors to a sample (section 2.2)

Identify whether a sample is degraded and/ or inhibited (section 2.3)

Determine contribution level in mixed DNA samples (section 2.4)

Document relevant assumptions (section 2.5)

Determine which loci and combinations of DNA types are useful for statistical support of

inclusions (section 2.6).
2.1 Determination of whether a sample is a mixture

A mixed Y-STR profile possesses certain common attributes that will tend to indicate the presence of
more than one contributor to the observed results.~The attributes may include:

®  Greater than one allele present at a'locus other than DYS385 where a gene duplication results
in a bi-allelic pattern.
. Significant imbalance in peak height between peaks at a DYS385.

®  Generally, evidence of a mixed DNA sample exists at multiple loci.

To determine whether a mixed Y-STR profile exists, the DNA profile must be evaluated in its entirety.
If a DNA mixture exists,a conclusion to that fact should be stated in the Forensic Biology report, and
may be stated independently of the conclusion(s) surrounding potential individual contributors (see
section’5).

2.2 Estimation of the number of contributors to a sample

Conclusions with respect to the minimum number of contributors must be included in a report.
Generally, an estimate of the minimum number of contributors is based on the locus that exhibits the
greatest number of allelic peaks and the fact that each contributor would contribute at most one allele
to the locus (except DYS385). While the minimum number of contributors to a mixture can be
established with a high probability, an absolute determination of the number of contributors cannot be

ascertained.
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2.3 Determination of whether inhibition and/or degradation is present

Please refer to section 2.4 of the Autosomal STR Interpretation Guidelines document for more
information on inhibition and degradation. The SDPD does not currently have good examples of
degraded or inhibited Y-STR profiles, however, the same basic tenets apply to both autosomal and Y-
chromosome analysis.

2.4 Determination of contribution levels in mixed DNA samples

The relative peak intensity differences between detected alleles can be used to identify differences in
contribution levels between contributors to relatively simple (i.e. 2-person) mixtures. In general a 3:1
difference in peak intensity will be used to identify major vs. minor alleles. In more complex mixtures
it may be difficult to determine major vs. minor alleles and analysts are encouraged to exercise caution
when interpreting Y-STR mixtures of more than two individuals.

Alleles designated as likely coming from a minor DNA contributor-to a Y-STr mixture will be denoted
with brackets (e.g. [16]) in the table of results.

2.5 Documentation of Assumptions

In certain circumstances, assumptions regarding DNA profiles may be made to assist the analyst in
drawing conclusions and to put the evidence in the proper context. All assumptions regarding any
interpretation will be presented in the repert and should also be in the notes (see section 5).

In certain circumstances assumptions regarding the presence of a contributor in a DNA mixture is
permissible (i.e. intimate samples )., In these circumstances the DNA profile from the assumed
contributor(s) can be used to/assist interpretation of the additional contributor(s) DNA profile/types
(section 2.7).

Prior to making comparisons; the profile should be evaluated to determine what loci and/or
combinations of DNA types are acceptable to support a conclusion statistically. Since there is
technically ne stochastic threshold to be concerned with (with the exception of DYS385) much of the
evaluation to determine what parts of the DNA results can be used for statistical weight takes into
account the possible presence of DNA types below the analytical (or detection). If, based on the
totality of the'information in the Y-STR result, it is reasonable to assume that all information is
accounted for in the results, all DNA types can be used for comparison, but it may useful to further
refine the genotypes for comparison if a limited number of combinations are likely.

If an analyst believes that filtered stutter peaks should be evaluated for comparison, the mean stutter
percentage observed for the allele during validation and other studies should be used to assess whether excess
stutter is likely. Peaks in stutter positions that are more than 2 standard deviations above the mean observed
stutter indicate the presence of excess stutter and that DNA contribution from a source other than stutter is
likely. If a peak in a stutter position is deemed to have originated from a separate contributor to the sample, then
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all stutter peaks in the mixture should be evaluated in the same manner and included in the assessment of the
mixture. After the evaluation of stutter peaks in the mixture it may be necessary to reassess the minimum

number of DNA contributors to the sample.

Section 3 - Comparison of DNA Typing Results

3.1 Inclusion. If a person of interest has no unexplainable differences from the alleles or allele
combinations determined to be useful for statistical support of inclusions, and thus comparison, they
are included as a source of the DNA or possible contributor to the DNA mixture.

3.2 Exclusion. If a person of interest has unexplainable differences from the alléles orallele combinations
determined to be useful for comparisons, they are excluded as a source of the/DNA orpossible
contributor to the DNA mixture.

3.3 Inconclusive. Some mixtures such as those with five or more contributors may not be suitable for
comparison, unless a minimal number of major contributors exist.  Compatisons to these mixtures will

be considered inconclusive.

An analyst may determine that due to a combination of variables including (but not limited to) the
number of DNA contributors as well as a lack of information in the results that no comparisons can be

made to the profile (or comparison for possible- minor contributors).
Section 4 - Statistical Analysis of DNA Typing Results

Y-STR loci are linked on the Y-chromosome and do not undergo linkage disequilibrium. Therefore neither
Recommendation 4.1 (NRC 1996) nor the Product Rule can be applied to Y-STR haplotypes. The
significance of a haplotype match in casework must be expressed in terms of the observed frequency of the
particular haplotype in the population (the counting method). Numerous Y-STR haplotype databases are

available on-line.

4.1 Apparent Single Source profiles
For the purposes of expressing the significance of a Y-STR haplotype match all alleles for loci deemed
acceptable for comparison will be searched in the database. More DNA profiles in the US YSTR
database have a subset of the Yfiler loci than have the full complement of the Yfiler loci. As a result, an
analyst may elect to search a subset of the Y-STR results in the database for the purposes of obtaining a
more discriminating search.

4.2 Mixed Y-STR DNA profiles

4.2.1 If asignificant difference in allele peak height exists in a male DNA mixture, a predominant
Y-STR DNA haplotype may be deduced. If a predominant haplotype is deduced, all
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applicable alleles from the predominant haplotype will be searched in the database (as in
section 4.1). For the purposes of expressing the significance of a Y-STR haplotype match all
applicable alleles will be searched in the database.

4.2.2 Ifapredominant Y-STR DNA profile cannot be deduced, the frequencies in a given database
may be determined for each possible haplotype and the sum of all combinations of possible

haplotypes may be reported.

4.3 Y-STR haplotype frequencies can be calculated from a number of established databases.” Applied

Biosystems generated a database of searchable haplotypes incorporating all of the Yfiler loci at:

www.appliedbiosystems.com/yfilerdatabase

The website displays each of the Yfiler loci next to drop down lists and text bexes. Common alleles
should be selected from the drop down list. Microvariant alleles.and loci with multiple alleles should
be inputted into the text boxes. Upon searching the questioned haplotype, the website will indicate
how many haplotypes in the database match. The number of matching haplotypes is listed for eight
different population groups and for all samples in the database. The number listed on the website for
each group in the database is a link that will‘display the full haplotypes for all matches. This can be
helpful when searching partial profiles or a subset of alleles in a mixture. The results page can be
printed for the case notes, and the haplotype frequencies can be expressed as the number of matches

divided by the number of samples in the/database.

Numerous other Y-STR haplotype databases are available on-line and their use is at the discretion of the
analyst. The Promega Corporation has a haplotype database at:

www/promega.com/techserv/tools/pplexy/

Upon visiting this website; launch the PowerPlex"Y Haplotype Database and enter the alleles from the
questioned haplotype. Choose the sample population of interest (e.g. Caucasian, Asian, Hispanic,
African-American or Native American), or select “All Populations”. Upon submitting the questioned
haplotype, the website will indicate how many haplotypes in the selected population database match
and the percentage of matching samples in the selected population. The results page can be printed for
the case notes, and the haplotype frequency can be expressed as the number of matches divided by the

number of samples in the database.

Other Y-STR haplotype databases are available at:

www.usystrdatabase.org

WWW.Vstr.org/index usa_or.htmL

W\rvw.reliagene .com
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Section 5 - Reporting of DNA Typing Results and Conclusions

The following are meant as guidelines for reporting conclusions for DNA testing in Forensic Biology Unit
reports. There are many ways to state a conclusion in a DNA report and the suggestions listed below do
not cover every possible scenario. Alternative wording may be used to express a conclusion so long as the
conclusion is correct, supported by the data, and is appropriate based on the statistical probability limits

employed by the Unit.

5.1 Reporting of DNA typing results
Please refer to the Autosomal STR Interpretation Guidelines document for additional information.

5.2 Reporting of Conclusions
Conclusions for each item should be present in the conclusions section of the report. It is
acceptable to group similar conclusions for multiple items together.

5.2.1 In general, conclusions should state whether a mixture of DNA was obtained, and if a mixture
was obtained, the minimum number of contributors should be'stated. The conclusion should
indicate if the sample is not suitable for comparison purposes. A brief description of the reason
that it is not suitable should be included. In the case of a mixture that is only suitable for
comparison to possible major contributors, an indication should be included that the sample is
not suitable for comparison to possible minor contributors. It may in some circumstances be
relevant to indicate whether male or female DNA is present in the sample.

If the sample is suitable for comparison and if comparisons are made, the conclusion should
indicate whether the persons of interest are included or excluded. If the comparison is
determined to be inconclusive; a statement giving reasons leading to the inconclusive
determination.

If an inclusion is made, and if the inclusion warrants a probability calculation (see section 4),

the applicable probabilities should be listed.

Any assumptions made regarding the comparisons and/or the probability calculations will be
listed in the conclusion.

If the'inclusion of an individual requires a larger number of contributors than the minimum
based on allele number and peak height ratios, a statement to that effect should be included.

5.2.2  Example of an inclusion to an apparent single source or predominant Y-STR haplotype

Male specific Y-STR testing of the evidence indicated the presence of DNA from a single male
or male lineage. John Doe is included as a possible source of the male DNA from this sample.
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The number of times the Y-STR DNA types from the evidence were observed in the ...
Database (website of appropriate database) is:

5.2.3 Example of an inclusion to a Y-STR mixture

During male specific Y-STR analysis of the evidence, a mixture of DNA from at least two males
was detected. John Doe is included as a possible contributor to the mixture of male DNA from
this sample. The approximate number of times the possible combinations of Y-STR haplotypes
from this mixture were observed in the ... Database (website of appropriate database)is:

REFERENCES:

1. AmpFISTR Yfiler™ PCR Amplification Kit User’s Manual
2. SDPD AmpFISTR Yfiler™ validation studies.

3. www.usystrdatabase.org

4. www.ystr.org/index usa gr.htmL.

5. www.reliagene.com.
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Appendix A: Glossary of terms (adapted from SWGDAM)
Allelic dropout: failure to detect an allele within a sample or failure to amplify an allele during PCR.

Analytical threshold: the minimum height requirement at and above which detected peaks can be
reliably distinguished from background noise; peaks above this threshold are generally not considered noise
and are either artifacts or true alleles.

Artifact: a non-allelic product of the amplification process (e.g., stutter, non-templated nucleotide
addition, or other non-specific product), an anomaly of the detection process (e.g., pull-up orspike), or a

by-product of primer synthesis (e.g., “dye blob”).

Composite profile: a DNA profile generated by combining typing results from different loci obtained
from multiple injections of the same amplified sample and/or multiple amplifications of the same DNA
extract. When separate extracts from different locations on a given evidentiary item are combined prior to

amplification, the resultant DNA profile is not considered a composite profile.
Conditional: an interpretation category that incorporates assumption(s) as to the number of contributors.

CPI: combined probability of inclusion; produced by multiplying the probabilities of inclusion from each
locus.

Deconvolution: separation of contributors to aimixed DNA profile based on quantitative peak height
information and any underlying assumptions.

Deduced: inference of an unknown contributor’s DNA profile after taking into consideration the
contribution of a known/assumed contributor’s DNA profile based on quantitative peak height
information.

Differential Degradation: a DNA typing result in which contributors to a DNA mixture are subject to
different levels of degradation (e.g., due to time of deposition), thereby impacting the mixture ratios across

the entire profile.

DNA Contributor: A general category of contribution for samples that are indistinguishable with regard

to major/minor contributors.

Evidence sample: also known as Questioned sample.

Exclusion: a conclusion that eliminates an individual as a potential contributor of DNA obtained from an
evidentiary item based on the comparison of known and questioned DNA profiles (or multiple questioned

DNA profiles to each other).

Guidelines: a set of general principles used to provide directions and parameters for decision making.
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Heterozygote: an individual having different alleles at a particular locus; usually manifested as two
distinct peaks for a locus in an electropherogram.

Homozygote: an individual having the same (or indistinguishable) alleles at a particular locus; manifested
as a single peak for a locus in an electropherogram.

Inclusion: a conclusion for which an individual cannot be excluded as a potential contributor of DNA
obtained from an evidentiary item based on the comparison of known and questioned DNA profiles (or

multiple questioned DNA profiles to each other).

Inconclusive/uninterpretable: an interpretation or conclusion in which the DNA'typing results are
insufficient, as defined by the laboratory, for comparison purposes.

Intimate sample: a biological sample from an evidence item that is obtained directly from an individual’s
body; or one where it is not unexpected to detect that individual’s allele(s) in the DNA typing results.

Known sample: biological material for which the identity of the donor is'established and used for
comparison purposes (referred to as a “K”).

Likelihood ratio (LR): the ratio of two probabilities of the same event under different hypotheses;
typically the numerator contains the prosecution’s hypothesis and the denominator the defense’s

hypothesis.

Major Contributor(s): an individual who appears to contribute a significant portion of the DNA to a

mixture.

Masked allele: an allele of the minor contributor that may not be readily distinguishable from the alleles
of the major contributor or an-artifact,

Minor contributor(s): an individual(s) who can account for the lesser portion of the DNA in a mixed
profile.

Mixture: a DNA typing result originating from two or more individuals.

Mixture ratio: the relative ratio of the DNA contributions of multiple individuals to a mixed DNA typing
result, as determined by the use of quantitative peak height information; may also be expressed as a
percentage.

Noise: background signal detected by a data collection instrument.

No results: no allelic peaks detected above the analytical threshold.
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Obligate allele: an allele in a mixed DNA typing result that is (a) foreign to an assumed contributor, or
(b) based on quantitative peak height information, determined to be shared with the assumed contributor.

Partial profile: a DNA profile for which typing results are not obtained at all tested loci due, for example,
to DNA degradation, inhibition of amplification and/or low- quantity template.

Peak height ratio (PHR): the relative ratio of two alleles at a given locus, as determined by dividing the
peak height of an allele with a lower relative fluorescence unit (RFU) value by the peak height of an allele
with a higher RFU value, and then multiplying this value by 100 to express the PHR as a per¢entage; used

as an indication of which alleles may be heterozygous pairs and also in mixture deconvolution.

Predominant DNA contributor: A subcategory in an assumption of a single major DNA contributor
when a single source genotype from the single strongest contributor to a mixtare.is.able to be easily
deduced from all of the DNA markers tested.

Probability of inclusion (PI): the percentage of the population that can be included as potential

contributors to a DNA mixture; also known as Random Man Not Excluded. .

Questioned Sample: biological sample recovered from a crime scene or collected from persons or

objects associated with a crime (referred to as a “Q”).

Random Match Probability (RMP): the probability of randomly selecting an unrelated individual from

the population who could be a potential contributor to an evidentiary profile.

Reference sample: also knownsas Known sample.

Restricted: referring to a statistical approach conditioned on the number of contributors and with
consideration of quantitative peak height information and inference of contributor mixture ratios; used to

limit the genotypic combinations of possible contributors.

Signal—to—noise ratio: an assessment used to establish an analytical threshold to distinguish allelic peaks

(signal) from background/instrumental noise.

Single-source profile: DNA typing results determined to originate from one individual based on peak

height ratio assessments and the number of alleles at given loci.

Stochastic effects: the observation of intra-locus peak imbalance and/ or allele drop-out resulting from

random, disproportionate amplification of alleles in low-quantity template samples.
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Stochastic threshold: the peak height value above which it is reasonable to assume that, at a given locus,

allelic dropout of a sister allele has not occurred.

Stutter: a minor peak typically observed one repeat unit smaller than a primary STR allele resulting from

strand slippage during amplification.

Unrestricted: referring to a statistical approach performed without consideration of quantitative peak
height information and inference of contributor mixture ratios; for CPE/CPI this may or may not be

conditioned on the number of contributors.
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